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Icons 
 

Icon Meaning 

 
Caution 

 
Example 

 
Note 

 
Recommendation 

 
Syntax 

 

 

Typographic Conventions 
 

Type Style Description 

Example text Words or characters that appear on the screen. These include field 
names, screen titles, pushbuttons as well as menu names, paths and 
options. 

Cross-references to other documentation 
Example text Emphasized words or phrases in body text, titles of graphics and tables

EXAMPLE TEXT Names of elements in the system. These include report names, 
program names, transaction codes, table names, and individual key 
words of a programming language, when surrounded by body text, for 
example, SELECT and INCLUDE. 

Example text Screen output. This includes file and directory names and their paths, 
messages, names of variables and parameters, source code as well as 
names of installation, upgrade and database tools. 

Example text Exact user entry. These are words or characters that you enter in the 
system exactly as they appear in the documentation. 

<Example text> Variable user entry. Pointed brackets indicate that you replace these 
words and characters with appropriate entries. 

EXAMPLE TEXT Keys on the keyboard, for example, function keys (such as F2) or the 
ENTER key 
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Sales and Distribution in IDES 

Sales and Distribution in IDES 
The following documentation portrays the structural organization and special features of Sales 
and Distribution in IDES Germany. It describes the most important organizational units and their 
embedding in the IDES group as a whole. Those organizational units not yet productive or still in 
preparation are characterized in a particular way. In this documentation you will also find 
reference lists of important master data which can be used when processing sales documents. 

 
The description of the IDES SD organization in other countries is not part of this 
documentation. 

1. Introduction [Page 13] 

2. Organization [Page 14] 

3. Special Features [Page 19] 

4. Reference lists [Page 22] 
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 Introduction  
Pre-configured customizing settings and a well-assorted set of master data in IDES allow you to 
carry out all standard business transactions easily in the areas of Sales Support, Sales, Shipping 
and Billing, and understand their integration with other enterprise functions.  

The range of examples for Sales Support includes the creation and evaluation of sales activities, 
market analysis, analysis of the competition and the creation of direct mailing campaigns.  

In the area of Sales, numerous business transactions with related functions such as pricing, 
availability check, document printing, etc. can be processed. 

The range of examples for shipping processing includes transportation scheduling, delivery 
scheduling, picking, loading and printing of shipping documents.  

Billing covers, amongst other things, the processing of invoices, credit memos or debit memos.  

The Sales Information System (SIS) is continually supplied with current data from the different 
areas in SD.  
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External Organization  
IDES has two sales organizations in Germany: 1000 and 1020. The products and services 
marketed are clearly allocated to one division and reach the customer via different distribution 
channels. 

Sales Organizations 
The sales organizations have the following areas of responsibility: 

Sales organization 1000 is in charge of selling and distributing pumps, elevators, lighting, 
motorcycles, vehicles and high tech products. 

Sales organization 1020 is responsible for consumer goods, chemical and pharmaceutical 
products and cosmetics. 

Product Divisions 
Materials and services sold in IDES are allocated to the following product divisions:  

Division Description 

01 Pumps 

02 Motorcycles 

03 Paints 

04 Lighting 

05 Food 

06 Elevators 

07 High Tech 

08 Services 

10 Vehicles 

12 Solvents 

13 Pharmaceuticals  

14 Cosmetics(in preparation) 

Distribution Channels 
The sales of IDES products takes place via the following distribution channels: 

Distribution Channel Description 

10 End customer sales 

12 Sold for resale 

14 Service 

20 Store chains 
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22 Industrial customers 

24 Pharmaceutical customers 

Sales Areas 
Which materials are managed in which organizational unit is determined by the sales area, that 
is, the combination of a sales organization, a distribution channel and a division. Sales in IDES is 
carried out on a cross-divisional basis via division 00. 

Sales documents in IDES are processed in one of the following sales areas: 

Sales organization Distribution channel Division 

1000 10 00 

1000 12 00 

1000 14 00 

1020 20 00 

1020 22 00 

1020 24 00 

All other divisions are assigned to the different products (product division) and play a key role in 
the following processes:  

• Business area determination in the sales document 

• Data update in the Sales Information System (SIS) and in Profitability Analysis (CO-PA). 

 

The following graphic explains the IDES sales areas: 

 
Special assignments ensure that in one given sales area only certain products can be sold. 
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If a sales order is created in the sales area 1000/10/00 the following products may be 
sold: 

Product Division 

Pumps 01 

Elevators 06 

High Tech 07 

Services 08 

 
At the moment, master data in the sales organization 1020 for scenarios concerning 
the sale of consumer goods and chemical products, is limited to foods and paints. 
Master data for pharmaceutical products and cosmetics is not available at present. 
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Internal Organization  
IDES has four branches in Germany. The sales headquarters (sales office 1000) are based in 
Frankfurt. The other branches are in Hamburg (sales office 1010 ), Berlin (sales office 1020) and 
Stuttgart (sales office 1030). Personnel working at the branches are organized into sales groups. 
Each sales group contains a number of sales representatives, depending on the size of the 
branch. 

Shipping Organization 
Shipping Points 
Scheduling and processing deliveries to customers or replenishment deliveries to an internal 
warehouse is carried out in Germany via any of 6 shipping points which are assigned to the 
plants in Hamburg, Berlin, Dresden, Frankfurt and Stuttgart. Collective picking is carried out at a 
special shipping point (1999) in Dresden (collective shipping).  

Picking 
Picking in IDES is carried out with Lean WM, i. e. using MM-WM transfer orders. Under Lean-
WM we undestand the implementation of a reduced functionality of the Warehouse Management 
module (MM-WM) in simply structured warehouses without stock management at storage bin 
level. 

The following warehouse numbers are relevant in IDES Germany for picking with Lean WM: 

Plant Storage location Warehouse Nr. 

1000 Hamburg 0001 010 Hamburg 

 0002 010 Hamburg 

1100 Berlin 0001 011 Berlin 

1200 Dresden 0001 012 Dresden 

1300 Frankfurt 0001 013 Frankfurt 

1400 Stuttgart 0001 014 Stuttgart 

Relationship between Sales and Distribution, Accounting and Materials 
Management 
The sales organizations 1000 (Frankfurt) and 1020 (Berlin) are assigned to the company code 
1000 (Germany). Which plants are relevant to sales is defined by the following allocation 
between sales organization/distribution channel and plant:  

Plants Sales Organization Distribution 
Channels 1000 1100 1200 1300 1400 

1000 10 X  X X  

 12 X  X  X 

 14   X   

1020 20  X    

 22  X    
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 24  X    

 

 

18  April 2001 



 SAP AG Sales and Distribution (SD) 

  Special Features 

 Special Features  
Sales Document Entry  
Sales document entry in IDES is permitted only via division 00 (cross-divisional sales). 

Business Area Determination 
Depending on the product division of a given material or service and the providing plant, a 
business area is automatically determined for each order item in the sales document. At the time 
of invoicing, all relevant revenue data is allocated to the respective business area. An exception 
to this occurs when processing sales documents in sales area 1000/14/00 (service from the sales 
organization in Frankfurt). In this case, the business area is determined by the sales area itself.  

 
Revenues generated by the sale of high tech products to end customers or retailers 
are normally assigned to business area 7000 (Electronic Products), as the product 
belongs to division 07 (High Tech). If, however, the same material is shipped for 
service purposes as a replacement part, revenues generated are then assigned to 
business area 8000 (External Services). 

Credit Management 
Automatic credit limit check during sales document processing (e.g. sales order, delivery) is an 
understandable necessity in a real business organization. However, in a model company like 
IDES it is undesirable that a business scenario not primarily concerned with credit management, 
cannot be processed due to the customer’s credit limit being exceeded. With this in mind, IDES 
has limited the amount of customers for which credit is checked. 

The following is a list of these customers: 

Customer number Description 
4999 Hallmann Anlagenbau GmbH 

1350 NSM Pumpentechnik AG 

1380 NSM Marschfelden GmbH 

1390 Technik und Systeme GmbH 

Sales employees  
When sales documents are processed, the sales employee responsible for the customer is 
automatically defaulted from the customer master record. Each sales employee belongs to a 
sales group and manages a certain number of customers depending on his qualifications and 
areas of expertise. The sales employee has a personnel number and is assigned to the 
organizational unit 1400 (Sales Germany) in Human Resources. 

If you wish to see the organizational allocation of sales employees in Human Resources, select 
 [Ext.], to get an explanation. 
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Product Hierarchy 
Products and Services sold in IDES are allocated a three-tier product hierarchy which is used for 
statistical and pricing purposes. 

SD and Profitability Analysis 
During order processing, important information is stored in the sales document. This is forwarded 
to Profitability Analysis during billing in order to support Controlling and decision-making in the 
company from a market point of view. The following features are involved: 

Features Example 

Fixed features Article, customer, business area, sales organization, distribution 
channel, product division etc. 

Master data Material group, customer’s industry sector, class of customer, sales 
employee, sales office etc. 

Features specific to IDES Sales region, product category, product hierarchy 1, 2 and 3 etc., 
derived from the sales document via special rules 

Transaction data  
Permanent sales document entry in IDES ensures that a data set is continually updated for the 
use by other applications. These, mainly automatically generated sales documents, supply the 
Sales Information System (SIS) and Profitability Analysis (CO-PA) with data at regular intervals. 
This allows the functionality of these applications to be demonstrated with a consistent volume of 
information. 

Transport Zones and Routes 
For the purpose of shipping and delivery processing, Germany has been divided in 10 
transportation zones (the same zones as used by the postal system). Pre-defined example 
routes are used to help determine the itinerary and the means of transport. 

Packaging 
Delivery items can be packed in IDES with the help of pre-defined shipping materials (e.g. crates, 
boxes, pallets). This makes it possible to document which type of packaging should be or has 
been assigned to the products to be delivered. Loading the packaged goods can be shown using 
various means of transport. 

In IDES, the system can make you a packaging proposal for the following groups of materials: 

Small parts, that have already been packed during production can be packed further into pallet 
boxes or wire baskets during delivery processing. 

Pumps can be packed into wooden crates (for domestic and overseas transportation).  

Monitors/on-board computers can be assigned to padded boxes. 

Special boxes are intended for packing PC-Ensembles. 

Light bulb boxes can be further packed in pallet boxes.  

Packing can be represented in terms of a hierarchy. Those products packed at the first stage can 
be packed further or loaded onto a means of transport, e.g. a padded box is loaded onto a pallet, 
the pallet in turn onto a freight car or truck.  
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 Reference lists  
The following reference lists help you to get a quick overview of important master data in IDES 
which you can use when processing sales documents. At present, these reference lists only 
apply to master data defined in the German organizational units. 

1. Select  [Ext.] , to get customer reference lists. 

2. Select  [Ext.] , to get product reference lists. 

3. Select  [Ext.] , to get reference lists of Sales employees. 
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Sales  
1. Sales Order Processing and Subsequent Functions [Page 24]  

2. Rush Order Processing [Page 36]  
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Sales Order Processing and Subsequent Functions 

Sales Order Processing and Subsequent Functions 
Purpose 
Business transactions in Sales and Distribution are recorded in the R/3 System using sales 
documents. 

You can find more information about this process under  [Page 25]. 

Process Flow 
You can find the data for this process under  [Page 26]. 

1. Creating a Sales Order [Page 27] 

2. Delivering a Sales Order [Page 30] 

3. Billing a Sales Order [Page 33] 

4. Displaying Master Data [Page 35] 
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Additional Process Information 
The sales order is the central document in Sales and Distribution. A sales order can be created 
on the basis of preceding inquiries and quotations. During order entry, you can record information 
about the customer and the products or services in the document. You also perform various 
checks, such as the availability check and the credit limit check. The information entered in the 
sales order is transferred to subsequent documents, which are used to further process the 
business transaction. The delivery document is the basis for the shipping activities. When 
shipping has been completed, the delivered goods and/or the services rendered are invoiced 
during the billing process. The billing data are then forwarded automatically to Financial 
Accounting and Profitability Analysis. 
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Data Used During This Process 
Fields Europe North America 

Order type OR (Standard Order) OR (Standard Order) 

Sales organization 1000 3000 

Distribution channel 10 10 

Division 00 00 

Customer 1000 3000 

Material P-103 P-103 

Shipping point 1000 3000 

Warehouse number 010 300 
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Creating a Sales Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Europe North America 

Order type OR OR 

Sales organization 1000 3000 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Sold-to party 1000 3000 

Ship-to party 1000 3000 

Purch. order no. K-BE-200000 

 

C-BU-200000 

PO date Today‘s date Today‘s date 

Req.deliv.date Today's date + three working days Today's date + three working days 

Pricing date Today‘s date Today‘s date 

Material P-103 P-103 

Order quantity 2 2 

 
The purchase order number establishes a link between the customer's purchase 
order and the sales document you generate. You can use the purchase order 
number to search for the sales document (see Using Matchcodes [Ext.]). 

5. Choose . 

6. If the system displays the Sales area for customer to party dialog box, double-click on the 
following ship-to party. 

Field Europe North America 

Ship-to party 1000 / 10 / 00 3000 / 10 / 00 
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If the goods ordered by the customer are not available on the requested delivery 
date, the R/3 System branches automatically to an availability check screen. Here 
you can choose one of the delivery options, for example, Delivery proposal.  

7. To confirm any informations, choose . 

8. Select the item, then choose . 

9. Select the item with the confirmed order quantity, then choose . 

10. Choose the Shipping tab page. 

To ensure that the most important shipping activities begin on time, for example, picking, 
loading and transport, the system automatically executes delivery scheduling. You can 
see the necessary entries for this shipment. 

 
Make a note of the Material availability date, as you will need this as a selection 
criterion to create the delivery. If the Transport planning date is earlier than the 
material availability date, you can create the delivery on this date. You can also see 
the shipping point responsible for delivering this order. 

11. Choose Goto → Overview. 

12. Select the item, then choose . 

The R/3 System uses condition types to display all of the pricing elements relevant for 
this order item (for example, prices, surcharges, discounts, freight costs, taxes, and so 
on). On this tab page you see all of the pricing elements determined for this item. 

13. Choose . 

14. Choose Extras → Output → Header → Edit. 

On the following screen, you see the output to be generated for this business transaction 
and the partner. 

15. Choose . 

The system confirms that the standard order has been saved. 

16. Make a note of the document number. 

17. Choose Sales document → Change. 

In the Go to "Change" dialog box, choose No. 

The system defaults the previously created order. 

18. Choose Sales document → Issue output to. 

19. In the dialog box, you see the output type valid for this sales document (BA00 = Order 
confirmation). 

20. Choose Print options. 

In the dialog box, you see additional printing information. 

21. Choose  Execute. 
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22. In the Output output dialog box choose . 

23. Choose  until the overview tree appears. 
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Delivering the Sales Order 
Use 
As soon as the material availability date or the transportation scheduling date for a schedule line 
has arrived, the schedule line becomes due for shipping. When you create a delivery, you initiate 
shipping activities such as picking and transportation scheduling. You now create an individual 
delivery. 

Procedure 
Creating an Individual Delivery 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Single Document → With Reference to 
Sales Order 

Transaction Code VL01N 

2. Enter the following data: 

Field Europe North America 

Shipping point 1000 3000 

Selection date The material availability date or the 
transport planning date of the first 
item 

The material availability date or the 
transport planning date of the first 
item 

Order Your sales order number Your sales order number 

 
You can search for your order number, using the F4 input help. For more 
information, choose Match Code Usage [Ext.]. 

3. Choose . 

4. Select the delivery item, then choose . 

You now see the item details. On the Picking tab page, note the following: 

Field Description 

Pick. Stat. Picking status of the delivery item 

WM status Status of the Warehouse Management activities 

Whse no. Warehouse number/warehouse complex 

Stor.type Storage type 
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Picking the Delivery 
You now trigger the picking of the delivery. This is achieved using a transfer order, which is 
generated as a subsequent function to the delivery. The transfer order is the basis for the picking 
list, which is used to withdraw the ordered goods from stock. 

5. Choose Subsequent functions → Create transfer order. 

6. The system asks whether you want to save the data. Choose Yes. 

The delivery is saved. 

7. Enter the following data: 

Field Europe North America 

Warehouse number 010 300 

Delivery Defaulted Defaulted 

Foreground/background Background Background 

8. Choose . 

The system generates a transfer order for the picking of the delivery quantities. 

9. To display the individual picking list, choose System → Services → Output controller. 

The system generates a new session. 

10. Choose Further selection criteria. 

11. In the Further Selection Criteria: Select Spool Requests dialog box, in the Basic settings 
screen area, select Extended, then choose . 

12. Enter the following data: 

Field Europe North America 

Spool request name LVS2 LVS2 

13. Choose . 

14. Select the entry, then choose . 

You now see a print preview of the transfer request. 

15. Choose System → End session. 

16. Choose  until the overview tree appears. 

Posting the Goods Issue 
17. As soon as picking is completed, you can post the goods issue for the delivery. The goods 

issue document for a delivery is a Materials Management (MM) and Financial Accounting (FI) 
document, which is used to update stock quantities and stock values. The system also 
updates a document for account-based Profitability Analysis. Goods issue ends the 
involvement of the shipping department in the business transaction. Call up the transaction 
as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Change → Single Document 
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Transaction Code VL02N 

18. Choose Post goods issue. 

The system confirms that the delivery has been saved. 

19. Make a note of the document number. You will need this to create the billing document. 

20. Choose  until the overview tree appears. 
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Billing the Sales Order 
Use 
Billing is the final activity in Sales and Distribution. When you create a billing document, you use 
a reference document, the delivery in this case. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Create 

Transaction Code VF01 

 
Enter your delivery number, if it has not already been defaulted by the R/3 System. 

2. Choose . 

3. Select the billing item, then choose . 

You now see the billing, pricing, accounting, and order data for this item. 

4. Choose the Item partners tab page. 

You see the various partners involved in this business transaction. 

 
Note that the partner responsible for payment (= payer) differs from the sold-to party. 

5. Choose . 

6. Choose . 

The system confirms that the billing document has been saved. The billing document has 
now been saved in Sales and Distribution, and the billing data have been automatically 
updated to Financial Accounting and Profitability Analysis. 

7. To display these documents, choose Billing document → Display. 

8. Choose  Accounting. 

In the dialog box, you can choose the document type you wish to call up. 

9. Choose the Accounting document. 

On the overview screen for the accounting document, you see the line items with the 
corresponding accounts and amounts that have been posted in Financial Accounting. 

10. Choose .  

11. Choose Profitab. Analysis. 

12. Choose either the Characteristics or the Value fields tab page. 
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You now see the various characteristics or value fields that have been transferred to 
Profitability Analysis. 

13. Choose  until the overview tree appears. 

In the List of Documents in Accounting dialog box, choose . 
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Displaying the Document Flow 
Use 
To ensure that all of the information in the logistics chain is fully integrated, the individual sales 
and distribution documents build on each other to form a network of interrelated documents. You 
can access the document flow from any of the Sales and Distribution documents involved in the 
entire business transaction. In this case, you access the document flow from the order. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Display 

Transaction Code VA03 

 
Enter your sales order number, if not already defaulted. 

2. Choose . 

3. Choose . 

You see all of the documents involved in the business transaction up to now, and the 
overall processing status. To call up any of the documents, position your cursor on the 
relevant line, then choose  Display document. 

4. Choose  until the overview tree appears. 
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Processing Rush Orders 
The processing of rush orders is covered in Picking with Automatic Generation of Transfer 
Orders [Page 276]. 
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Special Business Transactions 
1. Cross-Company-Code Sales [Page 38] 

2. Third-Party Order Processing [Page 60] 

3. Sales Processing according to ATP logic and Backorders [Page 74] 

4. Sales Processing with Availability Check against Product Allocation [Page 99] 

5. Sales Processing with Value Contract [Page 117] 

6. Invoicing a Project by Down Payment Processing [Page 134] 

7. Consignment Fill-Up [Page 155] 

8. Brebate Processing in SD and FI [Page 182] 

9. Monitoring the Budgets for Sales Promotions [Page 209] 
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Cross-Company Code Sales Processing 
The French branch of the IDES Group is purely a sales organization, without its own production 
plants. It is responsible for the French-speaking market and mostly sells products that have been 
produced at other locations of the IDES Group. 

In this IDES scenario, a customer places an order for personal computers with the French sales 
organization. The computers are produced in the Dresden plant of the IDES AG. Sales 
organization France notifies the Dresden plant directly of the customer requirements. The 
production plant in Germany then delivers these goods to the customer of the French sales 
organization. The customer is invoiced by the French sales organization for this delivery. IDES 
Germany invoices the French sales organization for the goods delivered. 

This means that two companies (company codes) of the IDES Group are involved in this sales 
transaction. We refer to IDES France as the ordering company code and IDES Germany as the 
supplying company code. 

You can find more information about this process under  [Page 39]. 

Process Flow 
You can find the data for this process under  [Page 41]. 

1. Creating the Sales Order in the Ordering Company Code [Page 42] 

2. Creating the Delivery in the Supplying Company Code [Page 44] 

3. Picking in the Supplying Company Code [Page 45] 

4. Creating the Invoice for the End Customer in the Ordering Company Code [Page 47] 

5. Creating the Internal Invoice in the Supplying Company Code [Ext.] 

6. Evaluating the Incoming Invoice in Financial Accounting [Page 51] 

7. Customizing in Profitability Analysis (CO-PA) for Cross-Code Sales [Page 52] 

8. Displaying line Items in Profitability Analysis for the Ordering Code [Page 54] 

9. Displaying Line Items in Profitability Analysis for the Supplying Code [Page 57] 

10. Analyzing Profitability Reports [Page 58] 
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Additional Process Information 
Special Features in Pricing 
In cross-company sales processing there are two invoices: one invoice for the customer and one 
internal invoice for the ordering company code. In both the customer invoice and the internal 
invoice an internal price is set that has been agreed by both the supplying and ordering company 
codes. This price in the invoice for the end customer represents the goods purchase value used 
for the profitability analysis in the ordering company code. The internal price is invoiced to the 
ordering company code and appears in the profitability analysis for the supplying company code 
as a revenue.  

To cope with this double function, Pricing uses two pricing procedures. Pricing in the sales order 
and in the invoice for the customer uses the standard pricing procedure. Pricing uses a second 
pricing procedure for the internal invoice. This procedure is a copy of the standard procedure, 
with the exception that it uses the new condition type ZIV1, rather than condition type PI01, to 
determine the internal price. The condition type ZIV1 uses the condition type PI01 as a reference. 
This means that there are no condition records for condition type ZIV1. Pricing for the internal 
invoice uses the corresponding condition from condition type PI01. When sending invoice data to 
the profitability analysis, this procedure allows you to copy the value from condition PI01 into the 
Costs  value field for a customer invoice and to copy the value of the condition type ZIV1 into the 
Revenue value field for an internal invoice. 

Determining a business area 
The rules for business area account assignment in goods issue posting and billing are set for 
each sales area in Customizing for SD.  

There are two sales areas in cross-company sales processing: a selling sales area (sales 
organization 2200 – distribution channel 10 – division 00) and a supplying sales area (sales 
organization 1000 – distribution channel 12 – division 00). 

The business area for the supplying sales area is determined according to the plant and the item 
division (material R-1001 belongs to division 07 = High Tech). This rule is used to determine 
business area 7000 (electronic products) in the sales order item. This entry is copied into the 
delivery and the goods issue document. This rule is also used to determine the business area in 
the internal invoice to the ordering company code. Posting to the business area 7000 then takes 
place. 

The business area for the ordering sales area is determined according to sales organization, 
distribution channel and item division. Business area determination in the invoice to the end 
customer uses this rule. The business area 7200 (Electronic products France) is determined in 
the final customer invoice and the resulting accounting document. 

Creating an incoming invoice by EDI (Electronic Data Interchange) 
Cross-company sales processing gives you the option of automatically creating an inbound 
invoice in the ordering company code. This is done using EDI, a technique which enables a 
cross-company electronic exchange of messages between business partners that may have 
different hardware, software and/or communication devices. In the example given, two partners 
exchange messages within one system. The message belongs to the EDI message type INVOIC 
(for an invoice) The message is exchanged between a sender (vendor = supplying company 
code) and a recipient (customer = ordering company code). There are two variants of the 
message type. If you use the variant F1, invoice receipt is posted to the recipients indirectly in 
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Financíal Accounting. This process uses this variant. If you use the variant MM, the invoice 
receipt is posted in Materials Management using the invoice check. The variant MM is used for 
stock transfer between different company codes. 

The partner agreements required for this EDI procedure have already been defined for the two 
partners involved in this exchange of messages(Tools → Business Communication IDoc 
→ Partner Profile) The supplying company code is represented by vendor number 10000 and 
partner type LI (vendor). The ordering company code is represented by customer number 22000 
and partner type KU (customer). The inbound parameters for vendor 10000 determine which 
rules apply if the system receives the INVOIC message from the vendor in the FI variant. The 
outbound parameters for customer 22000 are used in the R/3 System, if the INVOIC message is 
copied to the customer in the FI variant.. You can use output control for customer 22000 to 
specify whether message RD04, which was determined in the internal invoice, is linked with the 
EDI message type INVOIC in the FI variant. 

You are also required to enter the vendor number (10000) for the EDI procedure in the customer 
master record for the ordering company code (22000). The ordering company code is transferred 
to the supplying company code using this vendor number (Account at customer field in the sales 
data). 
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Data Used During This Process 
Field Data Description 

Order type OR Standard order 

Sales organization 2200 Sales organization of the sales orders and the customer 
invoice 

Distribution channel 10 Distribution channel for end customer 

Division 00 Cross-divisional 

Customer 2500 End customer 

Material R-1001 Finished product PC 

Shipping point 1200 Dresden 

Sales organization 1000 Sales organization of the internal invoice 

Customer 22000 Customer master of the ordering company code 

Vendor 10000 Vendor master of the supplying company code 
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Creating Sales Orders in Ordering Company Code 
Use 
A customer places an order with sales organization 2200 (France). You then create a sales order 
in this sales organization. By entering the appropriate plant in the sales order position the sales 
department triggers the delivery of the goods from plant 1200 (Dresden). The customer 
requirements are then entered into the requirements list of plant 1200. In the sales order, the 
system determines the sales price for the ordered item. The system simultaneously determines 
the price for the internal invoice of the supplying company code to the ordering company code. 
This internal price is purely statistical in the sales order, and does not therefore influence the 
value of the order item. 

In this first process, you act as an employee of the sales order department in the sales 
organization France. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Data 

Order type OR (standard order) 

Sales organization 2200 

Distribution channel 10 

Division 00 

3. Choose . 

4. Enter the following data: 

Field Data 

Sold-to party 2500 

PO number AD-649087 

Purchase order date Today‘s date 

5. Choose the Sales tab page, then enter the following data: 

Field Data 

Req.deliv.date Today's date + 5 working days 

Pricing date Today‘s date 

Material R-1001 

Order quantity 10 
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6. Choose . 

7. If a dialog box appears, choose . 

8. On the Create Standard Order: Overview screen, select the item, then choose . 

9. Choose the Shipping tab page. 

 
A sale of material R-1001 in sales organization 2200 (France) always triggers a 
delivery directly from the producing plant 1200 (Dresden). Plant 1200 is therefore 
entered in the material master record as the supplying plant. This ensures that this 
plant is defaulted in the order item. 

10. On the Create Standard Order: Item Data screen, choose Environment → Availability. 

You see that the sales order item is reported as a requirement to MRP in plant 1200. 
Since you are processing the standard order in the create mode, the sales order item is 
displayed in this list as a simulated requirement. 

11. Choose  until the Create Standard Order: Item Data screen appears. 

12. Choose the Conditions tab page to go to the pricing screen of the item. 

13. Select condition PR00, then choose  Condition rec. 

You see that the sales price has been determined using sales organization 2200 
(France), distribution channel 10 (End customer sales) and material R-1001. 

14. Choose . 

15. Select condition PI01, then choose  Condition rec. 

The internal price has been determined using supplying sales organization 2200, 
supplying plant 1200 and material R-1001. 

16. Choose .  

17. Select condition PI01, then choose . 

The Create Standard Order: Item Data screen appears. The internal price is marked as 
statistical in the sales order. 

18. Choose  until the Create Standard Order: Overview screen appears. 

19. Choose the Shipping tab page. 

 
Note the material availability date. You will need it later as a selection criterion to 
create the delivery. You can also see the shipping point responsible for delivery of 
the order. 

20. Choose . 

21. Note the number of the standard order. 

22. Choose  until the overview tree appears. 

In the dialog window, choose No. 
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Creating the Delivery in the Supplying Company Code 
Use 
The system has transferred the cross-company-code order directly into the delivery due list of 
shipping point 1200 (Dresden). On the delivery creation date, you create and process a delivery 
in this shipping point. 

During the next activities you act as an employee in a shipping department of the supplying 
company code. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Collective Processing of Documents for 
Shipment → Sales Orders 

Transaction Code VL10A 

2. Enter the following data: 

Field Data 

Shipping point/receiving point 1200 

Deliv.creation date (to) The material availability date or the transport planning date of 
the first item 

Route FR0005 

Sales organization 2200 

3. Choose . 

4. Choose . 

 
If there are other entries that are not suitable for the selected delivery list, remove the 
marker for these orders. 

5. Choose  Background. 

6. Choose . 

7. Position your cursor on the report group, then choose Documents. 

You see the created deliveries.  

8. Make a note of the delivery number generated by this run. 

9. Choose  until the overview tree appears. 
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Picking in the Supplying Company Code 
Use 
You use a picking list for withdrawal from the warehouse of the materials that are to be delivered 
to the customer. This picking list is generated on the basis of a transfer order created for the 
delivery. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Picking → Create Transfer Order → Single Document 

Transaction Code LT03 

2. Enter the following data: 

Field Data 

Warehouse number 012 

Delivery Your noted delivery number 

Process Flow Background 

Adopt picking quantity 1 

3. Choose . 

The system issues a transfer order number.  

 
The description below assumes that the material for the delivery has been picked in 
accordance with the entries in the transfer request. Serial numbers are entered in the 
delivery item and goods issue is posted. 

4. Choose  until the overview tree appears. 

5. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → Post 
Goods Issue → Collective Processing via Outb. Delivery Monitor 

Transaction Code VL06G 

6. Enter the following data: 

Field Data 

Shipping point/receiving point 1200 

Planned goods mvt date Adopt system proposal 

Planned goods mvt date (to) Adopt system proposal 

Route FR0005 
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7. Choose . 

8. On the Goods Issue for Outbound Deliveries to be Posted screen, select the line with the 
delivery created in this run. 

9. Choose Subsequent Functions → Change outbound deliveries. 

10. Select the delivery item, then choose Extras → Serial numbers. 

11. In the Maintain Serial Numbers dialog box, choose . 

12. On the Display Material Serial Number: Serial Number Selection screen, enter the following 
data (in the Serial number selection screen area): 

Field Data 

Plant 1200 

Storage location 0001 

13. Choose . 

14. On the Display Material Serial Number: Serial Number List screen, select 10 serial numbers. 

You can make multiple selections by using the CTRL-Key. 

Choose only serial numbers without values in the Description of technical object field. 

15. Choose . 

16. In the Maintain Serial Numbers dialog box, choose . 

17. On the Delivery ... Change: Overview screen, choose . 

The Goods Issue for Outbound Deliveries to be Posted screen appears. 

18. Select the delivery, then choose  Post Goods Issue. 

The Actual Goods Issue Date dialog box appears. 

19. Choose . 

You have now confirmed the proposed date as the actual goods issue date. The system 
confirms the goods movement. 

20. Choose  until the overview tree appears. 
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Creating Invoices for Customers in Ordering Company 
Code 
Use 
When you post the goods issue, the system enters the delivery in the billing due list of sales 
organization 2200 (France). Sales organization 2200 uses this delivery to create an invoice for 
the customer. The billing document contains both the sales price and the internal price. As in the 
sales order, this is purely a statistical entry. 

You now act as an employee of sales organization 2200 (France) to create an invoice. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Process Billing Due List 

Transaction Code VF04 

2. Enter the following data: 

Field Data 

Billing date from Today‘s date 

Billing date to Today's date (defaulted) 

Sales organization 2200 

Delivery-related (in the Documents to be selected screen area) Select 

3. Choose  DisplayBillList. 

The system proposes all the deliveries due on the current date for the selected sales 
organization. 

 
Note that there could be more deliveries (from previous processes) ready for billing 
than you created in this process. If this is the case, simply deselect the deliveries that 
do not belong to your current IDES process. 

4. On the Process Billing Due List screen, choose . 

The system displays your group number. 

5. Place the cursor on the line with the group number and then choose Documents. 

You see the sales document created for your group. 

6. Note the billing document number in the SD doc. column. 

7. Position your cursor on the line containing your sales document, then choose  Display 
document. 

8. Select your position. 
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9. Choose Go to → Header → Header. 

In the accounting data you see that the invoice is assigned to the company code 2200 
(IDES France). 

10. Choose . 

11. On the Invoice ...(F2) Display: Overview of Billing Items screen, mark the item and choose 
 (in the lower area of the screen). 

12. On the Invoice..(F2) Display: Item Data screen, mark the condition PI01 and choose . 

You reach the Invoice ...(F2) display: Item Data screen. 

Condition PI01 is marked as statistic in the invoice for the end customer. 

13. Choose . 

14. On the Invoice..(F2) Display: Item Data screen, choose  Analysis. 

15. On the Condition determination analysis screen, scroll down until you can display the 
condition type VPRS Cost appears. 

16. Double click on the VPRS. 

 
The condition Cost (VPRS) is part of the pricing procedure. It has statistic character 
and shows the goods issue value in the invoice. In this case goods issue is posted in 
a different company code to that of the billing document, so the condition is ignored. 
The cost that is transferred to the Sales Information System and to Profitability 
Analysis is the condition value for the internal price, rather than your value. 

15. Choose  until the overview tree appears. 
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Creating Internal Invoices in the Ordering Company 
Code 
Use 
By creating an invoice for the end customer, the delivery is entered into the billing due list for the 
sales organization of the supplying company code. An internal invoice is created to the supplying 
company code. This invoice includes the internal price for billing. 

Create the invoice as if you were an employee for sales organization 1000 (Germany). 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Process Billing Due List 

Transaction Code VF04 

2. Enter the following data: 

Field Data 

Billing date from Today‘s date 

To Today's date (defaulted) 

Sales organization 1000 

Delivery-related (in the Documents to be selected screen area) Deselect 

Intercompany billing (in the Documents to be selected section) Select 

 
ln the Documents to be selected screen area, deselect any other fields that are 
selected. 

3. Choose  DisplayBillList. 

The system lists all deliveries that are open for internal billing on the selected date. 

 
Note that additional deliveries (from previous IDES processes) may be displayed that 
are open for billing. If this is the case, simply deselect the deliveries that do not 
belong to your current IDES process. 

4. On the Process Billing Due List screen, choose . 

The system displays your group number. 

5. Position your cursor on the line containing your user name, then choose Documents. 

You see the sales document created for your group. 

6. Make a note of this document number. 
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7. Position your cursor on the line containing your sales document, then choose  Disp. doc.. 

8. Select your position, then choose . 

9. Choose the Item partners tab page. 

The payer of this billing document is the ordering company code. 

10. Choose  until the screen Intercompany Billing ... Overview of Billing Item appears. 

11. Choose Goto →Header →Header. 

In the area of the accounting data, you see that the billing document is assigned to the 
company code 1000 (IDES AG). 

12. Choose . 

13. On the Intercompany Billing xxx (IV) Display: Overview of Billing Items screen, select the 
item, then choose  (in the lower area of the screen). 

14. Select condition PR00, then choose . 

The price PR00 calculated in the billing document for the customer is inactive in the 
internal billing document. 

15. Choose . 

The Intercompany Billing ### Display: Item Data screen appears. 

16. Select condition ZIV1, then choose . 

The price for condition type ZIV1 is the active price for this internal billing document. 

17. Choose  until the Intercompany Billing ### Display: Item Data screen appears. 

18. Scroll down the section until you can display the condition type VPRS Cost. 

 
Unlike the end customer invoice in the ordering company code, the system 
determines the condition Cost (VPRS) for the internal invoice in the supplying 
company code. You see  the goods issue value that is forwarded as costs to the 
Sales Information System and to Profitability Analysis. 

It has been agreed between the company codes that the internal invoice of the supplying 
company code is to be posted automatically as an incoming invoice in the Financial 
Accounting of the ordering company code. 

19. On the Intercompany Billing xxx (IV) Display Item Data screen, choose Goto → Header → 
Output. 

You then reach the Intercompany Billing (IV) Display: Output screen. 

The Invoice receipt IV (RD04) output has been defined for internal invoices. This output 
accesses a program that posts the respective amount to the vendor account, using the 
data in the invoice from the ordering company code. 

20. Choose  until the overview tree appears. 
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Evaluating Incoming Invoices in Financial Accounting 
Use 
The system uses the data in the internal invoice that you created in the supplying company code 
to automatically generate a vendor invoice in comapny code 2200 (IDES France). In this process 
step, you display this vendor document. 

1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Payable → Account → 
Display/change line items 

Transaction Code FBL1N 

2. Enter the following data: 

Field Data 

Vendor account 10000 

Company code 2200 

Open items Select 

3. Choose . 

4. In the left screen area open the folder Document data. 

5. Select the Reference option in the folder. 

6. Choose . 

7. Under Dynamic Selections, enter the following data: 

Field Data 

Reference Document number of the internal invoice preceded by two zeros 

(Example: Document number = 90005389 

Entry = 0090005389) 

8. Choose . 

On the Display Vendor Line Items: Basic List screen, you see an open item that has 
been created on the basis of the incoming invoice document. 

9. Choose  until the overview tree appears. 
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Customizing in Prof. Analysis (CO-PA) for Cross Code 
Sales 
Use 
Customizing entries are required to transfer the values from the previous process steps into the 
corresponding fields in Profitability Analysis. 

One prerequisite is a characteristic to classify internal and external customers. For this purpose, 
you create the characteristic Intercompany business (cross-company code sales) in Profitability 
Analysis. This differentiates customers according to external and affiliated companies. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Master Data → 
Maintain Derivation Rules 

Transaction Code KEDE 

 
If you are executing a profitability analysis transaction for the first time since logging 
on to the system, a dialog box appears. 

2. In this case, enter the following data: 

Field Data 

Operating concern IDEA 

Type of Profit. Analysis Costing-based 

3. Choose . 

This dialog box is shown only once during the session. Once you have made your 
selection, the system always selects the given operating concern and the relevant type of 
profitability analysis. 

4. On the Characteristic Derivation: Maintain Entries screen, select Derivation rule: Customer 
→ Intercompany ind., then choose  Display rule values. 

5. On the Characteristic Derivation: Display Values screen, you see the number range interval 
used to distinguish the customer structure. Customer numbers 1 - 9999 are defined as 
external customers (E), customer numbers 10000 - 99999 are defined as affiliated 
companies (I). 

6. Choose  until the overview tree appears. 

The assignment of the condition types from SD to the value fields in CO-PA also needs 
to be modified. The condition types for intercompany business ZIV1 and PI01 need to be 
assigned to their respective value fields as Internal Revenue and Internal Cost. 

7. Call up the transaction as follows: 

Menu Path Tools → AcceleratedSAP → Customizing → Edit project 

52  April 2001 



 SAP AG Sales and Distribution (SD) 

  Customizing in Prof. Analysis (CO-PA) for Cross Code Sales 

Transaction Code SPRO 

8. On the Customizing: Edit Project screen, choose  SAP Reference IMG. 

9. Choose Controlling → Profitability Analysis → Flows of Actual Values → Transfer of Billing 
Documents. 

10. Choose  Assign Value Fields. 

11. In the dialog box, choose  Choose. 

The Change View CO-PA: Assignment of SD Conditions to Value Fields: Overview 
screen appears. 

12. Scroll down to condition type PI01. 

This condition type is assigned to value field VV140 Cost of goods sold and is therefore 
transferred to Profitability Analysis as a cost of the ordering company code. 

13. Scroll down to condition type ZIV1. 

This condition type is assigned to value field VV010 Revenue. 

 
This ensures the correct flow of values to Profitability Analysis. The amount 
represented by the cost of goods sold for the ordering company code is the revenue 
for the supplying company code. 

14. Choose . 

15. In the dialog box, choose . 

16. Choose  until the overview tree appears. 
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Displaying Line Items in Profitability Analysis for 
Ordering Company Code 
Use 
When you create billing documents, the data flows into Profitability Analysis. To check which 
value flows were triggered by the external or internal billing documents, you now examine the 
corresponding postings. 

Procedure 
10. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Information System 
→ Display Line Item List → Actual 

Transaction Code KE24 

11. Enter the following data: 

Field Data 

Currency type B0 

Record type F 

Period/year Current month/year (MM.YYYY) 

Entered by Your user name 

Billing date Today’s date 

12. Choose . 

If the Line items dialog box appears, choose  Continue. 

The Display Actual Line Items: List screen appears. You see a list of the billing document 
items. The system displays selected detail information for each item, such as Document 
number or Entered by. The line items are displayed in the operating concern currency 
(currency type B0). 

13. Double-click on the ref. doc. no. field for the document you have created for the external 
billing document for currency type BO. 

14. Choose  or  to display these characteristics. 

As you see on the Display line items screen, the line items use the business transaction 
with the French customer 2500 Adecom SA (customer-related characteristic) from the 
French company code 2200. The Intercompany Ind. field is marked with E  (customer-
related characteristic). This means that the system has used Customizing to recognize 
the customer as external. 

The article is assigned to plant 1200 (article-related). The profit center (article-related) 
and the business area, however, are related to the French organizational units. 

 
The characteristics represent all the dimensions that can be used in the profitability 
analysis. These characteristic values are derived from the customer and material 
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master data and from SD partner roles (such as sales representatives) or from CO-
PA-specific characteristics. 

15. Choose the Value fields tab page. 

The currency of this posting is the French franc. The applicable currency conversion rate 
to the currency of the operating concern is also given. 

16. Choose  or  to see the mentioned fields. 

On these screens, you see detailed information on order and billing quantities, revenues, 
discounts and detailed product cost components, which are derived from the Sales and 
Product Costing areas.  

In the revenue field, you see the sales revenue in DEM that corresponds to the order 
value in FRF. 

 
As the main currency for the operating concern is DEM, all values are calculated in 
DEM accordingly. 

In the Cost of goods sold field, you see the internal cost price as a cost factor for the 
ordering company code.  

Note this value. 

17. Choose Environment → Integration. 

18. Mark Display billing document, then choose . 

19. Select the billing document, then choose  (in the lower area of the screen). 

On the Display invoice...:Item data screen, you can see the sales revenue in FRF (DM 
revenue/ exchange rate x 100) under condition type PR00, and the condition type PI01, 
which specifies the internal cost (purchase price /exchange rate *100). 

20. Choose   until you reach the Display Actual Line Items: List screen. 
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Displaying Line Items in Profit. Anal. For Supp. 
Company Code 
1. On the Display Actual Line Items: List screen, call up the document that you created for the 

internal billing document (billing type IV) by double-clicking on it. 

2. Choose  or  to display the mentioned characteristics. 

As you can see on the Display Line Items screen, the customer is now the ordering 
company code 22000 IDES France SA and sales are invoiced to the supplying company 
code 1000 Germany. Frankfurt (see special features). Accordingly, the currency for this 
posting is DEM. The Intercompany Ind. characteristic is marked with an I. This means 
that the R/3 system has recognized the company as an internal, or otherwise-related, 
company using Customizing for the customer. 

The article is assigned to plant 1200. The profit center and the business area now 
correspond to the German organizational units. 

3. Choose the Value fields tab page. 

4. Choose  or  to display the mentioned characteristics. 

In the Revenue field, you see the sales revenue in DM. This could be seen in the 
ordering company code as a cost factor. 

In the Purchase price field, you see the standard price from the material master. This 
specifies the manufacturing costs in the supplying company code. 

Note this value. 

5. Choose Environment → Integration. 

6. Mark Display Material and choose . 

7. In the Display material (Initial) screen, confirm the material proposed by the system by 
choosing . 

8. In the Display ... Material (Finished product) screen, choose the Accounting 1 tab page. 

In the Current evaluation field, the standard price is used for price control. This is the 
value of the manufacturing costs (multiplied by the sales quantity), which are charged to 
the supplying company code. 

9. Choose  until the overview tree appears. 
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Profitability Report Analysis 
Use 
As shown in the line item display, the data is sent to the profitability analysis when the billing 
documents are created. You now call up a profitability report and check performance at operating 
concern and company code level. 

 
As described in Customizing in the profitability analysis (CO-PA) for cross-company sales, an 
intercompany indicator was created in the profitability analysis. This differentiates between 
internal and external customers. For reporting at company-code level, the revenues and costs of 
the various goods (billing type F2 or IV) areentered. At operating concern level, only the revenue 
from the external customer and the manufacturing costs of the supplying company code are 
entered (for balance sheet reasons). Below you see the effects of setting the intercompany 
indicator for reporting. 

Procedure 
21. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Information System 
→ Execute Report 

Transaction Code KE30 

22. Open the folder Report. 

A list of all CO-PA reports that are already defined is displayed. 

23. Mark report IDES-150, then choose . 

A dialog box appears in which you can enter variables for the report. 

24. Enter the following data: 

Field Data 

Article R-1001 

Fiscal year Current year 

Period from Current month 

To period Current month 

25. Choose . 

After issuing a message to point out that the data has been reselected, the system 
issues the report list.  

On the Execute Intercompany – Business research: Detail list screen, the data from the 
IDES business transaction example is contained in the first column with the IC indicator 
E (external customer). This corresponds to the values from the French company code 
(see column 4) and shows the revenue and cost factor from internal sales. 

In the second column, the IDES values are displayed with the IC indicator I (related 
company). This data is relevant to the success of the supplying company code (see 
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division 5). The revenue corresponds to the internal costs between the two company 
codes and the purchase price gives the manufacturing costs. 

The third column contains the amounts from the IDES company without setting the 
intercompany indicator. This means that the same business transaction is displayed with 
double revenues and costs. This is not desirable from an operating concern viewpoint. 

 
For operating concern reports therefore, a difference must be made between reports 
that deal with internal business transactions and those that deal with external ones. 
This does not need to be the case from a company code viewpoint. 

26. Choose  until the overview tree appears. 

27. In the dialog box, choose Yes. 
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Third-Party Order Processing 
Purpose 
The French branch of the IDES Group is purely a sales company, without its own production 
plants, and is responsible for the French-speaking market. 

The goods can be delivered to the customer in different ways: 

• Delivery from the company’s own stock, which is procured from other IDES group sites by 
means of stock transfer (see Cross-Company Sales Processing). 

• Delivery from the stock of another IDES group company (see Cross-Company Sales 
Processing) 

• Delivery by an external supplier (third-party order processing) 

In third-party processing the company transfers the sales order to an external vendor. This 
vendor delivers the goods directly to the customer and invoices the IDES company. The 
customer receives an invoice from the IDES company’s sales office. 

You can find more information about this process under  [Page 61]. 

Process Flow 
You can find the data for this process under  [Page 62]. 

1. Creating Sales Orders and Purchase Requisitions [Page 63] 

2. Creating a Purchase Order [Page 66] 

3. Posting a Goods Receipt [Page 68] 

4. Posting Invoice Receipt for Purchase Order [Page 70] 

5. Invoicing the Sales Order [Page 72] 
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Additional Process Information 
Item Categories 
In this example, we assume that the material for the customer order is delivered mainly using 
third-party order processing. For this reason, material M-02 has been assigned to item category 
group BANS (third-party item) in the sales data. The standard system proposes item category 
TAS (third-party item) for a material assigned to this group. This item category triggers third-party 
order processing.  

If a material is delivered only occasionally by third-party order processing, you assign it to a 
different item category group. For a material that has been assigned to item category group 
NORM (standard item), the system proposes item category TAN (standard item). Materials in this 
item category are delivered by your company.  

However, the standard system allows you to change item categories. Sometimes materials 
(usually delivered by your company) are provided by an external supplier. If this is the case, 
when processing orders, you can choose item category TAS instead of TAN. This triggers third-
party order processing.  
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Data Used During This Process 
Field Data Description 

Order type OR Standard order 

Sales organization 2200 Sales organization for sales order 

Distribution channel 10 Distribution channel for end customer 

Division 00 Cross-divisional 

Customer 2501 Customer 

Material M-02 Trading goods 

Purch. organization 2200 Sales organization France 

Purchasing group 220 Purchasing group Paris 

Plant 2200 Plant Paris 

Vendor 1010 Vendor 

Company code 2200 IDES France 
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Creating Sales Orders and Purchase Requisitions 
Use 
In this first process step, you act as an employee in the sales order processing department for 
the sales organization in France. The customer orders a material that is to be delivered with third-
party order processing. 

Procedure 
28. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

29. Enter the following data: 

Field Data 

Order type OR (standard order) 

Sales organization 2200 

Distribution channel 10 

Division 00 

30. Choose . 

31. Enter the following data: 

Field Data 

Sold-to party 2501 

Purch.order no. BE-787044 

PO date Today‘s date 

Req.deliv.date Today’s date +2 working days 

Pricing date Today‘s date 

Material M-02 

Order quantity 2 

32. Choose . 

33. In the dialog box, choose . 

The system goes to the Standard Order: Purchase Order Scheduling screen, because it 
cannot meet the requested delivery date. 

 
The item is scheduled automatically in the sales order, taking into account the 
planned delivery and processing times for the purchase. The purchase processing 
time is the time needed to convert a purchase requisition into a purchase order. It is 
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determined for each plant. For plant 2200, it is one working day.  The planned 
delivery time (taken from the purchasing information record) is five calendar days. 

34. Choose Complete dlv. 

35. Select the item and choose . 

36. You see that the system has generated two schedule lines. 

The first schedule line contains the same date as the customer’s requested delivery date. 
No quantity is confirmed for this date. The date for the second schedule line is based on 
automatic purchase order scheduling. The order quantity is confirmed for this date. 

37. Select the second schedule line, then choose . 

38. Choose the Procurement tab page. 

39. Choose Edit in the External procurement section. 

 
When you save the sales order, the system enters the number of the purchasing 
document in the Purchase requisition field.  

40. You see in the Procurement options section that the system has proposed vendor 1010 
(Sunny Electronics GmbH). 

 
The system has proposed this vendor because it has been selected as the fixed 
procurement source in the source list for material M-02. You can change this 
proposal by going to Edit → Assign supply source. 

41. Choose Environment → Master data → Info record. 

42. Choose Purch. org. data 1. 

In the Control section, a planned delivery time of 5 days is given. This time is necessary 
if the material is procured from vendor 1010. The purchase scheduling time has been 
based on this delivery time. 

43. Choose  until the Create Standard Order: Overview screen appears. 

44. Select the item and choose Goto → Item → Texts. 

45. Double-click on the Purchase order text line an enter the following data: 

Field Data 

Language (below right) English 

46. Enter the following text in the text editor: 

Notify Mr. Dupic at Bernadin SA by telephone when the delivery is due to arrive. 

47. Choose . 

48. On the Create Standard Order: Item Data screen, choose . 

The R/3 System issues a sales order number.  

49. Make a note of the document number. 
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50. Choose  until the overview tree appears. 

In the dialog box choose No. 
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Creating a Purchase Order 
Use 
A purchase requisition was created from the sales order. In purchasing, a purchase order is 
created  based on this requisition. In this first process step, you act as an employee in 
purchasing group 220 for the French IDES company. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase 
Requisition → Follow-On Functions → Create Purchase Order → Via 
Assignment List 

Transaction Code ME58 

2. Enter the following data: 

Field Data 

Purchasing group 220 

Purchasing organization 2200 

Vendor 1010 

Plant 2200 

Scope of list A 

Delivery date Today’s date +2 working days 

3. Choose . 

4. Place the cursor on the second line for the selected vendor, and choose Process 
assignment. 

5. Enter the following data: 

Field Data 

Order type NB 

6. Choose . 

 
If any other purchase orders are available for the current date, the system displays 
the Create Purchase Order: Increase PO dialog box, which you can use to expand 
the available purchase orders. In this case, choose New purchase order. 

7. On the left side of the screen, under Open requisitions, select the purchase requisition 
number. 

8. Choose . 

9. To open the header data area, choose  Header. 
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10. To display the address of the vendor, choose the Address tab page. 

11. To open the Item details area, choose  Item details. 

12. Choose the Delivery tab page. 

 
The goods receipt indicator is activated as a default value. This means that goods 
receipt has to be posted for a third-party item. Posting goods receipt is demonstrated 
in another process step. In system settings, you can use the account assignment 
category to control whether goods receipt is defined for a third-party item.  

13. Choose . 

Make a note of the purchase order number 

14. Choose  until the overview tree appears. 

15. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Messages → Print/Transmit 

Transaction Code ME9F 

16. Enter the following data: 

Field Data 

Document number Your PO number 

17. Choose . 

18. Select the purchase order and choose Display message. 

 
Note the text about delivery notification that has been taken from the sales order 
item. 

19. Choose . 

20. Select your purchase order, then choose Output message. 

 
The system indicates that the message has been issued (green tick). In this 
example, the message has been configured so that it is entered in a spool request 
first and is not output immediately. 

21. Choose  until the overview tree appears. 

 

April 2001  67 



Sales and Distribution (SD)  SAP AG 

Posting the Goods Receipt 

Posting the Goods Receipt 
Use 
The supplier reports to the purchasing department that the materials have been delivered to the 
customer. 

 
Due to the fact that third-party order processing is a goods movement from the 
supplier directly to the customer, this does not affect inventory management. 
However, the purchasing department at IDES France wants to record the delivery to 
the customer in the system and creates a goods receipt for the third-party order. 
Posting goods receipt has the following effects: 

Inventory is not updated. Goods receipt is posted directly to consumption. • 

• 

• 

The order value is posted to a GR/IR clearing account for invoice verification. 

Goods receipt can be monitored in the purchase order history. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Receipt → For Purchase Order → PO Number 
Known 

Transaction Code MIGO 

2. Enter the following data: 

Field Data 

Purchase order Your purchase order number 

3. Choose . 

The system copies the header data of the purchase order into the header data area of 
the GR document. 

The purchase order items are copied into the item overview. 

The PO number you entered is copied into the Current PO order field, and the PO 
number field is once again ready for input.  

If you click on individual items, the system displays an item data screen, which allows 
you, for example, to change the incoming quantity. 

4. In the header data area of the General  tab page, enter the following data: 

Field Data 

Document date Today's date (default) 

Posting date Today's date (default) 

5. To open the item detail area, choose  Detail Data. 
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6. Choose the WK tab page to check your organization data.  

7. In the item overview area, select OK for your item. 

 
If the OK indicator in the item overview area is not active, close the item detail area 
or select Item OK in the lower area of the item detail. 

8. Choose Post. 

 
The system confirms the posting and assings a material document number. Make a 
note of this number. 

9. Choose  until the overview tree appears. 
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Posting the Invoice Receipt for Purchase Order 
Use 
The external supplier has shipped the materials to the customer and bills IDES France for the 
delivery. In invoice verification, you post the invoice receipt. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Follow-On Functions → Logistics Invoice Verification 

Transaction Code MIRO 

2. Choose Edit → Switch company code. 

In the Enter Company Code dialog box, the system displays the company code that is 
currently active for invoice verification. This refers to the company code last used by the 
user. 

3. Enter the following data: 

Field Data 

Company code 2200 

4. Choose . 

5. In the field above the item overview, use the F4 input help to choose Purchase 
order/Scheduling agreement (if it is not already defaulted). 

You can also use this activity, for example, to enter invoices with reference to the 
delivery schedule. The system defaults the value last entered by the user. 

6. On the Basic Data tab of the header data area, enter the following data: 

Field Data 

Invoice date Today’s date 

Posting date Today's date (default) 

Tax amount, right field E4 (TVA LEE 20,6% sur importation) 

To the right of the Purchase order/Scheduling 
agreement field 

Your purchase order number 

7. Choose . 

 
In the item overview, the system displays the purchase order data. In the balance 
field, it displays the net amount that is required to calculate the gross amount. The 
traffic light in the balance field is red. 
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The value of the goods delivered plus VAT is normally entered on the invoice sent to 
you by the vendor. In this scenario, we simulate this procedure and determine the 
invoice amount ourselves. 

8. Enter the following data: 

Field Data 

Amount Determined gross amount 

 Select 

9. Choose . 

 
When you confirm your entries, the traffic light in the balance field changes to green. 

10. Choose . 

If you are requested by the system to enter a barcode, choose . 

The system confirms with the message Document no....created. 

11. Choose  until the overview tree appears. 
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Invoicing the Sales Order 
Use 
After receiving the invoice for the third-party order, the customer is billed for the relevant order in 
this step. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Process Billing Due List 

Transaction Code VF04 

2. Enter the following data: 

Field Data 

Billing date from Today‘s date 

Billing date to Today's date (defaulted) 

Sales organization 2200 

Sold-to party 2501 

Order-related (in the Documents to be selected section) Select 

Delivery-related (in the Documents to be selected screen area) Deselect 

3. Choose  Display BillList. 

The system proposes all the orders due on the current date for the selected sales 
organization. 

 
Note that there could be more orders (from previous processes) ready for billing than 
you created in this process. If this is the case, deselect the orders that do not belong 
to your process. 

The invoice receipt for the purchase order has updated the billing date of the order 
item. It can now be found in the billing due list, with the posting date of the invoice 
receipt document. 

4. Choose . 

The system generates a group number for the billing documents that you have created. 

5. Place the cursor on the group number and then choose Documents. 

The invoices created for the group number are displayed in a list. 

6. Place the cursor on the sales document and choose  Disp. doc. 
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The system copies the amount to be billed from the invoice receipt document, which 
has been posted based on the incoming invoice. 

7. Select the item, then choose Goto → Item → Item conditions. 

The item condition VPRS (Cost) is displayed. 

 
The amount of the incoming invoice has been transferred as the cost of the billing 
document (net value minus 3 percent cash discount). 

8. Choose  until the overview tree appears. 
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Sales Processing according to ATP logic and 
Backorders  
Purpose 
To increase the planning security as well as the delivery availability, the IDES model company 
checks the material availability within the sales order. The availability check is done to secure 
coverage of requirements by either stock or planned inward stock movement. This helps 
recognizing the availability on requirements date already when entering the sales order or 
whether it is necessary to plan ahead in a different way to ensure material availability. 

If the R/3 System detects a material shortfall, it automatically assigns the quantity available to the 
IDES sales via a deliberate backorder processing. 

The process is about the availabiltiy check based on the ATP quantity. When calculating the ATP 
quantity (ATP = available to promise) the R/3 System checks whether all outward movements are 
covered by existing inward movements and whether the inward movements contain minor 
quantities still open for incoming outward movements. These minor quantities not yet assigned 
form the ATP quantity. 

You can find more information about this process under  [Page 75]. 

Process Flow 
You can find the data for this process under  [Page 76]. 

1. Checking initial situation and establish if necessary [Page 77] 

2. Creating sales orders [Page 80] 

3. Analyzing current requirements and stock development [Page 84] 

4. Processing master production scheduling (MPS) [Page 85] 

5. Processing rescheduling [Page 87] [Page 87] 

6. Converting planned order into production order [Page 89] 

7. Creating Sales Order [Page 91] 

8. Processing rescheduling [Page 93] 

9. Backorder Processing [Page 95] 

10. Establishing the Initial Situation [Page 97] 
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Additional Process Information 
Controlling the availability check 
The scope of the availability check is controlled via the checking group and the checking rule. 
The checking group is enclosed in the plant data of the material master record. With the help of 
the checking rule one can distinguish the individual sales activities (sales order, delivery). For the 
process described here we defined a new checking group and determined the scope of checking 
for this checking group at the time of order creation and delivery time. We will deal with the scope 
of check at a later time in this script.  

The availability check´s reaction described in the process is based on the following system 
settings: 

• For the new checking group we activated the checking with cumulative amounts. This setting 
helps avoiding inconsistencies in the confirmation situation, which could emerge by a shift in 
time of inward movements. 

• On the level of sales and distribution we determined that the availability works within the 
framework of a rescheduling run with the option ”delivery proposal” 
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Data Used During This Process 
Field Data Description 

Material P-106 Finished product pump 

Plant 1000 Plant Hamburg 

Order type OR Standard order 

Sales organization 1000 Sales organization Germany 

Sales channel 10 Sales channel for consumer 

Division 00 Cross-division  

Customer 1320 Sold-to party of sales order 1 

Customer 2000 Sold-to party of sales order 2 

Customer 2006 Sold-to party of sales order 3 

Shipping point 1000 Shipping point Hamburg 
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Checking initial situation and establish if necessary 
Use 

To run the process you need a definite starting situation. In the last step you will create the 
starting situation once again. Firstly check, whether your predessor executed this last step 
beforehand. 

Procedure 
Checking material stock and perhaps correct it 

This process assumes a stock of 100 pieces. The following CATT procedure checks whether 
this stock exists and perhaps processes an inventory posting. 

1. Call up the transaction as follows: 

Menu Path Tools → ABAP Workbench → Test → Test Workbench → CATT Extended

Transaction Code SCAT 

2. Enter the following data: 

Field Data 

Test case Z_IDES_P_106 

3. Choose . 
4. Select the following options: 

Block Option 

Log type W/o 

Processing mode Background 

Variants W/o 

5. Choose . 
In the lower area of the screen (action line) the R/3 System displays what transactions 
are currently being processed. When the last run has been finished you receive a 
confirmation. 

6. Choose  until the overview tree appears. 

Checking inward and outward movements and perhaps deleting them 
7. Call up the transaction as follows: 

Menu Path Logistics → Production → Production Planning → MPS → Evaluations → 
Stock/Reqmts list 

Transaction Code MD04 

8. Choose the Individual access tab page. 

9. Enter the following data: 
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Field Data 

Material P-106    

Plant 1000 

10. Choose . 

The list should contain exactly one entry with the MRP element ”Stock” (Plant stock). It 
displays a quantity available of 100. If this is the case, choose . 

11. Choose  until the overview tree appears, to continue with process step Creating sales 
order [Page 80]. 

 
If you do not encounter this starting situation you will have to produce it yourself by 
executing the following steps. 

12. Should the list contain entries for MRP element ”Sales order” (Order) you have to firstly 
delete them. On the Stock/Requirements List: Individual Lines screen, position the cursor on 
the respective sales order and choose . 

13. Choose Sales Document → Delete. 

14. In the dialog box choose Yes to delete the order properly. 

15. Choose . 

16. Choose . 

The sales order deleted before can no longer be found on the list. 

17. Procede like that (step 12-16) for other sales orders that are still on the list. 

Should the list contain entries for the MRP element ”production order” (PR-ORD) you 
have to flag this production order for deletion.  

18. Position the cursor on the production order and choose . 

19. Choose Order → Functions → Deletion flag → set. 

20. Choose . 

21. Choose . 

Should the list contain entries for the MRP element ”planned order ” (PL-ORD) you have 
to delete the planned order.  

22. Position the cursor on the production order and choose . 

23. Choose Sales Document → Delete. 

24. Confirm the dialog box with Yes. 

25. Choose . 

26. Choose  (perhaps repeatedly). 

Now the list displays a plant stock of 100 pieces. This means that the starting situation 
necessary for the process step is now completed. 
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27. Choose  until the overview tree appears. 
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Creating sales orders 
Use 

When creating and editing a sales order one checks the availability of the material ordered. If 
the material is not available on the customer´s desired date the person responsible gets 
notice of the situation and gets informed when the material will be available again. The 
amount confirmed by the availability check is reserved for the sales order in order to make 
sure that this material is taken into account when the R/3 System processes other sales 
orders using this material.  

You will now play the role of a clerk in the sales order administration. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data:  

Field Data 

Order type OR 

Sales organization 1000 

Distribution channel 10 

Division 00 

3. Choose . 

4. Enter the following data: 

Field Data 

Sold-to party 1320 

Purch. order no. BE-801258 

PO date Current date 

Req.deliv.date Current date + 6 working days   

Pricing date Current date 

Material P-106 

Order quantity 60 

5. Choose . 

6. To skip any messages, choose . 

7. Choose the Shipping tab page. 
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The R/3 System displays a material availability date (Field: Mat.av.dt) for the item. 
The material availability date is determined by calculating backwards from the 
customer´s required delivery date and also considering the time that will be needed 
for other activities such as picking, packing, loading and transportation. The material 
availability date is the date on which the requirement is reported to the MRP. 

8. Choose . 

The R/3 System awards a sales order number. Write down this number. 

 
This sales order is now called Sales order 1. 

9. Create another sales order. Therefore enter the following data: 

Field Data 

Sold-to party 2006 

Purch. oder no. ET-439154 

PO date Current date 

Req.deliv.date Current date + 6 working days   

Pricing date Current date 

Material P-106 

Order quantity 50 

10. Choose . 

11. To skip any messages, choose . 

As the amount ordered by the customer is not available on the required delivery date, the 
R/3 System branches to the Standard order: Availability Control screen. 

 
The availability control is carried out for plant 1000, that was proposed in the sales 
order item. We can only confirm 40 pieces for the required delivery date. A complete 
delivery can only be confirmed after the end lead time that is displayed on this 
screen including the shipping and transportation times. One delivery proposal 
confirms 40 pieces for the required delivery date and the remaining 10 at a later time 
due to the replenishment lead time. 

12. Choose ATP quantities. 

You reach the Availability Overview screen informing you about the inward and outward 
movements posted. 

The MRP elements are displayed accumulated on a daily basis.  

13. To display the single records, choose  Totals records. 
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The MRP element ”Stock” displays a stock of 100 pieces. The sales order 1 is 
displayed as MRP element ”Order” with a requirement quantity of 60 pieces. The 
requirements date is the material availability date that was determined in the sales 
order via the delivery scheduling. Now the complete requirements quantity is 
confirmed. The accumulated ATP quantity is therefore only 40 pieces. The sales 
order you just entered will be displayed as simulated requirement in the overview 
(MRP element SimReq). 40 pieces ATP quantity are available for this order. This 
means that the availability control can therefore confirm a one-time delivery of 40 
pieces on the required delivery date. On the Availability Overview screen, the R/3 
System displays the end of the replenishment lead time of the material (field ”End 
lead time”). 

14. Choose  Scope of check. 

A dialogue box informs you about the availability check control. 

 
The availability check takes into consideration the stock freely available including 
safety stock. Other stock types being subject to usage restrictions are not 
considered. 

The checking evaluates planned orders and production orders as inward 
movements. For the planned orders the R/3 System only includes firmed orders. 
Firmed planned orders are orders that have already been edited by the MRP 
controller. They are no longer changed by an MRP controller. On the other hand 
there are sales requirements (Sales orders) and deliveries as outward movements. 

The replenishment lead time materials are included in the checking. This means that 
the availability check for the requirements is processed within the replenishment lead 
time. Requirements outside the replenishment lead time are generally available as 
the R/3 System assumes that these materials can be made available within the 
replenishment lead time via materials planning. If it is not possible to cover a 
requirement via inward movements, the end of the replenishment lead time is the 
earliest date on which one can confirm the materials. For in-house produced 
materials the replenishment lead time is maintained in the field Replleadtime of the 
MRP data. This is the estimated production time for a material across all production 
levels from procurement of the raw materials up to the final assembly. If this overall 
lead time is not maintained the R/3 System adopts the in-house production time as 
replenishment lead time. 

15. Choose . 

16. Choose . 

17. On the Standard Order: Availability Control screen, choose Delivery proposal. 

18. Select your item and choose . 

The R/3 System created two schedule lines due to the delivery proposal selected. 

19. Select the second delivery schedule and choose  Shipping. 

20. Choose the Shipping tab page. 
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The material availability date has been postponed to the end of the replenishment 
lead time. Starting from this material availability date the R/3 System determined the 
other dates displayed by a forward scheduling and also took into consideration how 
much time would be needed for activities connected to delivery such as picking, 
packing, loading and transportation. 

21. Choose . 

The R/3 System awards a sales order number. Write this number down.  

 
In the following we name this sales order Sales Order 2 

22. Choose  until the overview tree appears.  

In the dialog box Exit Order Processing choose No. 
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Analyzing current requirements and stock development 
Use 

Both sales orders you entered, represent a requirement from the MRP´s point of view. 

Playing the role of MRP controller in plant 1000 in this process step you get an overview 
about the current requirements and stock development of material P-106. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Production Planning → MPS → Evaluations → 
Stock/Reqmts list 

Transaction Code MD04 

2. Enter the following data: 

Field Data 

Material P-106 

Plant 1000 

3. Choose . 

You can see that both sales orders you just entered are listed here as requirements. 

 
Both sales orders report its complete order quantity as requirements to materials 
planning on the desired date. This means that the  materials planning has the 
task to procure the requirements for the customers required date.  

The sales order processing however, also provides the possibility to transfer the 
requirements according to the amounts and dates confirmed by the availability 
control. Therefore set the indicator in the field Date a. amount fix which will 
appear on the scheduling overview screen as well as on the screen for the 
availability check in the sales order. 

The quantity available is determined by the R/3 System by adding or subtracting 
the receipt or issue quantity per MRP element. 

4. Choose  until the overview tree appears. 
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Processing master production scheduling (MPS) 
Use 
Material P-106 is classified as master product in plant 1000. Master products are materials that 
have high influence on the company's value added or which allocate critical resources. Therefore 
they must be plannund with increased attention. 

In this process you take the role of an employee in the requirements planning and you are 
responsible for the planning of the material. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Production Planning → MPS → MPS → 
Single-Item, Single-Level 

Transaction Code MD42 

2. Enter the following data: 

Feld Data 

Material P-106 

Werk 1000 

Fields in the block MRP control parameter Transfer default values 

 
A single-item planning is executed, because in this process only the planning 
result of material P-106 is relevant. 

3. Choose . 

4. To skip any warning messages, choose . 

The system confirms that the requirements planning is executed. 

5. Choose . 

6. Call up the transaction as follows: 

Menu Path Logistics → Production → Production Planning → MPS → MPS → 
Single-Item, Interactive 

MD43 Transaction Code 

 
To check the planning result, you can use the interactive master production 
scheduling. There you do the fine-tune of the production plan for master products. 

7. Enter the following data: 

Feld Data 
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Material P-106 

Werk 1000 

Fields in the block Control parameter  Transfer default values 

8. Choose . 

9. To skip any warning messages, choose . 

 
The planning time fence determines a period, within which the R/3 system can't plan 
or change order proposals automatically. Thus the planner gets time for the manual 
planning of the critical products. To support planning, the system has created a 
planned order with the corresponding quantity. The planned order is dated to the end 
of the planning time fence. 

10. Position the cursor on the line with the planned order (PlOrd) and choose . 

11. Enter the following data: 

Field Data 

Date Date of the sales order 2 

12. Choose . 

The planned order is added to the list according to the new date. 

13. Position the cursor on the line with the planned order (PL-AUF) and choose . 

14. Choose . 

15. Choose . 

 
In the master production scheduling the critical products are one-level planned at the 
master product level. For the lower BOM levels dependent requirements are created 
without further planning of the BOM structure. The planning result won't be 
transfered to the dependent products until the master production scheduling is 
finished.  

16. Choose  until the overview tree appears. 
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Processing rescheduling 
Use 
After finishing a planning session the sales orders will be rescheduled. Based on the planning 
results the rescheduling process checks the availability of the sales orders. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Environment → Backorders 
→ Rescheduling → Execute 

Transaction Code V_V2 

 
Practically rescheduling will be executed overnight, because it requires much system 
resources. 

2. Enter the following data: 

Feld Daten 

Material P-106 

Plant 1000 

Unconfirmed documents required Select 

Simulation Deselect 

 
During the rescheduling the open sales order items release their confirmed 
quantities. The items are sorted according to delivery priority, creation date, 
document numberand item number and are then transfered to the availability check. 
Both sales orders are checked in the order of their creation date, because they have 
the same delivery priority. 

If the Unconfirmed documents required parameter is selected, at least one document 
of the material must be unconfirmed to assure that all documents of the material are 
transfered to the availability check. 

The delivery date of the sales order can be set as sorting criterion for the availability 
check, via the sorting criterion delivery date parameter (which you didn't choose). In 
this case every sales order is sorted according to the delivery date within the priority. 

Sales order items with the marks date and fixed quantity aren't rescheduled. 

3. Choose . 

The system displays a list of the rescheduling results. 

In the rescheduling log you can see, that sales order 2 has got a new confirmed quantity 
(column confirmed new). 

4. In the dialog box, choose Yes. 
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5. Choose  until the overview tree appears. 
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Converting planned order into production order 
Use 
In this process step the planned order is converted into a production order by the MRP controller. 
The production order has to be postponed even though it was planned differently. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Production planning → MPS → Evaluations → 
Stock/Reqmts list 

Transaction Code MD04 

2. Enter the following data: 

Field Data 

Material P-106 

Plant 1000 

3. Choose . 

4. Position the cursor on the line with the planned order and choose . 

5. Choose -> Prod.ord. 

 
Due to a machine breakdown the start of the production order is postponed three 
days.  

6. Enter the following data: 

Field Data 

Finish (in the block Dates) Delete date 

Start (in the block Dates) Previous date + 3 working days 

SchedType (in the block Scheduling) 1 (Forwards) 

7. Choose . 

8. Choose . 

The R/3 System determines a new order finish date. 

9. Choose .  

The R/3 System reports the allocation of a production order number.  

10. Choose (probably several times) , until the production order just created is displayed 
under the MRP element ProdOrd. 

The input date of the production order is placed after the requirements date of the two 
sales orders. 
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11. Choose  until the overview tree appears. 
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Creating Sales Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data:  

Field Data 

Order type OR 

Sales organization 1000 

Sales channel 10 

Division 00 

3. Choose . 

4. Enter the following data: 

Field Data 

Sold-to party 2000 

Purch. order no. CA-740398 

Order date Today´s date 

Req.deliv.date Today´s date + 8 working days 

Pricing date Today´s date 

Material P-106 

Order quantity 10 

5. Choose . 

If a dialog box appears, choose .  

6. Choose ATP quantities. 

The MRP elements are displayed accumulated on a daily basis. 

7. To display the individual records, choose  Totals records. 

 
The 10 pieces are only assigned to the sales order after completion of the 
replenishment lead time as the availability check includes a check of the 
accumulated incoming and issue quantities. The total amount of the incoming 
quantities is 110 pieces, the total amount of the precious issue quantites is 110 
pieces. The shortage check prevents that the ATP quantity of the production order is 
assigned to the new sales order.  

8. Choose . 

9. Choose Continue. 
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10. Choose .  

The R/3 System awards a sales order number. Write this number down.  

 
In the following we call this sales order Sales order 3. 

11. Choose  until the overview tree appears. 

12. If the dialog box Exit Order Processing appears, choose No. 
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Processing rescheduling 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Environment → Backorders 
→ Rescheduling → Execute 

Transaction Code V_V2 

2. Enter the following data: 

Field Data 

Material P-106 

Plant 1000 

Unconfirmed documents required Select 

Simulation Deselect 

3. Choose . 

 
Note that both sales order 1 as well as sales order 2 are confirmed due to the fact 
that their availability was checked at a time when the R/3 System had a sufficient 
ATP quantity available. If the parameter Unconfirmed documents necessary is 
set, the R/3 System has to have confirmed at least one more sales order of the 
material so that the sales order of this material will be checked. In our example 
this applies to Sales order 3 as the order quantity was not confirmed for the 
desired date.  

The R/3 System lists the results of the rescheduling  

4. Choose Deterioration. 

 
The R/3 System processed the availability check of the sales order items in the  
sequence delivery priority, creation date, document number and item number. As 
the orders have no different delivery priority, sales order 1 was checked first. It 
has the complete ATP quantity available and the order quantity of 60 pieces 
remains confirmed. Due to the production order postponement the situation for 
Sales order 2 deteriorates as the availability is checked later. The order quantity. 
The order quantity up to now confirmed for the desired date will now be 
distributed to two dates. For Sales order 3 the last one checked there is no 
change, due to the fact that in the shortage check 10 pieces were only be 
confirmed after the replenishment lead time. The planned order created from the 
requirements planning will not be included into the checking as it is not firmed. 

5. Choose  until the overview tree appears. 
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Backorder Processing 
Use 
The IDES Sales and Distribution uses backorder processing. Via backorder processing it is 
possible to list sales orders for the desired material and edit it manually respective to the 
confirmation. This can also even out shortfalls by assigning ATP quantities or taking back 
quantities confirmed somewhere else and be assigned once again. 

In the process mentioned here as an employee in the sales department you decide the Sales 
order 2 has priority before the Sales order 1 and is to be delivered with the complete order 
quantity for required delivery date. The restacking of the confirmed quantity is processed in the 
backorder processing. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Backorders → Backorder 
Processing → Material 

Transaction Code CO06 

2. Enter the following data: 

Field Data 

Material P-106 

Plant 1000 

Checking Rule  A ( = SD order) 

3. Choose . 

In the overview the R/3 System lists those incoming and issue quantities which are 
taken into consideration within the framework of the availability check. There is no ATP 
quantity available.  

4. Position the cursor on the Sales order 1 and choose  Change confirmation. 

In the block Sales Requirements the R/3 System offers the confirmed amount to be 
changed (Field Committed).  

5. Reduce this quantity by 10 pieces and choose . 

 
For Sales order 2 the R/3 System contains two entries in the list of the ATP 
situation this is due to the fact that the order quantity was distributed and 
confirmed by two schedule lines according to the delivery proposal.  

6. Position the cursor on the schedule line at a later time of Sales order 2 that displays a 
confirmed quantity of 10 pieces and select  Change Confirmation. 

In the block Sales Requirements the R/3 System offers the confirmed amount to be 
changed (Field confirmed).  
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7. Reduce this quantity by 10 pieces to 0 and choose . 

For the first schedule line of Sales order 2 the R/3 System provides the 10 pieces ATP. 

8. Position the cursor on the first schedule line of the Sales order 2 that displays a confirmed 
quantity of 40 pieces and choose  Change Confirmation. 

In the block Sales Requirements the R/3 System offers the confirmed amount to be 
changed (Field confirmed).  

9. Increase this quantity by 10 pieces to 50 and choose . 

10. Choose . 

11. Choose  until the overview tree appears. 
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Establishing initial situation 
Use 
For the process to be executed again, you re-establish the initial situation with this step. You will 
delete the inward and outward movements that have been entered during this process. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Production Planning → MPS → Evaluations → 
Stock/Reqmts.list 

Transaction Code MD04 

2. Enter the following data: 

Field Data 

Material P-106 

Plant 1000 

3. Choose . 

4. Position the cursor on the row that contains Sales order 1 and choose . 

5. Choose Sales document → Delete. 

6. In the dialogbox answer Yes when you are asked whether to delete the order. 

7. Choose  

8.  Choose  (probably repeat). 

The sales order just deleted can no longer be found in the list. 

9. Proceed likewise for Sales order 2 and 3 (steps 4-8). 

10. Position the cursor on the production order and choose . 

11. Choose Functions → Deletion flag → Activate. 

12. Choose . 

13. Choose . 

The list now only shows a plant stock of 100 pieces. 

14. Choose  until the overview tree appears. 
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Sales Processing With Availability Checks Against 
Allocations 
Purpose 
Sales organization 1000 (Germany) and sales organization 2200 (France) of the IDES company 
sell personal computers. These computers are produced in plant 1200 (Dresden). For specific 
personal computers the product allocations are determined by agreement between the 
production management of plant 1200 and the management of the two sales organizations 
involved. Each sales organization is entitled only to the agreed proportion of the agreed 
contingent of production of plant1200. Each sales organization allocates its contingent further 
among its distribution paths. 

For further information, see under  [Page 100] 

Process Flow 
You can find the data for this process under  [Page 101]. 

1. Create Process Starting Position [Page 102] 

2. Determine Material for Product Allocation [Page 104] 

3. Edit Planning Hierarchy [Page 105] 

4. Edit Product Allocation Planning [Page 108] 

5. Creating the Sales Orders [Page 111] 

6. Check Planning [Page 115] 

7. Create Other Process Starting Position [Page 116] 

 

 

April 2001  99 



Sales and Distribution (SD)  SAP AG 

Additional Process Information 

Additional Process Information 
Information Structure 
The product allocation data is saved in an information structure. In the standard system 
information structure S140 is delivered as an example of product allocation processing. This 
information structure allows product allocation processing by product allocation processing 
object, sales organization, distribution channel, customer, group and ordering party. As it is not 
necessary to put such details in the IDES company, we defined a new information structure S700 
that allows product allocation determination by product allocation processing object, sales 
organization and distribution channel. The order quantity is updated when you confirm the 
allocation quantity. The update periods for this quantity are determined from the allocation 
delivery date. 

Product Allocation Processing Method 
You can settle the product allocation processing order quantity against the product allocation 
quantity in two ways. The discrete ATP check bases the settlement on the current and future 
product allocation quantity. Product allocation quantities not used from previous periods are not 
taken into consideration. The cumulated ATP check settles the quantities against the remaining 
product allocation quantities using the standard ATP check logic. Product allocation quantities 
not used from previous periods are taken into consideration for the calculation of product 
allocation quantities available for the current period.  The product allocation processing scheme 
set up for this process uses the cumulated ATP check method.   
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Data Used During This Process 
Field Data Description 

Material R-1001 Personal computers 

Information Structure S700 Structure in which the product 
allocation processing data is saved 

Product allocation processing object R-1001 object to which the product allocation 
processing data apply 

Order type Standard order Standard order 

Sales organization 1000 Sales organization Germany 

Sales organization 2200 Sales organization France 

Distribution channel 10 Distribution channel for end customer 

Distribution channel 12 Distribution channel for retailers 

Division 00 Cross-divisional 

Customer 1320 Customer of the first sales order 

Customer 2000 Customer of the second sales order 

Customer 2006 Customer of the third sales order 
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Create Process Starting Position 
Use 
The process requires an initial situation. You create this starting situation in this step. 

Procedure 
1. Call the transaction as follows: 

Menu Path Logistics → Logistics Controlling → Flexible Planning → Master Data → 
Planning Hierarchy → Change 

Transaction Code MC62 

2. Enter the following data: 

Field Data 

Info structure S700 

3. Choose . 

4. In the dialog box, enter the following data: 

Field Data 

Prod. allocation object R-1001 

Sales organization No entry (delete any default) 

5. Choose . 

6. Choose Edit → Delete all Members. 

7. In the dialog-box that appears twice, choose Delete subtree(s).  

8. Choose . 

9. Choose  until the overview tree appears. 

10. Call the transaction as follows: 

Menu Path Tools →  ABAP Workbench →  Test →  Test Workbench →  CATT 
Extended 

Transaction Code SCAT 

11. Enter the following data: 

Field Data 

Test case Z_IDES_KONTI 

12. Choose . 

13. Select the following options: 

Block Option 

Log type - W/o Select 
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Processing mode - Background Select 

Variants - W/o Select 

14. Choose . 

In the status bar, you see which transactions are being processed. When the last 
procedure is completed, you receive a message that the R/3 System has posted a 
document. 

15. Choose  until the overview tree appears. 
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Determine Material for Product Allocation 
Use 
Materials the sales quantities of which are assigned via product allocations, have to be indicated 
in the R/3 System. This is done with the help of a product allocation processing scheme. 

Procedure 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master Data → Products → Material 
→ Other Material → Change 

Transaction Code MM02 

2. Enter the following data: 

Field Data 

Material R-1001 

3. Choose Select view(s). 

4. In the Select view(s) dialog-box, select the view Basic Data 1 and MRP Materials Planning 3 
and choose . 

5. Enter the following data: 

Field Data 

Plant 1200 

6. Choose . 

7. On the Basic Data 1 tab, enter the following data: 

Field Data 

Product schema R-1001 

 
The product allocation processing scheme determines product allocation criteria. 

8. On the Basic Data 3 tab, enter the following data: 

Field Data 

Strategy group 40 

9. Choose . 

10. Choose  until the overview tree appears. 
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Edit Planning Hierarchy 
Use 
Before the product allocation quantities can be planned, you must define a planning hierarchy. In 
the planning hierarchy you determine the sales organizations and distribution channels for the 
product allocation quantities. 

Procedure 
1. Call the transaction as follows: 

Menu Path Logistics → Logistics controlling → Flexible planning → Master data → 
Planning hierarchy → Change 

Transaction Code MC62 

2. Enter the following data: 

Field Data 

Info structure S700 

 
The info structure determines the product allocation criteria. The info structure S700 
allows product allocation by sales organization and distribution channel. In the info 
structure the R/3 System saves the product allocation data (e. g. product allocation 
quantity and order quantity per sales organization and distribution channel).  

3. Choose . 

4. Enter the following data in the Attributes dialog box: 

Field Data 

Prod. allocation object R-1001 

Sales organization No entry (delete any default) 

 
You have entered a product allocation processing scheme in the material master 
record R-1001 in the process step “Determine material for product allocation”. This 
scheme contains the product allocation processing object R-1001. At this point you 
determine that the following specifications are valid for product allocation processing 
object R-1001. The product allocation object scheme links the product allocation data 
and the material master record R-1001 for which the product is to be allocated. In our 
example one material refers to one product allocation scheme. You could use one 
product allocation scheme for several materials. Product allocation quantities based 
on this scheme are valid for all materials assigned to this scheme. Thus it would be 
possible to determine product allocation quantities for a common component of the 
materials involved.   

5. Choose . 

You go to the Change Planning Hierarchy: Sales organization screen. 
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6. Enter the following data in the first row: 

Field Data 

Sales org. 1000 

Proportion (%) 70 

7. Enter the following data in the second row: 

Field Data 

Sales org. 2200 

Proportion (%) 30 

8. Choose . 

 
Your entries specify that product allocation is possible for the product allocation 
object R-1001 in sales organizations 1000 and 2200. The proportion factors define 
the proportion of the product allocated to the two sales organizations when you 
define the total quantity for the product allocation object R-1001 in the future 
planning. In the following steps you determine the distribution channels for which 
product allocation quantities are to be determined, and specify proportions for the 
distribution channels.  

9. Position the cursor on the entry for sales organization 1000 and choose Next level. 

You go to the Change Planning Hierarchy: Distribution Channel screen. 

10. Enter the following data in the first row: 

Field Data 

Distr. chl 10 

Proportion (%) 20 

11. Enter the following data in the second row: 

Field Data 

Distr. chl 12 

Proportion (%) 80 

12. Choose . 

13. Position the cursor on the entry for sales organization 2200 in the Change Planning 
Hierarchy: Sales organization screen and choose Next level. 

14. Enter the following data in the first row: 

Field Data 

Distr. chl 10 

Proportion (%) 100 

15. Choose . 
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You get the message Planning hierarchy changed. 

16. Choose . 

17. Call the transaction as follows: 

Menu Path From the Flexible Planning node, choose Master data → Calculate 
Proportional Factors → Using Planning Hierarchy  

Transaction Code MC9B 

18. Enter the following data: 

Field Data 

Structure S700 

19. Choose . 

The R/3 System confirms that the proportions have been calculated. 

 
You entered proportions at all levels of the planning hierarchy. The R/3 System 
determines the proportions at the lowest (detailed) level in the hierarchy from these 
proportions. In the case of the distribution channel 10 in sales organization 1000 the 
proportion is determined as follows: 20 % x 70% x 100 % equals a proportion of 14 
%. If you set a product allocation quantity on the aggregated level of the product 
allocation processing objects, this quantity will be distributed according to the 
proportions to the lowest level of the distribution channels (Disaggregation). The 
values of the intermediate levels in the sales organization are the sum of the 
distribution channels in the sales organization. 

20. Choose  until the overview tree appears. 
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Edit Product Allocation Planning 
Use 
The product allocation quantities are determined in a plan. Plans are made for all sales 
organizations and distribution channels in the planning hierarchy.  

Procedure 
51. Call the transaction as follows: 

Menu Path Logistics → Logistics controlling → Flexible Planning → Planning → 
Change 

Transaction Code MC94 

52. Enter the following data: 

Field Data 

Planning type Z_S700 

53. Choose . 

 
The data of the plan which you make is saved in the info structure S700. The 
planning type is a template of the underlying info structure. The planning type e. g. 
defines the layout of the lines in the plan. 

54. Enter the following data: 

Field Data 

Prod. allocation object R-1001 

55. Delete any default Sales Organization and Distribution Channel field values.  

56. Choose Inactive version. 

57. Select version 000 Actual Data In the Choose Inactive Version dialog-box and confirm with 
. 

58. Confirm any warning messages with . 

You go to the Change Consistent Planning screen. 

 
The product allocation data is saved in an information structure. Info structures are 
also used in the Logistics Information System and the Sales & Operations Planning 
(SOP). Several versions of an information structure can exist (e.g. several planning 
versions and one version with the actual data). The actual data are administered 
under the version number 000. The version A01 always contains the active planning 
version. You save the planned product allocation quantities and updated sales order 
quantities (= Actual data) together in version 000. You must therefore plan under 
version number 000. As the version number 000 is not the active planning version, 
you have to select Inactive Version. 
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The planning tableau contains four key figures. The Product Allocation Quantity key 
figure can be planned. The other key figures are not ready for input. The Incoming 
Order Quantity key figure is updated from the sales orders. The Open Product 
Allocation and Unconfirmed Quantity key figures are calculated. The planning 
tableau starts with the current period.  

59. Choose . 

The planning horizon is twelve months. 

60. Choose , to return to the beginning of the planning horizon. 

 
In the following steps you determine a product allocation quantity for a period of 
twelve month and distribute it evenly to the individuals periods. You are currently on 
the aggregation level of the product allocation processing object R-1001 which 
represents the material R-1001. Product allocation quantities assigned to this level 
are distributed to the members of this planning hierarchy according to the proportions 
(Disaggregation). 

61. Select the line Product Allocation Quantity 

62. Choose Edit → Select → Select all periods. 

63. Choose . 

64. In the dialog box, enter the following data: 

Field Data 

ProdAllocQty 4000 

OP (in the Product Allocation Quantity row) == 

65. Choose . 

The specified quantity is distributed among the periods. As the R/3 System has no sales 
orders at hand to settle them against, it displays an open product allocation quantity of 
the same amount. 

66. Position your cursor on the ProdAllocQty line and choose . 

67. Mark the Sum Members row. 

68. Position the cursor on a member field in the Sum Members row. 

69. Choose Disaggregate row. 

The R/3 System displays the product allocation quantity distribution per period on the 
sales organization levels 1000 and 2200. The standard value on the level of the product 
allocation processing object R-1001 is distributed according to the proportion. 

70. Select the line R-1001 1000. 

71. Choose . 

The distribution channels of sales organization 1000 are displayed. 

72. Mark the Sum Members row. 

73. Position the cursor on a member field in the Sum Members row. 
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74. Choose Disaggregate Row. 

The R/3 System distributes the product allocation quantity per period on the sales 
organization levels 10 and 12. 

You get an overview of the product allocation quantity distribution in the distribution 
channels in sales organization 1000. 

75. Note the open product allocation quantity in the first two periods for the distribution channel 
10 in the sales organization 1000. 

76. Choose . 

The plan under version number 000 is saved. 

77. Choose  until the overview tree appears. 
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Creating the Sales Orders 
Use 
When processing sales orders the R/3 System checks whether the order quantity is covered by 
the product allocation. The check against the product allocation is done after the ATP availability 
check using the quantity it found. The ATP availability check (ATP = available to promise) checks 
whether the outward movements (e.g. sales orders, deliveries) are covered by inward 
movements (e. g. production orders) and whether the inward movements retain open quantities 
for new sales orders. If the subsequent availability check against the product allocation results in 
a change of the quantity confirmed, the R/3 System informs the order administration.  

 
To avoid the entry of many sales orders with small order quantities in this process 
step, we chose the order quantities so that the order quantities of three sales orders 
use up the product allocation quantities for two months.  

Procedure 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Data 

Order type OR (standard order) 

Sales organization 1000 

Distribution channel 10 

Division 00 

3. Choose . 

4. On the Sales tab, enter the following data: 

Field Data 

Sold-to party 1320 

Purch. order no. BE-297678 

Req.deliv.date Today‘s date 

Material R-1001 

Order quantity 25 

5. Choose . 

6. Confirm any dialog box with . 
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For the material R-1001 the R/3 System has a sales BOM that is deleted 
automatically after entering the item. The items additionally created are purely 
explanatory and do not affect the product allocation. 

7. Select the item in the Create Standard Order Overview screen and choose . 

The Create Standard Order: Item Data screen appears.  

 
The R/3 System confirms the ordered quantity for the earliest possible delivery date 
according to the delivery and transport schedule. Using this delivery date of the 
schedule line the R/3 System determines the period for the product allocation 
quantity check. For the corresponding month the distribution channel 10 in sales 
organization 1000 has a sufficient product allocation quantity available. Thus the R/3 
System confirms the sales order items from the product allocation processing point 
of view. 

8. Choose . 

You get the message Standard order XXX saved. 

9. Enter the following data: 

Field Data 

Sold-to party 2006 

Purch. order no. ET-897678 

Req.deliv.date Last working day of the second week next month 

Material R-1001 

Order quantity 35 

10. Choose . 

11. Choose Header Note  in the dialog box. 

12. Choose  if the Information dialog box appears. 

 
This sales order as well is created for the sales organization 1000 and distribution 
channel 10.  

13. Select the first item, then choose .  

The Create Standard Order: Item Data screen appears.  

 
The availability check against the ATP quantities confirmed the order quantity. The 
product allocation quantity check periods are determined from the allocation delivery 
date. The open product allocation quantity in distribution channel 10 of sales 
organization 1000 covers the order quantity in the following month. Thus the R/3 
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System confirms the sales order items from the product allocation processing point 
of view too. 

14. Choose . 

15. On the Create Standard Order: Overview screen, enter the following data: 

Field Data 

Sold-to party 2000 

Purch. order no. CA-410989 

Req.deliv.date Last working day of the second week next month 

Material R-1001 

Order quantity 40 

16. Choose . 

17. Confirm any dialog box with . 

18. You go to the Standard Order: Availability Check screen. 

 
The quantity proposed for the required delivery date as a one-time delivery is the 
open product allocation quantity up to the period the required delivery date is 
scheduled. The remaining order quantity can only be confirmed at the beginning of 
the following month when a new product allocation quantity becomes available.    

19. Choose Product Allocation. 

You go to the Product Allocation: Calculate Confirmation dialog box. 

 
The R/3 System determined the product allocation processing scheme R-1001 from 
the material master record R-1001. The scheme comprises the product allocation 
processing object R-1001. The product allocation by sales organization and 
distribution channel is made in this object. 

The order is created for sales organization 1000 and distribution channel 10. Thus 
the display has the attributes R-1001 (product allocation processing object), 1000 
(sales organization) and 10 (distribution channel). The R/3 System checks the 
product allocation quantity still open for the delivery date for these attributes. 

When calculating the open product quantity the check includes all unused product 
allocation quantities up to a maximum of three months before and after the product 
allocation date of the order (see "Interval“). 

For the req.deliv.date the R/3 System can therefore only confirm a subset. The 
remaining order quantity is then confirmed for the period in which a sufficient product 
allocation quantity is available again. 

20. Choose . 

 
The product allocation for the orders entered is displayed. 
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21. Choose . 

If applicable, the R/3 System informs you in the Information dialog-box that the product 
allocation processing check changed the confirmation. 

22. Choose Delivery Proposal in the Standard Order: Availability Check screen. 

23. If an Information dialog box appears, choose Help. 

The Help - Information dialog box explains the message. 

Choose  in the Help Information dialog box. 

Choose Information  in the dialog box. 

24. Choose  in the Change Standard Order: Overview screen. 

25. Choose  until the overview tree appears. 

26. Choose No in the dialog box. 
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Check Planning 
Use 
When you enter sales orders, the confirmed order quantities are put in the product allocation 
planning key figure “incoming order quantity”.  

Procedure 
78. Call the transaction as follows: 

Menu Path Logistics → Logistics Controlling → Flexible Planning → Planning → 
Display 

Transaction Code MC95 

79. Enter the following data: 

Field Data 

Planning type Z_S700 

80. Choose . 

81. Enter the following data: 

Field Data 

Prod.allocation object R-1001 

Sales organization 1000 

Distribution channel 10 

82. Choose Inactive version. 

83. Select version 000 Actual Data in the Choose Inactive Version dialog-box and confirm with 
. 

84. Confirm any warning messages with . 

You go to the Display Consistent Planning screen. 

The incoming order quantities have been updated. They are settled against the product 
allocation quantities and this settlement results in the product allocation quantity still 
open or unconfirmed quantity per period determined by the product allocation 
processing. 

85. Choose . 

86. Choose  until the overview tree appears. 
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Create Other Process Starting Position 
Use 
The material R-1001 is also used in other IDES processes. To avoid disturbing these processes, 
you must reverse the material allocation to the product allocation processing scheme here. The 
R/3 System will no longer execute the check against product allocation quantity for the material 
R-1001.  

Procedure 
87. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master Data → Products → 
Materials → Other Materials → Change 

Transaction Code MM02 

88. Enter the following data: 

Field Data 

Material R-1001 

89. Choose Select view(s). 

90. Select Basic Data 1 in the dialog box and choose .  

91. Enter the following data: 

Field Data 

Allocation schema Delete existing allocation 

92. Choose . 

93. Choose  until the overview tree appears. 
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Sales Processing with a Value Contract 
Purpose 
A value contract has been agreed between sales organization 1020 of the IDES enterprise and 
the retail chain RIWA. The value contract includes the purchase to a specified target amount of 
products from the Gloss paints product group. This purchasing agreement contains a special 
price reduction, which is fulfilled in the contract release orders. The contract also determines 
which companies of the RIWA group are authorized to be released from the contract through 
their purchase orders. 

You can find more information about this process under  [Page 118]. 

Process Flow 
You can find the data for this process under  [Page 119]. 

1. Posting the Stock [Page 120]  

2. Display the Value Contract [Page 122] 

3. Creating Sales Orders with Reference to the Contract [Page 125] 

4. Checking the Release Situation in the Value Contract [Page 124] 

5. Delivering the Sales Orders [Page 129] 

6. Creating Billing Documents [Page 131] 

7. Cancelling the Sales Order Item [Page 132] 

8. Checking the Release Situation in the Value Contract [Page 133] 
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Additional Process Information 
Contract Type 
We have created a new sales document ZWK1 especially for this IDES process. In contrast to 
contract type WK1 (general contract type), which is supplied with the standard, you can create 
contract data for contracts of the new sales order type. This enables you to store price 
agreements in the contract. 

In contracts of sales document type ZWK1, the system defaults rule B for checking the 
authorized release partners. This rule ensures that the system checks the customer in the 
customer hierarchy. The system accepts the partner as the ship-to party of the contract if the 
partner wishing to release from the contract is the ship-to party of the contract, or if they are 
assigned to the ship-to party of the contract at a lower level of the customer hierarchy.  

Copying Control 
Contracts of contract type ZWK1 can be released through standard orders (sales document type 
OR). To transfer the partner data from the contract to the order, we defined a new copy routine 
and entered this into the copy control of both document types. The copy routine ensures that only 
the releasing ship-to party is transferred in the release, and the other partners are determined 
from the master data of the ship-to party. 
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Data Used During This Process 
Field Data Description 

Plant 1100 Berlin  

Storage location 0001 Delivering warehouse 

Material Y-352 colour 5 litre can 

Material Y-353 colour 10 litre can 

Contract 40000080 Value contract 

Order type OR Standard order 

Sales organization 1020 Berlin, Germany 

Distribution channel 20 Retail chains 

Division 00 Cross-divisional 

Sold-to party 6005  

Sold-to party 6006  

Shipping point 1100 Berlin 

Warehouse number 011 Warehouse, Berlin 
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Posting the Stock 
Use 
During this process you deliver specified materials to customers. In the first process step, you 
ensure that there is sufficient stock to fulfil these deliveries. As the procurement process is not of 
absolute interest to this process, you post the stock without reference to any upstream production 
or purchase order. The materials involved are managed in batches. You therefore need to 
specify the characteristics of the batches that are posted to. 

Procedure 
94. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Receipt → Other 

Transaction Code MB1C 

95. Enter the following data: 

Field Data 

Document date Today‘s date 

Posting date Today‘s date 

Movement type 501 

Plant 1100 

Storage location 0001 

96. Choose . 

97. Enter the following data: 

Field Data 

Material (1st line) Y-352 

Quantity (1st line) 250 

Material (2nd line) Y-353 

Quantity (2nd line) 200 

98. Choose . 

99. In the Automatic Batch Number Allocation dialog box, the system informs you that the 
batches to be created are numbered automatically. Choose Yes. 

The Enter Other Goods Receipts: Classification screen appears, where you enter the 
batch attributes for material Y-352. 

100. Enter the following data: 

Field Data 

Viscosity 180 
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Density 2.05 

Wavelength 800 

101. Choose . 

The Enter Other Goods Receipts: Classification screen appears, where you enter the 
batch attributes for material Y-353. 

102. Enter the following data: 

Field Data 

Viscosity 180 

Density 2.05 

Wavelength 600 

103. Choose . 

104. Choose . 

105. Choose . 

The system issues a document number. 

106. Choose  until the overview tree appears. 
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Display the Value Contract 
Use 
In this process step, you find out about the agreements for the existing value contract. As this 
process chain assumes a precisely defined difference between the target value of the contract 
and the value used until now, you may need to change the previous target value. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales  → Contract → Display 

Transaction Code VA43 

2. On the Change Contract: Initial Screen, enter the following data: 

Field Data 

Contract 40000080 

3. Choose . 

4. If an Information dialog box appears, reminding you of the subsequent numbers, choose . 

Compare the target value of the contract item with the released value. The target value 
should be 13850 EUR higher than the previous released value 

5. Position your cursor in the Product hierarchy field of the value contract item, then choose the 
F4 input help. 

The system branches to the Product Hierarchy dialog box. 

 
The sales department has a three-level product hierarchy (main group, group, 
subgroup). The generic entry 0011000105* in the product hierarchy field, defines that 
the value contract refers to materials belonging to the paint colors group, or its 
subgroups. When releases are made from this value contract, the system checks 
whether the ordered materials belong to one of the product hierarchies listed here. 

6. Choose  to ensure that no changes are made to the contents of the Product hierarchy 
field. 

The contract item is coupled with a price agreement. This agreement specifies that a 
discount of 10 % is to be awarded with all contract release orders. 

7. On the Change Value Contract (IDES)...: Overview screen, choose  (Display details for 
document header). 

8. Choose the Sales tab page. 

 
On the Change Value Contract (IDES) ####: Header Data screen, you can see that 
the rule Check partner of customer hierarchy applies to the release check. This rule 
states that a partner wishing to release against a contract, is authorized to carry out 
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this release if they are the sold-to party of the contract, or if they are assigned to the 
sold-to party of the contract at a lower hierarchy level. 

9. Choose  until the overview tree appears. 
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Checking the Release Situation in the Value Contract 
Use 
The values released by the two sales orders have now been updated in the value contract.  You 
can now display the release situation. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Contract → Display 

Transaction Code VA43 

2. On the Display Contract: Initial Screen, enter the following data: 

Field Data 

Contract 40000080 

3. Choose . 

The Display Value Contract (IDES) XXXX: Overview screen appears 

 
The released value of the contract is now greater than the target value.  

4. Choose  until the overview tree appears. 
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Creating Sales Orders with Reference to the Contract 
Use 
In this process step, you create two sales orders with reference to the value contract. The value 
released by the relevant sales order is updated in the value contract. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Data 

Order type OR 

Sales organization 1020 

Distribution channel 20 

Division 00 

3. Choose . 

4. Enter the following data: 

Field Data 

Sold-to party 6005 

Purch. order no. RI-438900 

PO date Today‘s date 

Req.deliv.date Today’s date +4 working days 

5. Choose Sales document → Create with reference. 

6. If the Information dialog box appears, choose . 

7. In the dialog box, choose the Contract tab page. 

8. Choose  Contracts. 

 
The system determines from which value contracts the releasing partner 6005 can 
release from. As customer 6005 is assigned to a lower level of the customer 
hierarchy for the sold-to party, the system defaults the appropriate contract.  

9. Choose Selection list. 

10. To skip the warning message, choose . 

The Value Contract (IDES) ####: Selection List for Reference Document screen 
appears. 
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11. Choose  Enter matl. 

 
You now define which of the materials ordered by the customer is to by released 
against the value contract. The system checks whether the specified materials 
belong to one of the product hierarchies stored in the value contract, which would 
make them valid for release.  

12. Enter the following data: 

 Field Data 

Material (1st line) Y-352 

Order quantity (1st line) 200 

Material (2nd line) Y-353 

Order quantity (2nd line) 100 

13. Choose . 

14. On the Value Contract (IDES) XXXX: Selection List for Reference Document screen, choose 
 Copy. 

The Create Standard Order: Overview screen appears. 

15. Select the first item, then choose . 

The Create Standard Order: Item Data screen appears. 

 
The discount stored in the value contract has been copied into the sales order item. 

16. Choose . 

17. Choose the Shipping tab page. 

18. Note the material availability date (Mat.av.dt.) for both items. 

19. Choose . 

The system issues a sales order number. Make a note of this number. This order will 
now be referred to as Sales order 1. 

20. Choose . 

21. In the dialog box, choose No. 

22. On the Create Sales Order: Initial Screen, choose . 

23. Enter the following data: 

Field Data 

Sold-to party 6006 

Purch. order no. RI-538900 

PO date Today‘s date 
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Req.deliv.date Today’s date +4 working days 

24. Choose Sales document → Create with reference. 

25. In the Create with Reference dialog box, choose the Contract tab page. 

26. Choose  Contracts. 

 
The system determines from which value contracts the releasing partner 6006 can 
release from. As customer 6006 in is assigned to a lower level of the customer 
hierarchy for the sold-to party, the system defaults the appropriate contract.  

27. Choose Selection list. 

28. To skip the warning message, choose . 

The Value Contract (IDES) ####: Selection List for Reference Document screen 
appears. 

29. Choose  Enter matl. 

 
You now define which of the materials ordered by the customer is to by released 
against the value contract. The system checks whether the specified materials 
belong to one of the product hierarchies stored in the value contract, which would 
make them valid for release. 

30. On the Change Value Contract (IDES) ####: List of Materials to be Copied screen, enter the 
following data: 

Field Data 

Material (1st line) Y-352 

Order quantity (1st line) 50 

Material (2nd line) Y-353 

Order quantity (2nd line) 100 

31. Choose . 

32. On the Change Value Contract (IDES) XXXX: Selection List for Reference Document screen, 
choose  Copy. 

The Standard Order: Overview screen appears. 

 
The customer orders the first item for a later delivery date. You therefore need to 
change the existing entry for the delivery date.   

33. Select the first item, then choose . 

34. Enter the following data: 

Field Data 
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Delivery date (1st line) Original date + 10 working days 

35. Choose . 

36. Choose . 

37. On the Standard Order: Overview screen, choose the Shipping tab page. 

38. Note the material availability date (Mat.av.dt.) of the second, earlier item. 

39. Choose . 

The Value Contract Release dialog box informs you that the target value of the contract 
has been exceeded. The contract item does, however, allow you to save the order with 
reference to the contract, thereby exceeding the target value.   

40. Choose Save. 

The system issues a sales order number. Make a note of this number. This order will 
now be referred to as Sales order 2. 

41. Choose  until the overview tree appears. 

In the Exit Order Processing dialog box, choose No. 
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Delivering the Sales Orders 
Usage 
You now deliver the two sales orders. The first item of sales order 2 is not delivered just yet, due 
to the later delivery date. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Collective Processing of Documents for 
Shipment → Sales Orders 

Transaction Code VL10A 

2. Enter the following data: 

Field Data 

Shipping point/receiving point 1100 

Delivery creation date The earliest of the material availability date from order number 1

Delivery creation date (to) Today + 6 working days 

Ship-to party Empty (delete default entry) 

Sales organization 

(in the General data section) 

1020 

3. Choose the Sales orders tab page. 

Field Data 

Range of documents section  

SD document (1st field) 

Sales order 1 

Range of documents section  

SD document (2nd field) 

 

Sales order 2 

4. Choose . 

5. Choose . 

 
If the numbers of sales order 1 and 2 are not sequential it may be that other orders 
are included for your selection. If required, deselect these orders. 

6. Choose  Background. 

7. Choose . 

8. Position your cursor on the report group, then choose Goto → Documents. 
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You see the created deliveries.  

Make a note of the numbers for both deliveries generated by this run. 

9. Choose  until the overview tree appears. 

10. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Picking → Create Transfer Order → Single Document 

Transaction Code LT03 

11. Enter the following data: 

Field Data 

Warehouse number 011 

Plant 1100 

Delivery The first of the two deliveries you noted 

Foreground/backgrnd Background 

Adopt pick quantity 2 

12. Choose . 

The system generates a transfer order for the picking of the delivery quantities. Adopting 
picking quantities means that the system immediately posts goods issue for the delivery. 

13. Repeat steps 11 and 12 for the second delivery. 

14. Choose  until the overview tree appears. 
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Creating the Billing Document 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Process Billing Due List 

Transaction Code VF04 

2. Enter the following data: 

Field Data 

Billing date from Today‘s date 

to Today‘s date 

Organization data section: 

Sales organization 

1020 

Documents to be selected:  

Delivery-related 

Select 

3. Choose  DisplayBill.list. 

The system lists all deliveries that are open for internal billing on the selected date. 

 
Note that additional deliveries (from previous IDES processes) may be displayed that 
are open for billing. If this is the case, simply deselect the deliveries that do not 
belong to your current IDES process. 

4. Choose . 

The Process Billing Due List screen appears. 

5. Choose  until the overview tree appears. 
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Cancelling the Sales Order Item 
Use 
Customer 6006 informs you that they wish to cancel the first item of sales order 2. You now need 
to enter a rejection reason for this item. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Change 

Transaction Code VA02 

2. On the Change Sales Order: Initial Screen, enter the following data: 

Field Data 

Order Document number of sales order 2 

3. Choose . 

In the Information dialog box, the system may inform you of subsequent documents. 

4. Choose . 

5. On the Change Standard Order ####: Overview screen, choose the Reason for rejection tab 
page. 

6. To enter a rejection reason for the first item, enter the following data: 

Field Data 

Reject (rejection reason in first line) Customer usage to be postponed 

7. Choose . 

8. To skip a warning message, choose . 

9. Choose  until the overview tree appears. 
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Checking the Release Situation in the Value Contract 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Contract → Display 

Transaction Code VA43 

2. Enter the following data: 

Field Data 

Contract 40000080 

3. Choose . 

The Display Value Contract (IDES) XXXX: Overview screen appears. 

 
The released value has been reduced by the value of the rejected item. 

4. Choose  until the overview tree appears. 
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Invoicing a Project with Down Payment Processing 
Purpose 
A customer has placed an order for the construction, delivery and assembly of a passenger 
elevator. The sales order is completed within a project and the order contains an agreement with 
the customer that they make a down payment once they have received the layout of the first 
construction plan. You invoice the customer for the order as the project progresses by sending 
them two billing documents. The down payment is settled in the first partial invoice. 

This process should clarify how a billing plan for a sales order item can be linked to project 
milestones and down payment processing. The process does not provide a detailed description 
of the Logistics aspects of the project. See the Make-To-Order Production of Elevators [Ext.] 
scenario for more details of the Logistics side (for example, assembly processing, variant 
configuration, material requirements planning, delivery). 

You can find more information about this process under  [Page 135]. 

Process Flow 
You can find the data for this process under  [Page 137] 

1. Prepartory Measures [Ext.]  

2. Creating Sales Orders and Projects [Page 139] 

3. Releasing a Project [Page 143] 

4. Confirming Activity [Page 144] 

5. Creating Down Payment Requests [Page 145] 

6. Posting Down Payments [Page 147] 

7. Confirming Activity [Page 148] 

8. Creating Invoices [Page 149] 

9. Displaying Line Items [Page 151] 

10. Confirming Activity [Page 152] 

11. Creating Invoices [Page 153] 
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Additional Process Information 
The following information applies mainly to IDES users with knowledge of Customizing for SD 
and the project system. This text uses data from the process to demonstrate how the billing plan 
in the sales order is linked with the project. Particular attention is paid to how this applies within 
Customizing. Because this text refers to this IDES demo, you should read it after completing the 
process chain. 

Assembly Processing with a Network 
Material E-1001 used in the process, belongs to planning strategy group 85 (assembly 
processing network with project). This group contains strategy 85 (assembly processing network 
with project). This strategy is controlled by requirement type ZMPN (assembly with 
network/project). Assembly processing with network type PS04 is provided for this requirement 
type. This setting means that when you create a sales order item for this material, the system 
automatically creates a network of this category in the project system.  

(see SAP Reference IMG: Production → Production planning → Demand Management → 
Planned Independent Requirements → Planning Strategy →...) 

Billing with the Billing Plan 
The material belongs to item category group 0008 (PS: Billing plan without configuration). This 
item category group causes item category TP01 (Network: Billing plan withouth configuration) to 
be used in the sales document type PS1 (PS: Order) that is used in this process. 

(See SAP Reference IMG: Sales and Distribution → Sales → Sales Documents → Sales 
Document Item → Assign item categories) 

In item category TP01, billing relevance I (relevant for order-related billing - billing plan) is set. 
Billing plan type 10 (PS partial billing) has also been assigned to this category. This configuration 
causes a billing plan of this type to be used for the item in the sales order.  

(See SAP Reference IMG: Sales and Distribution → Billing → Billing plan → Assign billing plan 
types to item categories) 

Link between the billing plan and the network 
In the sales order item, the item category configuration creates a billing plan with billing plan type 
10 (PS: Milestone billing). Three date categories are defined in Customizing for this billing plan 
type: 01 - Milestone billing, 02: - Final invoice, 03: - Down payment request. Billing rule 1 
(percentage milestone billing) is configured for date category 1. Date category 02 works with 
billing rule 3 (final invoice for milestone billing). This rule ensures that amounts remaining to be 
billed (possibly arising from price changes after the first partial invoices) are included in a final 
invoice. Date category 03 uses rule 4 (down payment for percentage milestone billing). This rule 
triggers down payment processing. Date category 03 refers to the standard billing type FAZ 
(down payment request) with which the down payment request should be posted.  

(See SAP Reference IMG: Sales and Distribution → Billing → Billing plan → Define and assign 
date categories → Maintain date category for billing plan type). 

As explained above, a network is also created on the basis of the requirement type for the sales 
order item. When it does this, the R/3 System uses the standard network E-1001 (with which 
material E-1001 is linked) as a reference. This standard network belongs to the project system 
basis data. Milestones are assigned to some of the processes in this standard network. In these 
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milestones, the indicator “Sales document date” is set. This indicator when used with date key 01 
(Date in the billing plan) controls whether the date for a milestone is copied into the billing plan 
for the sales order. The relevant billing percentage rate is also specified in the milestone, except 
for in the milestone for the final invoice.  

(see application menu: Logistics → Project System → Basic Data → Templates → Network 
Parameters from Sales Order...). 

The milestones in the standard network E-1001 also indicate the relevant milestone usage. 
These are the usages PS01, PS03 and PS04. Milestone usage is determined in Customizing.  

Milestone usage can refer to a date category for a billing plan type in Sales and Distribution. 

There is no date category specified for usage PS01. In this case the R/3 System chooses the 
default date category from billing plan type 10. This is date category 01 (partial billing). Activity 
1150 in the network, linked to a milestone of usage PS01, issues the date and the billing 
percentage rate for a partial invoice to the billing plan for the sales order. Activity 2000 also 
contains a milestone for the same purpose. Confirming this activity triggers a second partial 
invoice. 

A reference to date category 03, billing plan type 10 is available for usage PS03. The second 
milestone in activity 2000 is for usage PS03. This allows the activity to issue the date for the final 
invoice in the billing plan. 

Milestone usage PS04 is linked to date category 04, billing plan type 10. Activity 1000 in the 
network contains a milestone with this usage. Activity 1000 uses it to issue the date and 
percentage rate for the down payment request in the billing plan for the sales order.  

(See SAP Reference IMG: Project System → Structures → Operative Structures → Milestones 
→ Define milestone usage) 
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Data Used During This Process 
Field Data Description 

Sales order type PS1 Sales order type for project processing 

Sales organization 1000 Sales organization: Germany 

Distribution channel 10 Distribution channel for end customer 

Division 00 Cross-division 

Sold-to party 1600 Customer 

Material E-1001 Elevator 

Company code 1000 IDES Germany 

Account 113100 Bank account 
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Preparatory Measures 
 

Descriptions in the project system are not multi-lingual so carry out an Automatic 
translation [Ext.] to the language you require. 
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Creating Sales Orders and Projects 
1. Call up the transaction as follows: 

Menu Path Logistic → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Data 

Order type PS1 

Sales organization 1000 

Distribution channel 10 

Division 00 

3. Choose . 

4. Enter the following data: 

Field Data 

Sold-to party 1600 

Purch.order no. TA-450931 

PO date Current date 

Requested delivery date Accept proposed date 

Material E-1001 

Order quantity 1 

5. Choose . 

In case you are asked to enter a business area, enter 1000 and choose . 

The system informs you that it has read and scheduled the network. 

 
The elevator ordered by the customer will be manufactured in a project and material 
E-1001 is linked to a standard network. The network created in the sales order is 
copied from the standard network. The network determines the progress of the 
project, in other words, the chronological sequence of the individual project steps.  

You reach the PS: order: Availability Control screen. 

 
The network scheduling determines a final date for the project and in the Availability 
Control screen, the system informs you that, in accordance with current planning, the 
order item cannot be confirmed until this date.  

6. Choose Complete dlv. 
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7. Select the item and choose Goto → Item → Billing plan. 

 
The customer will be invoiced for the sales order item with a billing plan. The total 
value of the item is billed in two partial invoices as the project progresses. The final 
invoice is for any amount outstanding after both partial invoices have been paid. You 
have also agreed with the customer that they pay 10 per cent of the total value as a 
down payment. The planned billing dates have been taken from the network that was 
created in the background for the sales order item. All dates have been blocked for 
billing (Block field) because the actual dates have not yet been confirmed. The block 
is removed once the milestones assigned to these dates in the network have been 
confirmed as completed. 

8. Choose the Schedule lines tab page. 

9. Select the second schedule line and choose . 

10. Choose the Procurement tab page. 

In the Assembly section, the system displays the sequential number of the network that 
was created when you created the order item. When you save this sales order, this 
number is replaced by a final network number. 

11. In the Assembly section, choose Header. 

You reach the Network Create: Header Data screen. 

 
In order to explain how the billing plan is linked to the project, we will now branch into 
the network although this is not necessary for actually creating the order. The project 
is created automatically when you save the sales order.  

12. Choose . 

13. On the Create Network: Basic Data Overview (Basic Dates) screen, choose the 
Int.processing tab page. 

The system lists all the activities that have to be implemented during the internal 
processing of the project. 

14. Choose . 

15. Choose . 

The system branches to the Create: Network: Milestone Overview screen for activity 
1000, which represents the project phase up until when the customer accepts the 
construction layout.  
Milestones are assigned to an activity and are used within the project to control when 
certain phases in the process have been achieved.  

16. Select the milestone line and choose . 

The system branches to the Milestone detail data screen. 

In the Basic data tab page in the Usage section, you can see that the Sales document 
date indicator has been activated. This indicator specifies that the scheduled date for the 
activity is to be copied into the billing plan for the sales order. The InvoicePercentg field 
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displays the percentage amount in the invoice or required for a down payment for the 
date. The milestone is linked to the down payment date in the billing plan.   

17. Choose . 

18. On the Create: Network: Milestone Overview screen, choose  several times until you 
reach the display for activity 1150, which controls the project’s earned value. (The activity 
number is displayed in the Activity field.)  

19. Select the milestone line and choose . 

Activity 1150 is also linked to a milestone and when this milestone is confirmed, the 
partial invoice releases 30 per cent of the total value. 

20. Choose . 

21. Choose  several times, until the system informs you that it has reached the last activity. 

22. Choose . 

23. Choose the Ext. processing tab page. 

The system lists an activity called Certification & Release to Customer, which is 
implemented by another company. 

24. Select activity 2000 and choose . 

This activity is linked to two milestones.  

25. Select both milestone lines and choose . 

When the first milestone is confirmed, the second partial invoice for the billing plan is 
released, which bills the customer for the remaining 70 per cent of the total order value.  

26. Choose . 

When the second milestone Final bill - correction is confirmed, the system removes the 
billing block for a final invoice. The final invoice can contain any remaining amounts that 
still need to be paid. This might be necessary, for example, if you agree to increase the 
price during the project after partial invoices, based on the old price, have already been 
created.   

27. Choose . 

28. Choose . 

29. On the Create PS: order: Schedule Line Data screen, choose . 

To confirm possible warning messages choose . 

The system informs you that it has generated the project and issues you with a sales 
order number. 

30. Make a note of the sales order number. 

31. Choose  until the overview tree appears. 

In the Exit order Processing dialog box choose No. 
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Releasing a Project 
Use 
In order to carry out the activities in a project, you have to release the it. Follow this step to 
release your project. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Project System → Project → Project Builder 

Transaction Code CJ20N 

In case you open the project builder for the first time, choose  twice. 

2. Choose . 

3. Enter the following data: 

Field Data 

Project definition E- + (sales order number noted earlier); 
Example: E-5423 

4. Choose . 

5. Select  Elevator modell 1001 in the left-hand corner. 

6. Choose Edit → Status → Release. 

The status in the field System status will be set to REL (Released). 

7. Choose . 

8. Choose . 
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Confirming Activity 
Use 
Once you have created the layout and it has been accepted by the customer, you can confirm 
the relevant activity in the project.  

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Project System → Project → Project Builder 

Transaction Code CJ20N 

2. Choose . 

3. Enter the following data: 

Field Data 

Project def. E- + (sales order number noted earlier); 
Example: E-5423 

4. Choose . 

5. Select  Elevator modell 1001 in the left-hand corner. 

6. Choose . 

7. Select the activity  Layout & acceptance from customer. 

8. Choose Edit → Activity → Confirm. 

In the dialog box you see the actual data of the customer activitiy 1000 Layout & 
acceptance. The indicator FinalConfirm is selected. 

9. Choose . 

The status in the field System status will be set to CNF (Confirmded). 

10. Wählen Sie . 

11. Wählen Sie . 
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Creating Down Payment Requests 
Use 
When you confirm activity 1000, the system removes the billing block for the first date in the 
billing plan, because the prerequisites for the down payment request have been fulfilled. Create 
the down payment request in this step. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales And Distribution → Billing → Billing Document → 
Process Billing Due List   

Transaction Code VF04 

2. Enter the following data: 

Field Data 

Billing date from Current date 

Billing date to Current date 

SD document Sales order number noted earlier 

Sales organization 1000 

Documents to be selected - Order-releated Select 

Documents to be selected - Delivery-releated Deselect 

3. Choose  DisplayBillList. 

The sales order is displayed on the Process Billing Due List screen. 

4. Select the entry in the worklist and choose Environment → Display Document. 

5. Select item 10 and choose Goto → Item → Billing Plan. 

You can see that the down payment date is no longer blocked for billing. The billing date is 
the confirmation date of the assigned project activity so the order is in today’s billing worklist.  

6. Choose . 

7. On the Display PS: order...: Overview screen, choose  again. 

8. Choose . 

The system displays that a billing document has been created.  

9. Position your cursor on the line containing your group number and choose Documents. 

10. Place the cursor on the sales document and choose  Disp. doc. 

11. Select the item and choose Goto → Item → Item Conditions. 

In the line Calculated Costs, you can see that the final amount is 10 per cent of the sales 
order value plus output tax. 
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12. In the column Condition Value, note the value of Calculated Costst. 

13. Choose . 

14. Choose  Accounting. 

You reach the Display Document: Overview screen where the most important data for 
the document created in Financial Accounting is displayed. 

The document generated in Financial Accounting does not have any affect on accounting 
and does not update the transaction figures. However, it is used as a noted item to 
remind the Accounting department that a down payment has to  be made, and serves as 
a posting template for the down payment or as a document for the dunning program. A 
document item is entered in the receivables account for the down payment request 
without creating an offsetting entry. 

15. Choose  until the overview tree appears. 
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Posting Down Payments 
Use 
On receipt of the down payment request, the customer transfers the required amount to your 
company. In this step, you enter the down payment using the down payment request as a 
reference. The R/3 System then automatically sets the down payment as cleared. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable →  Document 
Entry → Down Payment → Down Payment 

Transaction Code F-29 

2. Enter the following data: 

Field Data 

Document date Current date 

Company code 1000 (is proposed) 

Currency EUR 

Account (in the Customer section) 1600 

Special G/L ind. A (down payment) 

Account (in the Bank section) 113100 

Amount Amount noted earlier 

3. Choose Requests. 

 
Because you are not permitted to balance down payments with receivables and 
liabilities from the delivery, the down payment is treated as a special G/L transaction 
both in G/L accounting and in accounts receivables accounting. Special G/L 
transactions are those that have to be processed separately.  

4. Select the down payment request you want to process and choose Create down payments. 

5. On the Post Customer Down Payment: Display Overview screen, choose . 

6. Choose  until the overview tree appears, confirming the Exit Editing dialog box with Yes. 
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Confirming Activity 
Use 
Because this script deals mainly with the billing aspect of a project, you now confirm the activity 
that leads to the first partial invoice. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Project System → Progress → Confirmation → Individual 
Confirmation → Enter 

Transaction Code CN25 

You reach the Create Network Confirmation: Initial Screen. 

2. Enter the following data: 

Field Data 

Network Network number proposed by the R/3 System 

 
If the R/3 System does not propose a network number, you can search for it with a 
matchcode.Choose the Networks by Sales Order. Enter the sales order number you 
entered earlier and choose . 

3. Choose . 

4. On the Create Network Confirmation: Activity Overview screen, choose 1150 (Update 
control) and choose  Actual data. 

On the Create Network Confirmation: Actual data dialog box, the R/3 System proposes 
values which you can accept. 

5. Choose . 

On the Create Network Confirmation: Initial Screen, the R/3 System informs you that the 
confirmation has been saved.  

6. Choose  until the overview tree appears. 
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Creating Invoices 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales And Distribution → Billing → Billing Document → 
Process Billing Due List   

Transaction Code VF04 

2. Enter the following data:  

Field Data 

Billing date from Current date 

Billing date to Current date 

SD document Sales order number noted earlier 

Sales organization 1000 

Order-related (in the Documents to be selected section) Select 

3. Choose  DisplayBillList. 

4. On the Process Billing Due List screen, select the entry in the worklist and choose 
Environment → Display document. 

You reach the PS: Display order...: Overview screen. 

5. Select item 10 and select Goto → Item → Billing plan. 

The R/3 System branches to the Display PS: order...Item Data screen. 

You can see that the first invoice date is no longer blocked for billing. The billing date is 
the confirmation date of the assigned project activity so the order is in the billing due list.  

6. Choose . 

7. On the PS: Display order....: Overview screen, choose  again. 

You eventually reach the Process Billing Due List screen. 
8. Select the entry in the billing due list and choose Individual billing document. 

This takes you to the Invoice Create...(F2): Overview of Billing Items screen. 

 
The billing document contains two items: The first item invoices the customer for 30 
per cent of the total order value. The second item displays the down payment 
amount that has to be off-set.  

9. Select the second item and choose Pricing. 

 
If you did not want the total down payment amount to be offset with the first partial 
invoice, you could change the pricing amount for condition type AZWR (down 
payment/offsetting) here in the Pricing screen for the Offset Item. In this case the 
offset amount that is now open will appear for offsetting in the next partial invoice.  
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10. Choose . 

11. On the Invoice ... (F2) Create: Overview of Billing Items screen, choose . 

12. The Process Billing Due List screen issues the billing document number in a message. Note 
this number. 

13. Choose . 

14. Choose  until the overview tree appears. 
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Displaying Single Line Items 
Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → Accounts Receivable →  Account 
→ Display/Change Line Items 

Transaction Code FBL5N 

2. Enter the following data: 

Field Data 

Customer 1600 

Company code 1000 

Open items Select 

3. Choose . 

4. On the left side of the screen, in the Documents folder, select Reference. 

5. Choose  Adopt Selected Items. 

6. Enter the following values in the Selection Criteria: Values dialog box: 

Field Data 

Reference (from) Billing document noted earlier with two leading zeros (for example, 
0090005702) 

7. Choose . 

8. Choose . 

You reach the Display Customer Line Item: Basic List screen. 

9. Choose  until the overview tree appears. 
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Confirming Activity 
Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Project System → Progress → Confirmation → Individual 
Confirmation → Enter 

Transaction Code CN25 

You reach the Create Network Confirmation: Initial Screen. 

2. Enter the following data: 

Field Data 

Network Network number proposed by the R/3 System 

Activity 2000 

3. Choose . 

The R/3 System branches to the Create Network Confirmation: Actual data screen. 

4. Enter a duration of  3 days. 

5. Choose . 

On the Create Network Confirmation: Initial Screen, the R/3 System informs you that the 
confirmation has been saved. 

6. Choose  until the overview tree appears. 
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Creating Invoices 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales And Distribution → Billing → Billing Document → 
Process Billing Due List   

Transaction Code VF04 

2. Enter the following data:  

Field Data 

Billing date from Current date 

Billing date to Current date 

SD document Sales order number noted earlier 

Sales organization 1000 

Order-related (in the Documents to be selected section) Select 

3. Choose  DisplayBillList. 

4. On the Process Billing Due List screen, select the entry in the worklist and choose 
Environment → Display document. 

You reach the PS: Display order...: Overview screen. 

5. Select item 10 and select Goto → Item → Billing plan. 

You reach the Display PS: Order...Item Data screen. 

 
You can see that the date for the second partial invoice for the remaining 70 per cent 
as well as the date for the final invoice are no longer blocked for billing. No prices 
have been increased during the project run time so the date for the final invoice does 
not contain any values to be billed.  

6. Choose . 

7. On the Display PS Order: Overview screen, choose . 

8. Choose . 

9. Choose  until the overview tree appears. 
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Consignment Handling 
Consignment Fill-Up [Page 156] 

Consignment Pick-Up [Page 162] 

Consignment Issue [Page 168] 

Consignment Returns [Page 175] 
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Consignment Fill-Up 
Purpose 
Consignment stock at the customer site can be replenished using Consignment fill-up. 

You can find more information about this process under  [Page 157]. 

Process Flow 
You can find the data for this process under  [Page 158]. 

1. Displaying the Consignment Stock [Page 159] 

2. Replenishing Consignment Stock at the Customer Site [Page 160] 
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Additional Process Information 
Consignment fill-up replenishes the stock at the customer site. Since the goods remain the 
property of your company, this process is not relevant for pricing and consequently not for 
invoicing either. 
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Data Used During This Process 
Field Europe North America 

Order type CF (Consignment fill-up) CF 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

Sold-to party 1001 3001 

Material L-40F L-40F 

Shipping point 1200 3200 

Plant 1200 3200 

Warehouse number 012 320 
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Displaying the Consignment Stock 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → 
Environment → Stock → Stock Overview 

Transaction Code MMBE 

2. Enter the following data: 

Field Europe North America 

Material L-40F L-40F 

Plant 1200 3200 

Display version 1 1 

No zero stock lines Selected Selected 

Company code Selected Selected 

Plant Selected Selected 

Storage location Selected Selected 

Batch Selected Selected 

Special stock Selected Selected 

3. Choose . 

The R/3 System displays the stock situation according to your selection criteria. 

 
The stock for product L-40F is recorded in cartons (base unit of measure). In sales 
and distribution, this material can be sold in cartons or pallets. One pallet contains 4 
cartons. 

4. Select Cust. consignment, then choose . 

In the dialog box, you see information about the consignment stock located at various 
customer sites. Note the consignment stock unrestricted-use for customer 1001 (Europe) 
or customer 3001 (North America). 

5. In the dialog box, choose . 

6. Choose  until the overview tree appears. 
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Replenishing Consignment Stock at the Customer Site 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Europe North America 

Order type CF CF 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Sold-to party 1001  3001 

Purch. order no.r K-LM-300000 

 

C-IS-100300 

PO date Today‘s date Today‘s date 

Req.deliv.date Today’s date + 2 days Today’s date + 2 days 

Material L-40F L-40F 

Order quantity 20 (cartons) 20 (cartons) 

5. Choose . 

If the system displays a dialog box, choose . 

 
If the goods ordered by the customer are not available on the requested delivery 
date, the R/3 System branches automatically to an availability check screen. Here 
you can choose one of the delivery options, for example, Delivery proposal. The R/3 
System then returns to the overview screen. 

6. On the Shipping tab page, check that the following shipping point has been entered: 

Field Europe North America 

160  April 2001 



 SAP AG Sales and Distribution (SD) 

  Replenishing Consignment Stock at the Customer Site 

Shi... (Shippig point) 1200 3200 

7. Choose Sales document → Deliver. 

The system confirms that the consignment fill-up has been saved. 

8. Choose Subsequent functions → Create transfer order. 

The End document processing dialog box appears. 

9. Choose Yes. 

The delivery has been saved. 

10. Enter the following data: 

Field Europe North America 

Warehouse number 012 320 

Delivery Defaulted Defaulted 

Foreground/backgrnd Background Background 

Adopt picking quantity 2 2 

11. Choose . 

The system generates a transfer order for the picking of the delivery quantities. Option 2 
(Adopt picking quantity) ensures that the goods issue posting is made at the same time 
as the delivery. 

12. Choose  until the overview tree appears. 

13. To see the changes made to the stock situation, repeat the procedure Displaying the 
Consignment Stock [Page 159]. 

On the stock overview screen, you can see that the consignment stock at the customer 
site has increased by 20 cartons. 

 

 

April 2001  161 



Sales and Distribution (SD)  SAP AG 

Consignment Pick-Up 

Consignment Pick-Up 
Purpose 
Consignment goods not used by the customer can be returned to the warehouse of your 
company using Consignment Pick-Up. 

You can find more information about this process under  [Page 163]. 

Process Flow 
You can find the data for this process under  [Page 164]. 

1. Collecting Consignment Goods from the Customer Site [Page 165] 

2. Displaying the Consignment Stock [Page 167] 
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Additional Process Information 
Your company uses consignment pick-up to take back consignment goods that the customer 
does not need. This process is not relevant for billing since the goods remain the property of your 
company. 
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Data Used During This Process 
Field Europe North America 

Order type CP (Consignment pick-up) CP 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

Sold-to party 1001 3001 

Material L-40F L-40F 

Shipping point 1200 3200 

Plant 1200 3200 

Storage location 0001 0001 
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Collecting Consignment Goods from the Customer Site 
Prerequisites 
If you would like to execute this process without first performing consignment fill-up, you should 
first execute the process step Displaying the Consignment Stock [Page 159]. This enables you to 
track the stock changes triggered by this process. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Europe North America 

Order type CP (consignment pick-up) CP 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Sold-to party 1001 3001 

Purch. order no. K-LM-300001 C-IS-100300 

PO date Today‘s date Today‘s date 

Req.deliv.date Today‘s date Today‘s date 

Material L-40F L-40F 

Order quantity 4 (cartons) 4 (cartons) 

5. Choose . 

6. Choose Sales document → Deliver. 

7. Select the delivery item, then choose . 

8. Choose the Processing tab page. 
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Note that this business transaction is not relevant for picking (Field: Not relevnt for 
pick). 

9. Choose the Picking tab page. 

10. Enter the following data: 

Field Europe North America 

Stor. location 0001 0001 

11. Choose Post goods receipt. 

The customer consignment stock has now been reduced by 4 cartons and the system 
has posted a goods receipt to your regular inventory. This concludes this business 
transaction. 

12. Choose  until the overview tree appears. 
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Displaying the Consignment Stock 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → 
Environment → Stock → Stock Overview 

Transaction Code MMBE 

2. Enter the following data: 

Field Europe North America 

Material L-40F L-40F 

Plant 1200 3200 

Display version 1 1 

No zero stock lines Selected Selected 

Company code Selected Selected 

Plant Selected Selected 

Storage location Selected Selected 

Batch Selected Selected 

Special stock Selected Selected 

3. Choose . 

You can see that your total stock has increased by four cartons. 

4. Select Cust.consignment, then choose . 

The consignment stock of this customer has been reduced by 4 cartons. 

5. In the dialog box, choose . 

6. Choose  until the overview tree appears. 
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Consignment Issue 
Purpose 
The Consignment issue enables the customer to withdraw consignment goods from the special 
stock that are to be used or sold. 

You can find more information about this process under  [Page 169]. 

Process Flow 
You can find the data for this process under  [Page 170]. 

1. Creating a Consignment Issue [Page 171] 

2. Billing the Consignment Issue [Page 174] 
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Additional Process Information 
This business transaction is relevant for billing, because the property is transferred between 
owners. 
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Data Used During This Process 
Field Europe North America 

Order type CI (Consignment Issue) CI 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

Sold-to party 1001 3001 

L-40F L-40F 

Shipping point 1200 3200 

Plant 1200 3200 

Material 
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Creating a Consignment Issue 
Prerequisites 
If you would like to execute this process without first performing consignment fill-up, you should 
first execute the process step Displaying the Consignment Stock [Page 159]. This enables you to 
track the stock changes triggered by this process. 

Procedure 

Logistics → Sales and Distribution → Sales → Order → Create 

1. Call up the transaction as follows: 

Menu Path 

VA01 Transaction Code 

2. Enter the following data: 

Field Europe North America 

Order type CI CI 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Sold-to party 1001 3001 

Purch.order no. K-LM-300002 C-IS-100303 

PO date Today‘s date Today‘s date 

Req.deliv.date Today‘s date Today‘s date 

Material L-40F L-40F 

Order quantity 8 (cartons) 8 (cartons) 

5. Choose . 

 
Standard pricing is performed for this business transaction, because the issued 
goods are to be invoiced. 

6. Choose Sales document → Deliver. 
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On the Delivery Create: Overview screen, the system confirms that the consignment 
issue has been saved. 

7. Select the delivery item, then choose . 

Choose the Processing tab page. 

 
Note that this business transaction is not relevant for picking (Field: Not relevnt for 
pick). 

8. Choose Edit → Post goods issue. 

The customer consignment stock has now been reduced by 8 cartons and the system 
has posted a goods receipt to your regular inventory. This concludes this business 
transaction. 

9. Choose  until the overview tree appears. 

You now display the customer consignment stock once again. 

10. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → 
Environment → Stock → Stock Overview 

Transaction Code MMBE 

11. Enter the following data: 

Field Europe North America 

Material L-40F L-40F 

Plant 1200 3200 

Display version 1 1 

No zero stock lines Selected Selected 

Company code Selected Selected 

Plant Selected Selected 

Storage location Selected Selected 

Batch Selected Selected 

Special stock Selected Selected 

12. Choose . 

13. Select Cust.consignment line, then choose . 

14. The consignment stock of this customer has been reduced by 8 cartons. 

15. In the dialog box, choose . 

16. Choose  until the overview tree appears. 
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Billing the Consignment Issue 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales → Billing → Billing Document → Create 

Transaction Code VF01 

The R/3 System defaults the delivery you have just created. 

2. Choose . 

3. Choose . 

The system confirms that the billing document has been saved. 

4. Choose  until the overview tree appears. 
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Consignment Returns 
Purpose 
Consignment returns enable your customer to return goods to the consignment stock that have 
already been issued from it. 

You can find more information about this process under  [Page 176]. 

Process Flow 
You can find the data for this process under  [Page 177]. 

Processing Returns of Consignment Goods [Page 178] 1. 

2. Creating a Credit Memo [Page 181] 
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Additional Process Information 
This business transaction is relevant for billing, because the customer is credited for the returned 
goods. 
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Data Used During This Process 
Field Europe North America 

Order type CR (Consignment returns) CR  

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

Sold-to party 1001 3001 

Material L-40F L-40F 

Shipping point 1200 3200 

Plant 1200 3200 

Storage location 0001 0001 
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Processing the Return of Consignment Goods 
Prerequisites 
If you would like to execute this process without first performing consignment fill-up, you should 
first execute the process step Displaying the Consignment Stock [Page 159]. This enables you to 
track the stock changes triggered by this process. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Europe North America 

Order type CR (consignment return) CR 

1000 3000 

Distribution channel 12 12 

Division 00 

Sales organization 

00 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Sold-to party 1001 3001 

Purch. order no. K-LM-300003 C-IS-100304 

PO date Today‘s date Today‘s date 

Order reason Poor quality 101 (poor quality) 

Material L-40F L-40F 

Order quantity 2 (cartons) 2 (cartons) 

5. Choose . 

The system issues a warning that you need to check the billing date. 

6. Choose . 
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This business transaction has been automatically blocked for billing (see the Billing 
block field Check credit memo). You can only create the credit memo for this 
customer when the block has been removed. 

7. Select the return item, then choose . 

8. Choose the Shipping tab page, then enter the following data: 

Field Europe North America 

Storage location 0001 0001 

9. Choose Sales document → Deliver. 

10. Select the delivery item, then choose . 

11. Choose the Processing tab page. 

 
Note that this business transaction is not relevant for picking. 

12. Choose Post goods receipt. 

You have now increased the customer consignment stock in your plant by 2 cartons. 

13. Choose  until the overview tree appears. 

You now display the customer consignment stock once again. 

14. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → 
Environment → Stock → Stock Overview 

Transaction Code MMBE 

15. Enter the following data: 

Field Europe North America 

Material L-40F L-40F 

Plant 1200 3200 

Display version 1 1 

No zero stock lines Selected Selected 

Company code Selected Selected 

Plant Selected Selected 

Storage location Selected Selected 

Batch Selected Selected 

Special stock Selected Selected 

16. Choose . 

17. Select Cust.consignment, then choose . 

The consignment stock of this customer has been increased by 2 cartons.  
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18. Choose . 

19. Choose  until the overview tree appears. 
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Creating a Credit Memo 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Change 

Transaction Code VA02 

2. Enter the number of the sales document you created for the consignment return (or search 
Using Matchcodes [Ext.]). 

3. Choose . 

In the dialog box, the system informs you about the subsequent documents. 

4. Choose . 

5. To ensure that you can create the billing document choose in the Billing block field the F4 
input help and select the blank line. 

6. Choose Sales document → Billing. 

The system saves your changes. 

7. Choose . 

The document is saved. 

8. Choose Billing document → Display. 

The system defaults the number of your credit memo. 

9. Choose  Accounting. 

In the dialog box, you can choose the document type you wish to call up. 

10. Choose the Accounting document. 

On the overview screen for the accounting document, you see the line items with the 
corresponding accounts and amounts that have been posted in Financial Accounting. 

11. Choose  until the overview tree appears. 

In the dialog box choose . 
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Rebate Processing in SD and FI 
Purpose 
A rebate agreement has been made between sales organization 1020 and the store chain RIWA. 
The agreement states that if the retail chain places enough orders to reach a certain annual sales 
volume for certain products, they will receive a price discount from the sales organization. The 
sales volume figures used to calculate the rebate include figures from all the companies that 
belong to the RIWA store chain. The rebate is paid to the head office. 

You can find more information about this process under  [Page 183]. 

Process Flow 
You can find the data for this process under  [Page 185]. 

1. Posting Stock [Page 186] 

Creating Rebate Agreements [Page 18 ]8  2. 

Checking Customer Hierarchy [Page 19 ]2  3. 

4. Creating Sales Orders [Page 193] 

Delivering Sales Orders [Page 19 ]6  5. 

Creating Invoices [Page 19 ]8  6. 

7. Settlling Rebate Agreements [Page 20 ]1  

Creating Rebate Credit Memos [Page 20 ]5  8. 

9. Displaying a Profitability Report [Page 20 ]7  

182  April 2001 



 SAP AG Sales and Distribution (SD) 

  Additional Process Information 

Additional Process Information 

• Sales organization 

• Materials must belong to points 1 to 10 of the product hierarchy 

Sales and Distribution → System Modification → Create new fields (using the condition 
technique) → New fields for pricing. 

SD Pricing 
A new condition table has been created for rebate processing that enables you to make rebate 
pricing dependent on the following criteria: 

• Distribution channel 

• Customer must belong to a customer hierarchy 

The procedure for using a partial area of the Product hierarchy field in Pricing is described in the 
Implementation Guide text. 

Customizing menu path: 

Updating Customer Hierarchy Categories in CO-PA 
The operating concern IDEA defined in IDES has three characteristics for belonging to the 
customer hierarchy (customer hierarchy levels 1 to 3). 

In the master records for customer hierarchy nodes, the Assign hier. (hierarchy assignment) field 
is maintained for the marketing data. The number maintained in this field controls to which of the 
relevant hierarchy nodes the three defined CO-PA characteristics are copied. 

+/- Sign Transfer of the Rebate Condition Type to CO-PA 
The rebate condition types in SD correspond to the VV090 Rebate field in Profitability Analysis. 

The system uses the rebate condition type to transfer the provision amount from the billing 
documents (created during the validity period of the rebate) to this field in Profitability Analysis. 

The rebate condition type appears twice in the rebate credit memo (created once the rebate 
agreement had been settled). The first value is specified by the rebate amount that remains to be 
paid. This condition value is positive. The second value is specified using the rebate condition 
type for the value of the provision that remains to be written off. This condition value is displayed 
with a negative sign in SD. The difference between the actual rebate and the provision is copied 
from the rebate credit memo to the value field in Profitability Analysis.  The CO-PA field uses the 
difference that has been posted to indicate the actual value of the rebate once it has been 
settled. 

Because all the values transferred from SD to CO-PA are given the same sign, the indicator for 
the rebate condition type is set to +/- sign transfer. This indicator ensures that both positive and 
negative values from the condition are balanced. 

Customizing menu path: 

Controlling → Profitability Analysis → Flows of Actual Values → Transfer of Billing Fields 
→ Assign Actual Values. 
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Settlement Materials in Rebate Agreements 
Because the conditions in the rebate are not specific to the materials (they are created at a 
higher level in the product hierarchy), you need to specify a settlement material in the condition 
records for the rebate agreement. These settlement materials are used by the system to create 
credit memo requests and the rebate credit memo. For each product group (level 1 to 10 in the 
product hierarchy) that appears in the rebate agreement, a separate settlement material is 
assigned to the relevant product group in the Product hierarchy field. 
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Data Used During This Process 
Field Data Description 

Sales organization 1020 Berlin, Germany 

Distribution channel 20 Retail chains 

Division 00 Cross-divisional 

Plant 1100 Berlin plant 

Warehouse number 011 Warehouse, Berlin 

Shipping point 1100 Shipping point, Berlin 

Agreement type 0004 Hierarchy rebate 

6000 Customer 

Product group 0011000105 Gloss paints 

Product group 0011000110 Primer 

Settlement material 170 Settlement material for rebate credit memo for 
gloss paints 

Settlement material 178 Settlement material for rebate credit memo for 
primer 

Sold-to party 6002 Customer 

Sold-to party 6006 Customer 

Material Y-352 Gloss paints 

Material Y-353 Gloss paints 

Material CH_5103 Primer 

Operating concern IDEA Global IDES 

Type of Profit. Analysis Costing-based  

Report IDES-170 Rebate 

Rebate recipient 
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Posting the Stock 
Use 
During this process, you deliver specified materials to customers. In this first process step, you 
ensure that there is enough stock to cover the deliveries. You do not need to know anything 
about the procurement process for this scenario, as you post stock without making any reference 
to a previous production or purchase order. The materials involved are managed in batches. You 
therefore need to specify the characteristics of the batches to which the materials are posted. 

Procedure 
107. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Receipt → Other 

Transaction Code MB1C 

108. Enter the following data: 

Field Data 

Document date Today‘s date 

Posting date Today‘s date 

Movement type 501 

Storage location 

Plant 1100 

0001 

109. Choose . 

110. Enter the following data: 

Field Data 

Position 1  

Material (1st line) Y-352 

Quantity (1st line) 200 

Position 2  

Material (2nd line) Y-353 

Quantity (2nd line) 400 

 

CH_5103 

Quantity (line 3) 340 

Position 3 

Material (line 3) 

111. Choose . 

A dialog box appears informing you that the batches to be created are automatically 
numbered internally. 
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112. Choose Yes. 

In the following screen, you enter the batch attributes for material Y-352. 

113. Enter the following data: 

Field Data 

Viscosity 180 

Density 2.05 

Wavelength 800 

114. Choose . 

Now you enter the batch attributes for material Y-353. 

115. Enter the following data: 

Field Data 

Viscosity 180 

Density 2.05 

Wavelength 600 

116. Choose . 

117. Choose . 

The Enter Other Goods Receipts: Classification screen appears, where you enter the 
batch attributes for material CH_5103. The R/3 System proposes specific values. Do not 
change these entries. 

118. Enter the following data: 

Field Data 

Viscosity 40 

Gloss 80 

119. Choose . 

120. Choose . 

121. Choose . 

122. Choose  until the overview tree appears. 
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Creating Rebate Agreements 
Use 
Now you enter data for the rebate agreement. You define the runtime of the agreement and the 
recipient of the rebate payment. Sales organization 1020 uses a three-level product hierarchy 
(main group, group, subgroup). The rebate agreement is based on the sales volume for a product 
from a specific group (for example, paint, underlay). Different rebate percentages apply to these 
groups. You define these individual agreements in this step.  

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master Data → Agreements 
→ Rebate arrangement → Create 

Transaction Code VB01 

2. Enter the following data: 

Field Data 

Agreement type 0004 (hierarchy rebate) 

3. Choose . 

4. In the dialog box, enter the following data: 

Field Data 

Sales organization 1020 

Distribution channel 20 

Division 00 

5. Choose  Copy. 

6. Enter the following data: 

Field Data 

Description RIWA: Colors DDMMYY (replace DD with the current day, MM with the 
month and YY with the year, e.g. 070899). 

Rebate recipient 6000 

Currency EUR 

Validity period Today‘s date 

To End of current year 

Verification levels F 

7. Choose . 
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The specified rebate recipient is the central office of the RIWA store chain. 

8. Choose Conditions.  

9. In the following dialog box, place the cursor on Condition type ZB07 and choose New 
condition record. 

10. Enter the following data: 

Field Data 

Sales organization 1020 

Distribution channel 20 

Customer hierarchy 6000 

Validity period Today‘s date 

To End of current year 

Prod. Grp (line 1) 0011000105 

Rate (line 1) 8- 

Prod. Grp (line 2) 0011000110 

Rate (line 2) 5- 

11. Choose . 

 
The rebate agreement consists of two individual agreements, which are defined 
using the condition records. Once the requirements defined in the condition records 
have been met in the billing document, the rebate basis for the relevant condition 
record is increased by the billed value.  

Both individual rebate agreements determine that the sales volumes for the RIWA 
store chain should be taken into account. The R/3 System represents the RIWA 
store chain as a customer hierarchy. The highest hierarchy level is the customer 
number specified in the condition record (here 6000). The sales volume figures (used 
later for the rebate) include both the sales volume reached by customer 6000 and 
the sales volumes of all customers assigned to customer 6000 in the hierarchy.  

The conditions are also based on the volume for a product from a specific group 
(00110000105 = paint; 0011000110 = primer). Different rebate percentages apply to 
these groups. The percentages are scaled according to value.   

12. Select both conditions and choose . 

13. Enter the following data for the first condition: 

Field Data 

From (line 1) 10000 

Rate (line 1) 8- 

From (line 2) 15000 
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Rate (line 2) 10- 

From (line 3) 20000 

Rate (line 3) 12- 

From (line 4) 50000 

Rate (line 4) 15- 

14. Choose . 

15. Choose . 

16. Enter the following data for the second condition: 

Field Data 

From (line 1) 10000 

Rate (line 1) 5- 

From (line 2)  50000 

Rate (line 2) 7- 

From (line 3) 100000 

Rate (line 3) 10- 

17. Choose . 

18. Choose . 

 
The percentage of accruals determines that an accrual of the unpaid bonus payment 
is posted in financial accounting for each billing document. In profitability analysis 
this amount is displayed in the value field VV090 bonus. Because of the scaling the 
rate that will be used in end-of-period rebate, isn't determined yet. The percentage 
with which the accruals are posted in the billing documents is therefore an estimated 
value. For both individual rebate agreements you assume, that an average value in 
the sales grading will be achieved at the end of the validity period. With this 
assumption you determine the percentage of accruals. 

19. Enter the following data: 

Feld Daten 

Accruals  (line 1) 10- 

Accruals  (line 2) 7- 

20. Select both conditions and choose . 

 
For each condition record, enter a material for settlement. This material is needed to 
create a credit memo request and a credit memo when settling the amount.  

21. Enter the following data: 
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Field Data 

Matl f. settl. 170 

22. Choose . 

23. Choose . 

24. Enter the following data: 

Field Data 

Matl f. settl. 178 

25. Choose . 

26. Choose . 

The R/3 System issues a rebate agreement number (for a hierarchy rebate). 

Note this number. 

27. Choose . 
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Checking Customer Hierarchy 
For a better understanding of the process, this step displays the structure of the customer 
hierarchy.  

1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master Data → Business Partners 
→ Customer Hierarchy → Edit 

Transaction Code VDH1N 

2. Enter the following data: 

Field Data 

Customer hierarchy type A 

Validity date Today‘s date 

Customer 6000 

Sales organization 1020 

Distribution channel 20 

Division 00 

3. Choose . 

4. Position your cursor on RIWA Central Finance, then choose . 

The partial agreements in the rebate agreement are created at the top level of the 
customer hierarchy (customer number 6000). The rebate agreement includes the sales 
volume for hierarchy node 6000 and all its sub-hierarchies. 

5. Choose . 
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Creating Sales Orders 
Members of the RIWA store chain place orders with sales organization 1020 and you enter them 
in the R/3 System. 

1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Data 

Order type OR 

Sales organization 1020 

Distribution channel 20 

Division 00 

3. Choose . 

4. Enter the following data: 

Field Data 

Sold-to party 6002 

Purch. order no. RI-740398 

Purchase order date Today‘s date 

Req.deliv.date Today’s date +4  working days 

Pricing date Today‘s date 

Material Y-352 

Order quantity 200 

Material CH_5103 

Order quantity 200 

5. Choose . 

6. In the Partner selection dialog box, select customer 6003. 

7. Choose . 

8. In the dialog box, choose . 

9. Choose Goto → Header → Partner. 

Sold-to party 6002 belongs to the RIWA store chain. You can see that the system has 
copied this information to the sales order. The business transaction fulfills the 
requirement that the rebate agreement is specific to a customer. 

10. Choose . 
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11. Select the first item and choose Environment → Display material. 

12. Choose the Sales: sales org. 2 tab page. 

Here you can see that the material has been assigned to the product hierarchy. 

13. Place the cursor on the product hierarchy number and choose the F4 help. 

14. Place the cursor on 00110 Paints and choose Next level.  

On the next screen, the R/3 System lists all the groups that belong the main group 
Paints. 

15. Place the cursor on 00105 Gloss paints and choose Next level. 

The R/3 System lists all the groups that belong to the subgroup “Gloss paints”. 

16. Choose . 

 
On the Display Material: (Finished product) screen, you can see that the material has 
been assigned to the gloss paints subgroup, and to the opaque paints group. The 
material-specific requirement for the rebate agreement is therefore fulfilled. 

17. Choose . 

18. Complete steps 10 to 17 for the second item. 

 
The material for the second item belongs to the zinc-aluminium primer subgroup and 
to the priming group. This also fulfills the material-specific requirement for the rebate 
agreement. 

19. Choose the Shipping tab page. 

20. Note the Material availability date (Mat. av. dat) for both items. 

21. Choose . 

The R/3 System issues a sales order number. 

Note this number and use it instead of sales order 1, each time it is mentioned in the 
following scenario. 

22. Create another sales order by entering the following data: 

Field Data 

Sold-to party 6006 

PO number RI-744598 

Purchase order date Today‘s date 

Req.deliv.date Today’s date +4 working days 

Pricing date Today‘s date 

Material Y-353 

Order quantity 400 
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Material CH_5103 

Order quantity 140 

23. Choose . 

The sold-to party for this order is also a member of the product hierarchy. The materials 
ordered belong to the gloss paint or primer product group. This means that the order 
fulfills the requirements for the rebate agreement for both items. 

24. In the dialog box, choose . 

25. Choose the Shipping tab page. 

26. Note the Material availability date (Mat. av. dat) for both items. 

27. Choose . 

The R/3 System issues a sales order number. 

Note this number and use it instead of sales order 2, each time it is mentioned in the 
following scenario. 

28. Choose . 

29. In the dialog box, choose No. 

30. Choose . 
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Delivering Sales Orders 
You deliver the sales orders to the customers. This part of the process does not have any special 
features with regard to rebate processing. 

1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Collective Processing of Documents due 
for Delivery → Sales Orders 

Transaction Code VL10A 

2. Enter the following data: 

Field Data 

Shipping point 1100 

Delivery creation date The earliest of the material availability dates 

Delivery creation date (to) The later of the material availability dates 

Empty (delete default entry) 

Sales organization 1020 

Ship-to party 

3. Choose the Sales orders tab page. 

Field Data 

SD document (1st field) Sales order 1 

Sales document type Sales order 2 

4. Choose . 

5. Choose . 

 
If the numbers of sales order 1 and 2 are not sequential, it may be that other orders 
are included for your selection. If required, deselect these orders. 

6. Choose  Background. 

7. Choose . 

8. Position your cursor on the report group, then choose Documents. 

You see the created deliveries.  

Make a note of the numbers for both deliveries generated by this run. 

9. Choose  until the overview tree appears. 

10. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Picking → Create Transfer Order → Single Document 
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Transaction Code LT03 

11. Enter the following data: 

Field Data 

Warehouse number 011 

Plant 1100 

Delivery The first of the two deliveries you noted 

Foreground/backgrnd Background 

Adopt picking quantity 2 

12. Choose . 

The system generates a transfer order for the picking of the delivery quantities. Adopting 
picking quantities means that the system immediately posts the goods issue for the 
delivery. 

13. Repeat steps 11 and 12 for the second delivery. 

14. Choose . 
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Creating Invoices 
Use 
When you create the invoice, the system updates the rebate basis in the rebate agreement. In 
Financial Accounting, a provision is posted for the future rebate payment. The provision amount 
is accrued in the Rebate value field in Profitability Analysis. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Process Billing Due List 

Transaction Code VF04 

2. Enter the following data: 

Field Data 

Billing date from Today‘s date 

To Today‘s date 

Sales organization 1020 

Documents to be selected screen - delivery-related  Select 

3. Choose  DisplayBillList. 

The system lists all deliveries that are open for internal billing on the selected date. 

 
Note that additional deliveries (from previous IDES processes) may be displayed that 
are open for billing. If this is the case, deselect the deliveries that do not belong to 
your current IDES process. 

4. Choose . 

The R/3 System displays a group number for the orders that you have created.  

5. Position the cursor on the group number line, and then choose Documents. 

You see a list of the created invoices. 

6. Note the document numbers of both sales documents. 

7. Place the cursor on the first invoice and choose  Disp. doc.. 

The quantity of the individual batch is billed on the basis of the system setting. For this 
reason, the billing document contains an item without a batch entry and a billing quantity 
of zero, and a further item for each batch with the corresponding billing quantity. 

8. Select item 11, then choose  in the lower half of the screen. 

9. Select the line for condition type ZBO7 and choose . 
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You can see that the pricing condition has been calculated according to the rebate 
agreement that you created (in the Rebates section). The amount corresponds to the 
provision percentage rate determined in the rebate agreement (Condition values 
section). The condition is only for statistical purposes and does not influence the value of 
the billing item. A provision is posted for the value of the condition (Control data section). 

10. Choose . 

In the condition record for the rebate agreement, the sales volume valid for a rebate is 
increased by the value in the Rebate basis line.  

11. Choose . 

12. Choose  Accounting. 

13. In the dialog box, choose Accounting document. 

In Financial Accounting, both revenue and receivables have been posted, along with the 
provision for the value of condition type ZBO7. Account 8900 is the balance sheet 
account and account 884010 is the sales deduction account.  

14. Choose . 

Two documents exist for the profitability analysis because it is updated for each item in 
the sales order and billing document. 

15. Choose the first document for the profitability analysis.  

16. Choose the Characteristics tab page. 

17. To see more characteristics, choose . 

You can see all the relevant data from the billing document. On customer hierarchy level 
01, you can see the first node for the RIWA central office, along with customer number 
6000 and the assignments to customer hierarchies 02 and 03 (as discussed in the Check 
Customer Hierarchy process step). Product hierarchies 1 - 3 are filled according to the 
CO-PA derivation rules. 

 
Characteristics exist for all dimensions that can be used for analysis purposes in 
Profitability Analysis. These characteristics values are derived from the customer and 
material master data and from SD partner roles (such as sales representatives), or 
from CO-PA-specific characteristics. 

18. Choose the Value fields tab page. 

19. Scroll down using , until the rebate and revenue fields are displayed. Note that the value of 
the Accounting provision in the Cash discount field is the sales deduction from the profitability 
analysis. 

 
The value fields contain detailed information about billing quantities, revenue, 
rebates and detailed product cost components that were derived from the Sales and 
Distribution and Product Cost Planning areas. Note that the list of value fields 
continues over several screens. 

20. Choose . 
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21. Choose . 

22. Choose  until the overview tree appears. 
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Settling Rebate Agreements 
Use 
Now you settle the rebate agreement. For obvious reasons, we cannot wait until the validity 
period of the agreement has expired before we do this. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master Data → Agreements 
→ Rebate arrangement → Change 

Transaction Code VB02 

2. Enter the following data: 

Field Data 

Agreement Agreement number noted earlier 

3. Choose . 

4. Choose . 

The rebate agreement displays the values currently accrued for each condition. 

5. Choose . 

6. Enter the following data: 

Field Data 

Status of agreement B (agreement released for settlement) 

7. Choose . 

8. Choose Rebate payments → Final settlement → Using payment screen. 

The amount to be paid for each individual agreement is displayed. 

9. Choose . 

10. Note the number of the credit memo request. 

11. To close the dialog box, choose . 

12. On the Change Rebate Agreement screen, choose Rebate agreement → Display. 

13. Enter the following data: 

Field Data 

Agreement Agreement number noted earlier 

14. Choose . 

15. Choose Rebate payments → Rebate documents. 

16. In the dialog box, enter the following data: 
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Field Data 

Final settlement Select 

17. Choose . 

 
In the product group 0011000105 (gloss paint) area, the payment amount exceeds 
the provision amount. In the production group 0011000110 (primer) the opposite is 
true. 

18. Choose . 

19. To close the dialog box, choose . 

20. Choose . 
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Creating Rebate Credit Memos 
Use 
Now you create the rebate credit memo (based on the credit memo request generated in the 
settlement). 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Change 

Transaction Code VA02 

2. Enter the following data: 

Field Data 

Order Credit memo request noted earlier 

3. Choose . 

You can see that the credit memo request has been created for the rebate recipient 6000 
(entered in the rebate agreement). The items in the credit memo request are created 
using the settlement material entered in the condition records for the rebate agreement.  

4. Select the first item and choose  in the lower half of the screen. 

Condition type ZBO7 appears twice. In the first line, it contains the payment amount 
calculated from the sales volume. The second line contains the provision amount posted 
up to now. When you create the credit memo, the provision in Financial Accounting is 
written off by this amount. In Profitability Analysis, once the credit memo has been 
created, the system updates the difference between the payment and provision amounts 
in the rebate value field. 

5. Choose . 

6. Enter the following data: 

Field Data 

Billing block empty (delete any default) 

7. Choose Sales document  Billing. 

8. Choose . 

The R/3 System issues a document number. 

Note this number. 

9. On the Create Billing Document screen, choose Billing document  Display. 

10. Enter the following data: 

Field Data 

Billing document Your noted Billing number 
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11. Choose  Accounting. 

12. In the dialog box, double click on Accounting document. 

The posted provision has been settled (account number 89000 and 884010). 

13. Choose . 

14. Double click on the first document from the profitability analysis. 

15. Choose the Characteristics tab page. 

16. To see more characteristics, choose . 

You can only see product hierarchies 1 and 2 because the settlement material has been 
assigned to these hierarchy levels only. 

You now see customer 6000 (the central office of the company RIWA), to which the 
rebate credit memo is sent. On the customer hierarchy level, only field 01 has been 
completed, because the credit memo was sent directly to the central office and not to the 
companies assigned beneath it. 

You can see the settlement material for the product hierarchy for gloss paints, but you 
can’t see the sold final product anymore. 

17. Choose the Value fields tab page. 

18. Scroll down using  until you display the Rebate costing field. 

The value field contains the difference between the provision and the amount that was 
paid out. This means that the total amount of the sales deduction has increased, 
because the condition type for rebates was updated to Profitability Analysis using sign 
transfer. This makes it possible for a negative sign to count as an increase to costs. 

19. Choose . 

20. Double click on the second document in Profitability Analysis. 

Look at the credit memo item for the product hierarchy for primers. 

21. Choose the Value fields tab page. 

The rebate value field contains the difference between the provision and the amount that 
was paid out. This time the value is not negative. This means that the provision was too 
high and that the total value of the rebates has been decreased by this amount. 

22. Choose . 

23. Choose . 

24. Choose  until the overview tree appears. 
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Creating Rebate Credit Memos 
Use 
Now you create the rebate credit memo (based on the credit memo request generated in the 
settlement). 

Procedure 
25. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Change 

Transaction Code VA02 

26. Enter the following data: 

Field Data 

Order Credit memo request noted earlier 

27. Choose . 

You can see that the credit memo request has been created for the rebate recipient 6000 
(entered in the rebate agreement). The items in the credit memo request are created 
using the settlement material entered in the condition records for the rebate agreement.  

28. Select the first item and choose  in the lower half of the screen. 

Condition type ZBO7 appears twice. In the first line, it contains the payment amount 
calculated from the sales volume. The second line contains the provision amount posted 
up to now. When you create the credit memo, the provision in Financial Accounting is 
written off by this amount. In Profitability Analysis, once the credit memo has been 
created, the system updates the difference between the payment and provision amounts 
in the rebate value field. 

29. Choose . 

30. Enter the following data: 

Field Data 

Billing block empty (delete any default) 

31. Choose Sales document  Billing. 

32. Choose . 

The R/3 System issues a document number. 

Note this number. 

33. On the Create Billing Document screen, choose Billing document  Display. 

34. Enter the following data: 

Field Data 

Billing document Your noted Billing number 

April 2001  205 



Sales and Distribution (SD)  SAP AG 

Creating Rebate Credit Memos 

35. Choose  Accounting. 

36. In the dialog box, double click on Accounting document. 

The posted provision has been settled (account number 89000 and 884010). 

37. Choose . 

38. Double click on the first document from the profitability analysis. 

39. Choose the Characteristics tab page. 

40. To see more characteristics, choose . 

You now see customer 6000 (the central office of the company RIWA), to which the 
rebate credit memo is sent. On the customer hierarchy level, only field 01 has been 
completed, because the credit memo was sent directly to the central office and not to the 
companies assigned beneath it. 

You can see the settlement material for the product hierarchy for gloss paints, but you 
can’t see the sold final product anymore. 

You can only see product hierarchies 1 and 2 because the settlement material has been 
assigned to these hierarchy levels only. 

41. Choose the Value fields tab page. 

42. Scroll down using  until you display the Rebate costing field. 

The value field contains the difference between the provision and the amount that was 
paid out. This means that the total amount of the sales deduction has increased, 
because the condition type for rebates was updated to Profitability Analysis using sign 
transfer. This makes it possible for a negative sign to count as an increase to costs. 

43. Choose . 

44. Double click on the second document in Profitability Analysis. 

Look at the credit memo item for the product hierarchy for primers. 

45. Choose the Value fields tab page. 

The rebate value field contains the difference between the provision and the amount that 
was paid out. This time the value is not negative. This means that the provision was too 
high and that the total value of the rebates has been decreased by this amount. 

46. Choose . 

47. Choose . 

48. Choose  until the overview tree appears. 
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Displaying a Profitability Report 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Information System 
→ Execute Report 

Transaction Code KE30 

 
If you are executing a profitability analysis transaction for the first time since logging 
on, the Set operating concern dialog box appears. 

2. Enter the following data: 

Field Data 

Operating concern IDEA 

Type of Profit. Analysis Costing-based 

3. Choose . 

This dialog box is shown only once during the session. Once you have made your 
selection, the system always selects the given operating concern and the relevant type of 
profitability analysis. 

4. Select IDES-170 and choose : 

Data 

The Selection: Rebate should display the parameters from the report. If this is not the 
case, enter the following data: 

Field 

Period from Current month (MM.YY) 

To period Current month (MM.YY) 

Plan/act.ind. 0 

Version Empty (delete any default) 

Record type F 

5. Choose . 

In the top line, you can see that sales organization 1020 and distribution channel 20 have 
been determined for this report. You can page through the other characteristics as you 
require. The value fields displayed are for the billing quantity, revenue and rebate value. 

 
For more information about the functions in Reporting, see Executing Defined 
Reports in Profitability Analysis and Reporting Functions [Ext.]. 

The first characteristic you see that can be navigated is the division. In this case, this 
is division (paints). 
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6. Double-click on 03 paint. 

The system displays product hierarchy 1.  

7. Double-click on line 00110 (paints). 

You now see product hierarchy 2 and how it is divided between gloss paints (article Y-
352 and Y-353) and primer (article CH_5103). In the Rebate value field, you can see the 
amounts that were paid out as rebates. 

8. Double-click on the line 0011000110. 

You see an overview of the articles in the product hierarchy. Article CH_5103 is the 
finished product that was sold and 178 is the settlement material for this product 
hierarchy.  

9. Double-click on the article CH_5103. 

You see an overview of the customers in the RIWA company that ordered this article. 

10. Double-click on customer 6002. 

Product hierarchy 3 is assigned to the article CH_5103. 

11. Choose  twice. 

12. Double-click on settlement material 178. 

The customer is the central office with customer number 6000. The difference between 
the rebate provision and rebate payment has been offset for this customer 

13. Double-click on this customer. 

You can see that product hierarchy 3 has not been assigned to the article because the 
settlement material is only defined up to product hierarchy 2.  

 
You can see the product hierarchy for gloss paints by going back three steps and 
implementing steps 7-11 for product hierarchy 0011000105. 

14. Choose . 

The Exit report dialog box appears. 

15. Choose Yes. 

16. Choose . 
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Monitoring Sales Promotion Budgets 
Sales organization 1020 has created a sales promotion, that is, a general marketing plan, for the 
product group “paint”, which contains several types of sales deals. The sales deals provide the 
basis for arranging discounts with the customers and the promotion contains the budgets 
planned for the discounts. When you create a sales deal, the system checks whether resources 
are still available from the planned budget. As soon as sales orders or billing documents for a 
particular sales deal are created, the actual figures from these transactions are transferred to the 
budget so that it remains up to date. 

You can find more information about this process under  [Page 210]. 

Process Flow 
You can find the data for this process under  [Page 211]. 

1. Posting Stock [Page 212] 

Creating Promotions [Page 214] 2. 

Planning Budgets [Page 21 ]5  3. 

4. Display Budget [Page 218] 

Creating Sales Promotions [Page 220] 5. 

Display Sales Actions [Page 224]  6. 

7. Controlling Budget Assignments [Page 226] 

Creating the Sales Orders [Page 227] 8. 

Controlling Budget Assignments [Page 230] 9. 

10. Delivering Sales Orders [Page 23 ]1  

Creating Transport Request [Page 232] 11. 

Creating Billing Documents [Page 233] 12. 

13. Controlling Budget Assignments [Page 234] 

14. Resetting Starting Situation [Page 235] 
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Additional Process Information 
Expanding the Operating Concern 
The IDEA operating concern (IDES global operating concern) has been expanded to include 
promotions and sales deals. This means that these are also available as evaluation objects in 
Profitability Analysis. 

Activating Budgets in Profitability Analysis 
Budget assignments have to be updated for each condition type when you maintain condition 
records. The condition type used in this process (KA00 - sales discount) has already been 
activated. 

Call up the Customizing transaction as follows: 

Menu Path Controlling → Profitability Analysis → Flows of Actual Values → Set up 
transfer of customer rebate agreements 

Transaction Code SIMG_CFMENUORKEKES4 

 

IDES-180 Report 
Data can be transferred from the Sales and Distribution (SD) application component to 
Profitability Analysis at three different times. When you maintain condition records, data is 
updated with transaction type G (customer rebate agreements); when you create sales orders, it 
is updated with transaction type A (incoming sales orders); and when you bill them, data is 
transferred to Profitability Analysis with transaction type F (billing data). 

Report IDES-180 has been defined for budget controls. This report evaluates data that have 
been updated for a promotion in Profitability Analysis. The data is compressed at promotion level 
according to country, sales region, customer and period/year. The report contains different 
indicators. Indicator Plan promotion evaluates data available in transaction type G as planning 
data in Profitability Analysis. This data comes from promotion budget planning. The Actual deal 
indicator is based on data available in transaction type G as actual data. This data is updated 
when you create condition records. The report calculates the actual data for transaction type A 
with the Actual orders indicator and, for transaction type F with the Actual billing document 
indicator. 

All the indicators named are based on the Other rebates value field in the IDEA operating 
concern. Condition type KA00 (promotion discount) from SD correspond to this value field in 
Profitability Analysis. 

The three indicators Open promotions, Open orders and Open billing documents are all defined 
by a formula that calculates the difference between the planned values and the actual values for 
each transaction type. 
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Data Used During This Process 
Field Data Description 

Plant 1100 Berlin 

Storage location 0001 Material storage 

Y-352 Paint 5 Liter can 

Material Y-353 Paint 10 Liter can 

Promotion type 0030 Promotion 

Sales organization 1020 Berlin, Germany 

Distribution channel 20 Retail chains 

Division 00 Cross-divisional 

Customer 6010 Homebuilding 

Customer 6011 Havers 

Customer 6002 Riwa 

Type of sales deal 0020 Sales deal 

Operating concern IDEA Operating concern IDES 

Plan version 180 Promotion 

Planning layout IDES180 Promotion 

Report IDES-180 Promotion 

Shipping point 1100 Shipping point Berlin 

Warehouse number 011 Warehouse Berlin 

Material 
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Posting Stock 
Use 
During this process you deliver specified materials to customers. In the first activity you ensure 
that there is sufficient stock to fulfil these deliveries. As the procurement process is not of interest 
to this process, you post the stock without reference to any upstream production or purchase 
order. The materials involved are managed in batches. You therefore need to specify the 
characteristics of the batches that are posted to. 

Procedure 
1. Call the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Receipt → Other 

Transaction Code MB1C 

2. Enter the following data: 

Field Data 

Document date Today’s date 

Movement type 501 

Plant 1100 

Storage location 0001 

Posting date Today’s date 

3. Choose . 

4. Enter the following data: 

Column  Row Data 

Material 1 Y-352 

Quantity 1 150 

Material 2 Y-353 

Quantity 2 130 

5. Choose . 

6. If the Automatic Batch Number Assignment dialog box appears, choose Yes. 

7. Enter the following data for Material Y-352: 

Field Data 

Viscosity 180 

Density 2,05 

Wavelength 800 

212  April 2001 



 SAP AG Sales and Distribution (SD) 

  Posting Stock 

8. Choose . 

9. Enter the following data for Material Y-353: 

Field Data 

Viscosity 180 

Density 2,05 

Wavelength 600 

10. Choose . 

11. Choose . 

A document number assignment is displayed in the status line. 

12. Choose  until the overview tree appears. 
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Creating Promotions 
Use 
This activity creates promotions in the R/3 System. You specify the promotion’s sales area and 
validity period. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master Data → Agreements 
→ Promotion → Create 

Transaction Code VB31 

2. Enter the following data in the Create Promotion screen: 

Field Data 

Promotion type 0030 

3. Choose . 

4. Enter the following data in the Organizational Data dialog box: 

Field Data 

Sales organization 1020 

Distribution channel 20 

Division 00 

5. Choose Copy. 

6. Enter the following data: 

Field Data 

Description Your paint program 

Validity period from First day of the current month 

To six months later 

7. Choose . 

The promotion number is displayed in the status line. 

8. Note the promotion number. 

9. Choose  until the overview tree appears. 
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Planning Budgets 
Use 
This activity determines the budget for promotions. The budget plans the discounts which can be 
allowed in a sales promotion. The planning levels are country and region and customer. 

Procedure 
1. Call the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Planning → Edit 
Planning Data 

Transaction Code KEPM 

2. If the Set Operating Concern dialog box appears, enter the following data: 

Field Data 

Operating concern IDEA 

Costing-based Select 

3. Choose . 

 
This dialog box appears when the transaction is first called. The R/3 System keeps 
your selection. 

4. Open the  Planning Levels →  IDES 180 →  IDES 180 tree in the top left-hand 
corner. 

5. Choose Change Planning Package by clicking with the right-hand key on  IDES 180. 

6. Enter the following data at the right-hand side: 

Field Data 

From Country + Region DE 05 (North-Rhine Westphalia) 

From Period/Year Current month/year 

To Period/Year Current month/year 

Promotion Promotion number noted earlier 

Version 180 

7. Choose . 

8. Call the Promotion by double-click on  IDES. 

9. Open the  IDES 180 →  Enter planning Data →  IDES 180 tree in the bottom left-
hand corner. 

10. Call Change Sales and Profit Plan: Aggregated Values by double click on  IDES180. 

11. Enter the following data: 
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Column  Row Data 

Customer 1 6010 

Budget 1 40000 

Customer 2 6011 

Budget 2 20000 

12. Choose . 

13. Select the first row: 

14. Choose . 

 
The cumulated value which you specified was distributed among the promotion 
periods (months) by the R/3 System in the Change Sales and Profit Planning: Period 
Values screen. 

15. Choose . 

The status row shows that the plan data have been posted. 

 
You then plan the data for country + region DE 08 (Baden-Württemberg). 

16. Open the  Planning Levels →  IDES 180 →  IDES 180 tree in the top left-hand 
corner. 

 17. Choose Change Planning Package by clicking with the right-hand key on IDES 180. 

18. Enter the following data at the right-hand side: 

Field Data 

From Country + Region DE 08 (Baden-Wuerttemberg) 

From Period/Year Current month/year 

To Period/Year Current month/year 

Promotion Promotion number noted earlier 

Version 180 

19. Choose . 

20. Call the Promotion by double-click on  IDES. 

21. Open the  IDES 180 →  Enter planning Data →  IDES 180 tree in the bottom left-
hand corner. 

22. Call Change Sales and Profit Plan: Aggregated Values by double click on  IDES180. 

23. Enter the following data: 

Column  Data 
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Customer 6002 

Budget 24000 

24. Choose . 

25. Choose . 

The status row shows that the plan data have been posted. 

26. Choose  until the overview tree appears. 
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Display Budget 
Use 
In the following step, display the planning data for one of the two regions again. This should 
clarify how the planning data in profitability analysis has been cumulated. 

Procedure 
1. Call the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Planning → Edit 
Planning Data 

Transaction Code KEPM 

2. Open the  Planning Levels →  IDES 180 →  IDES 180 tree in the top left-hand 
corner. 

3. Choose Change Planning Package by clicking with the right-hand key on  IDES 180. 

4. Enter the following data at the right-hand side: 

Field Data 

Country + Region DE 05 

From Period/Year Current month/year 

To Period/Year Current month/year 

Promotion Promotion number noted earlier 

Version 180 

5. Choose . 

6. Call the Promotion by double-click on  IDES. 

7. Open the  IDES 180 →  Enter planning Data →  IDES 180 tree in the bottom left-
hand corner. 

8. Call Change Sales and Profitability Planning: Cumulated Values by double click on  
IDES180. 

9. Select the row for customer 6010. 

10. Choose  Line items. 

If the Line items: Selection Conditions dialog box appears, choose . 

 
The data has been posted to Profitability Analysis as transaction type G (customer 
agreements) as planning values (planned/actual indicator = 1). 

11. Double-click on the first item to call the Display Planned Individual Items: List. 
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The planned figures have been updated for the characteristic values that you entered 
for sales organization, country + region, customer and promotion. Other 
characteristics can be derived from these characteristic values, (such as the 
company code from the sales organization) or they are taken from the customer 
master record that you specified (for example, customer class). The budget is copied 
into the Other discounts field. 

12. Choose . 

13. Choose  until the overview tree appears. 

In the dialog box, choose No. 
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Creating Sales Promotions 
Use 
A promotion contains sales deals which are used to agree a rebate with a customer for certain 
products in the range of paints. The value of the pricing rebate that arises from the planned sales 
volume is updated as a budget assignment. 

Procedure 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master Data → Agreements 
→ Sales deal → Create 

Transaction Code VB21 

2. Enter the following data: 

Field Data 

Type of sales deal 0020 

3. Choose Reference Promotion. 

Data 

4. Make the following entries in the Input Reference Agreement dialog box: 

Field 

Promotion Promotion number noted earlier 

5. Choose  Copy. 

6. Choose . 

On the Organizational Data dialog box, you can see that the promotion specified has 
been copied to the organizational data for the agreement. 

7. Choose . 

8. Enter the following data: 

Field Data 

Description 6010: Paint  

To period  Current month + 5 

9. Choose Conditions. 

The Valid Condition Types and Key Combination dialog box appears. 

10. Position the cursor on the row for condition type KA00 Sales Promotion. 

11. Choose New Condition Records. 

12. Enter the following data: 

Field Data 

Sales organization 1020 

220  April 2001 



 SAP AG Sales and Distribution (SD) 

  Creating Sales Promotions 

Distribution channel 20 

Customer 6010 

Material (1st line) Y-352 

Rate (line 1) 10 

Y-353 

Rate (line 2) 

Material (2nd line) 

15 

13. Choose . 

14. Mark both rows. 

15. Choose . 

The Create Sales Deal: Detail Sales Promotion (KA00) screen for the first condition is 
displayed. 

16. Enter the following data: 

Field Data 

Planned basis 20000 

17. Choose . 

 
The planned sales volume for customer 6010 and material Y-352 during the validity 
period of the rebate is 20,000 DEM. The system uses this value to calculate the 
planned condition value which is then transferred to Profitability Analysis (see 
below). 

18. Choose  to display the condition for the second item. 

19. Enter the following data: 

Field Data 

Planned basis 30000 

20. Choose .  

21. Choose . 

To skip any warnings about Overlapping Validity Periods choose . 

 
The number of your sales action is displayed in the status row. 

22. Note the sales action number. 

 
Create another sales deal. 

23. Enter the following data: 
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Field Data 

Type of sales deal 0020 

24. Choose Reference Promotion. 

25. Enter the following data: 

Field Data 

Promotion Promotion number noted earlier 

26. Choose  Copy. 

27. Enter the following data: 

Field Data 

Description 6011: Paint  

to Current month + 5 

28. Choose Conditions. 

The Valid Condition Types and Key Combination dialog box appears. 

29. Position the cursor on the row for condition type KA00 Action. 

30. Choose New condition Record. 

31. Enter the following data in the Create Sales Deal: Overview Sales Promotion(KA00) screen: 

Field Data 

Sales organization 1020 

Distribution channel 20 

Material (1st line) Y-352 

7,5 

Material (2nd line) Y-353 

Rate (line 2) 11 

Customer 6011 

Rate (line 1) 

32. Choose . 

33. Mark both rows. 

34. Choose . 

35. Enter the following data: 

Field Data 

Planned basis 10000 

36. Choose . 

37. Choose  to display the condition for the second item. 

38. Enter the following data: 
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Field Data 

Planned basis 15000 

39. Choose . 

40. Choose . 

To skip any warnings about Overlapping Validity Periods choose . 

The number of your sales action is displayed in the status row. 

41. Note the second sales action number. 

42. Choose  until the overview tree appears. 
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Display Sales Action 
Use 
In the following step, display the data for one of the two sales deals again. The system displays 
how the data from the condition records created for this sales deal is forwarded to Profitability 
Analysis. 

Procedure 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master Data → Deals → Sales 
Deals → Display 

Transaction Code VB23 

2. Enter the following data: 

Field Data 

Sales deal Number of second sales deal 

3. Choose . 

4. Choose Conditions. 

5. On the Valid Condition Types and Key Combinations dialog box, place the cursor on 
Condition type KA00 sales deal and choose . 

6. Select the first item: 

7. To display the individual items, choose Environment → Line items. 

 
The planned value of the condition is transferred to Profitability Analysis with 
transaction type G (customer agreements). This transaction type also posts the data 
from the previous budget assignment. In contrast to the budget data which was 
posted to Profitability Analysis with the planned/actual indicator 1 (planned), the 
condition values are indicated as 0 (actual). Profitability Analysis also uses another 
currency so the documents are displayed in both the operating concern’s currency 
(currency type B0) and the company code currency (currency type 10). 

The planned condition value is distributed across the different months (periods) 
according to the condition’s validity period. 

8. Double-click on the first individual item. 

9. Choose the Characteristics tab page. 

 
The planned value of the discount has been updated at country and region and 
customer levels. Country and region and customer are also the promotion budget 
criteria. As the promotion number which belongs to the sales deal has been 
transferred to Profitability Analysis, the budget assignment can be compared with the 
promotion budget using the planned condition values. 
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10. Choose the Value fields tab page. 

11. Choose  until Other rebates is displayed. 

 
Condition type KA00 (promotion discount) from SD corresponds to the Other rebates 
field in Profitability Analysis. This field contains the planned condition value. 

12. Choose  until the overview tree appears. 

In the dialog box, choose . 
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Controlling Budget Assignments 
Use 
As soon as sales promotions with their rebate agreements have been created, you can check 
how much of the budget has been used for the promotion. 

 
This report displays the data available in Profitability Analysis for the sales deal you created. The 
first drill-down level displays the data at country level. This compares the country budget 
(Promotion planned) against the actual values at country level for the sales promotion (Promotion 
Actual). Open Promotions displays the difference between the values as an open budget. You 
can navigate further to the levels for Country + Region, Customer and Period (month). 

Procedure 
1. Call the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Information System 
→ Execute Report 

Transaction Code KE30 

2. Select the report  IDES-180. 

3. Choose . 

4. Enter the following data: 

Field Data 

Promotion Promotion number noted earlier 

5. Choose . 

6. Call the customer view by double-click on North Rhine Westphalia. 

7. Call the distribution of the total values among the periods by double-click on the first 
customer. 

8. Choose . 

9. In the dialog box, choose Yes. 

10. Choose  until the overview tree appears. 
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Creating Sales Orders 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Data 

Order type OR 

Sales organization 1020 

Distribution channel 20 

Division 00 

3. Choose . 

4. Enter the following data: 

Field Data 

6010 

Purch. order no. HE-760398 

PO date Today’s date 

Req.deliv.date Today’s date + 4 working days 

Pricing date Today’s date 

Material (1st line) Y-352 

Order quantity (1st line) 100 

Material (2nd line) Y-353 

Order quantity (2nd line) 50 

Sold-to party 

5. Choose . 

6. To skip any information messages, choose . 

7. Select the first item. 

8. Choose . 

The Create Standard Order: Item Data screen appears. 

9. Select the row for condition type KA00 Sales Promotion. 

10. Choose  Condition rec. 

11. Select the row for condition type KA00. 

12. Choose . 
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The promotion discount is taken from the sales action you created earlier that in 
turn belongs to the Paint program promotion. 

13. Choose . 

14. Choose . 

15. Choose the Shipping tab in the Create Standard Order: Overview screen. 

16. Note the material availability date (Mat. av. dat) for both items. 

17. Choose . 

The assigned order number is displayed in the status bar. 

18. Note the order number. 

This order will now be referred to as Sales order 1. 

19. To create another order, make the following entries: 

Field Data 

Sold-to party 6011 

Purch. order no. HA-984598 

PO date Today’s date 

Req.deliv.date Today’s date + 4 working days 

Pricing date Today’s date 

Material Y-352 

Order quantity 50 

Material Y-353 

Order quantity 80 

20. Choose . 

21. To skip any information messages, choose . 

22. Choose the Shipping tab page. 

23. Note down the Material availability date (Mat. av. dat) for both items. 

24. Choose . 

The assigned order number is displayed in the status bar. 

25. Note the second order number. 

This order will now be referred to as Sales order 2. 

26. Choose  until the overview tree appears. 

In the dialog box, choose No. 
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Controlling Budget Assignments 
Use 
As soon as sales orders are created for the sales deal, the actual figures for these orders 
become available for monitoring the budget. 

 
The report lists the value updated from the customer orders for the rebate in the Actual sales 
order value column. The Open sales order values column contains the budget amount that 
has not yet been used by the sales orders. 

Procedure 
1. Call the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Information System 
→ Execute Report 

Transaction Code KE30 

2. Select the report  IDES-180. 

3. Choose . 

4. Enter the following data: 

Field Data 

Promotion Promotion number noted earlier 

5. Choose . 

6. Call the customer view by double-click on North Rhine Westphalia. 

7. Call the distribution of the total values among the periods by double-click on the first 
customer. 

8. Choose . 

9. In the dialog box, choose Yes. 

10. Choose  until the overview tree appears. 
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Delivering Sales Orders 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Collective Processing of Documents Due 
for Delivery → Sales Orders 

Transaction Code VL10A 

2. Enter the following data: 

Field Data 

Shipping point/receiving pt 1100 

Delivery creation date The earliest of the material availability dates 

Delivery creation date (to) The later of the material availability dates 

Ship-to party Empty (delete default entry) 

Sales organization 1020 

3. Choose the Sales orders tab. 

4. Enter the following data: 

Field Data 

SD document (1st field) Sales order 1 

SD document (2nd field) Sales order 2 

5. Choose . 

6. Select your customer orders. 

7. Choose  Background. 

8. Choose  to display the log. 

9. Position the cursor on the group number. 

10. Choose Documents. 

The numbers for the created deliveries are displayed in the Document column. 

11. Make a note of both delivery numbers. 

12. Choose  until the overview tree appears. 
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Create Transport Request 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Picking → Create Transfer Order → Single Document 

Transaction Code LT03 

2. Enter the following data: 

Field Data 

Warehouse number 011 

Plant 1100 

Delivery First delivery number 

Foreground/backgrd Background 

Adopt pick quantity 2 

3. Choose . 

 
The system generates a transfer order for the picking of the delivery quantities. 
Option 2 (Adopt picking quantity) ensures that the goods issue posting is made at the 
same time as the delivery. 

4. Enter the following data: 

Field Data 

Warehouse number 011 

Plant 1100 

Delivery Second delivery number 

Foreground/backgrd Background 

Adopt pick quantity 2 

5. Choose . 

6. Choose  until the overview tree appears. 
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Creating Billing Documents 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Process Billing Due List 

Transaction Code VF04 

2. Enter the following data: 

Field Data 

Billing date from Today’s date 

To Today’s date 

Sales organization 1020 

Documents to be selected – delivery-related Select 

3. Choose  DisplayBill.List. 

The system displays all the deliveries that are still open for internal billing on the current 
date. 

If other deliveries than those you created are selected, deselect them. 

4. Choose . 

The invoicing run is displayed. 

5. Position the cursor on the line containing your billing run. 

6. Choose Documents. 

The created invoices are displayed. 

7. Choose  until the overview tree appears. 

In the dialog box, choose Yes. 
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Controlling Budget Assignments 
Use 
Once an invoice has been created for the deliveries, budget monitoring can access the actual 
figures from the billing documents. 

 
The report lists the value updated from the billing documents for the rebate in the Actual 
billing document value column. The Open billing document values column contains the budget 
amount that has not yet been used by the billing documents. 

Procedure 
1. Call the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Information System 
→ Execute Report 

Transaction Code KE30 

2. Select the report  IDES-180. 

3. Choose . 

4. Enter the following data: 

Field Data 

Promotion Promotion number noted earlier 

.5. Choose  

6. Call the customer view by double-click on North Rhine Westphalia. 

7. Call the distribution of the total values among the periods by double-click on the first 
customer. 

8. Choose . 

9. In the dialog box, choose Yes. 

10. Choose  until the overview tree appears. 
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Resetting Starting Situation 
Use 
Set a deletion flag for the condition records you created for the sales promotions so that the 
process can be repeated. This prevents the validity periods overlapping with each other. 

Procedure 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Master data → Conditions → Select 
using index → Change conditions. 

Transaction Code V/15 

2. Select the index Customer/Sales Org/Distrib. Channel/Sector in the Select Index dialog box. 

3. Choose . 

4. Enter the following data: 

Field Data 

Customer 6010 

To 6011 

Sales organization 1020 

Distribution channel 20 

Division Empty (delete any default) 

Valid on Today’s date 

5. Choose . 

6. Choose Administrative data. 

The system displays the condition records that are assigned to the sales promotion you 
created. 

7. Select all condition records. 

8. Choose . 

The D column displays the deletion flag for the condition records. 

9. Choose . 

The status row shows that the condition records have been saved. 

10. Choose  until the overview tree appears. 
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Shipping 
1. Combining Orders (Manually and via the Delivery Due List) [Page 23 ]8  

2. Partial Delivery [Page 249] 

Packing the Delivery [Page 259] 3. 

4. Kpicking with Lean WM [Page 267] 
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Combining Orders (Manually and Via the Delivery Due 
List)  
Purpose 
In this process, a customer places two orders on the same day. The second order is to be 
delivered together with the first. 

You can find more information about this process under  [Page 239]. 

Process Flow 
You can find the data for this process under  [Page 240]. 

1. Creating a Sales Order [Page 241] 

Creating a Sales Order With Reference to a Document [Page 243] 2. 

3. Combing Orders Manually in One Delivery [Page 245] 

Processing the Delivery Due List [Page 24 ]6  4. 

5. Picking the Delivery and Posting the Goods Issue [Page 248] 
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Additional Process Information  
You can group entire orders, order items of different orders, or partial deliveries of individual 
order items into one delivery. The orders (or order items) and schedule lines must have identical 
shipping criteria. At the time of delivery, orders can be combined manually or automatically via 
the delivery due list. 
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Data Used During This Process  
Field Europe North America 

Order type OR (Standard order) OR 

Sales organization 1000 3000 

Distribution channel 12 12 

00 

Customer 1033 3850 

Material 1 R-1141  R-1141  

Material 2 R-1140 R-1140 

Shipping point 1200 3200 

Warehouse number 

Division 00 

012 320 
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Creating a Sales Order 

Logistics → Sales and Distribution → Sales → Order → Create 

1. Call up the transaction as follows: 

Menu Path 

Transaction Code VA01 

2. Enter the following data: 

Field Europe North America 

Order type OR OR 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Sold-to party 1033 3850 

Purch.order no. K-KA-201001 C-SD-058300 

PO date Today‘s date Today‘s date 

Req.deliv.date Today's date + three working days Today's date + three working days 

Pricing date Today‘s date Today‘s date 

Material R-1141 R-1141 

Order quantity 5 5 

5. Choose . 

If a dialog box should appear, choose . 

 
If the goods ordered by the customer are not available on the requested delivery 
date, the R/3 System branches automatically to an availability check screen. Here 
you can choose one of the delivery options, for example, Delivery proposal. The R/3 
System then returns to the overview screen. 

6. On the overview screen, select your item, then choose . 

7. Select the schedule line with the confirmed order quantity, then choose . 
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8. Choose the Shipping tab page. 

9. Make a note of the Material availability date, as you will need this as a selection criterion to 
create the delivery. If the Transport planning date is earlier than the material availability date, 
you can create the delivery on this date. 

10. Choose . 

11. Make a note of the order number.  

12. Choose  until the overview tree appears.  

In the dialog box, choose No. 
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Creating a Sales Order With Reference to a Document 
Use 
The customer orders five more monitors. The first sales order is to be used as a reference. Both 
orders are to be delivered together. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

The system automatically proposes the following data from the previous transaction. 

Field Europe North America 

Order type OR OR 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

2. To use the first order as a copy reference, choose  Create with reference. 

3. Choose the Order tab page, then enter the following data: 

Field Europe North America 

Order Order number from the first process 
step 

Order number from the first process 
step 

Req.deliv.date Today's date + three working days Today's date + three working days 

4. Choose Copy. 

The system copies all relevant data and branches to the overview screen of the new 
document. 

5. Enter the following data:  

Field Europe North America 

Purch.order no. K-KA-201002 C-SD-058301 

PO date Today‘s date Today‘s date 

6. On the same screen, change following data: 

Field Europe North America 

Material R-1140 R-1140 

Order quantity 6 6 

7. Choose . 
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Since you are changing the material proposed in the first order, the R/3 System 
updates the item type and pricing. 

8. In the next dialog boxes, choose . 

9. Choose . 

10. Make a note of the order number. 

11. Choose  until the overview tree appears. 

In the Exit Order Processing dialog box, choose No. 

244  April 2001 



 SAP AG Sales and Distribution (SD) 

  Combining Orders Manually in One Delivery 

Combining Orders Manually in One Delivery 
Use 
In this process step, you create an individual delivery for the second order and then manually add 
the first order to the delivery. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Single Document → With Reference to 
Sales Order 

Transaction Code VL01N 

2. Enter the following data: 

Field Europe North America 

Shipping point 1200 3200 

Selection date The material availability date or the 
transport planning date of the first 
item 

The material availability date or the 
transport planning date of the first 
item 

Order Second order number Second order number 

3. Choose . 

The R/3 System generates the first delivery item from the second sales order. 

4. To copy the open item from the first sales order to this delivery, choose Outbound delivery → 
Deliver sales order. 

5. In the dialog box, enter the following data: 

Field Europe North America 

Order Number of the first sales order Number of the first sales order 

6. Choose . 

You now see the new item from the first order.  

 
Do not save this delivery, since this process step is only used to demonstrate how 
you can manually combine orders at the time of delivery.  

7. Choose  until the overview tree appears. 

The system asks whether you want to save your data. Choose No. 
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Processing the Delivery Due List 
Use 
Instead of creating a delivery individually for a sales order, you can use the delivery due list to 
process deliveries for all order items that are due for delivery at a certain time or within a certain 
period. In this case, the R/3 System creates deliveries for all of the sales order items you select. 
It also checks which order items can be combined into one delivery. 

In this process step, the R/3 System automatically creates one delivery for the two sales orders 
you created earlier. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Collective Processing of Documents 
Due for Delivery → Sales Orders 

Transaction Code VL10A 

2. Enter the following data: 

Field Europe North America 

Shipping point/receiving pt 1200 3200 

Deliv.creation date (from) The material availability date 
or the transport planning date 
of the first item 

The material availability date 
or the transport planning date 
of the first item 

3. Choose the Sales orders tab page. 

4. Enter the following data: 

Field Europe North America 

SD document (from) First order number First order number 

Sales document (to) Second order number Second order number 

5. Choose . 

The R/3 System displays the two order items due for delivery that match your selection 
criteria. 

6. Choose . 

7. Choose  Background. 

8. Choose . 

The system generates a log. 

9. Position your cursor on the report group, then choose Documents. 

10. Select the document number, then choose  Disp.doc.. 

You now see the created delivery. 
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11. Note the delivery number displayed in the Outbound delivery field. 

12. Choose  until the overview tree appears. 

April 2001  247 



Sales and Distribution (SD)  SAP AG 

Picking the Delivery and Posting the Goods Issue 

Picking the Delivery and Posting the Goods Issue 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Picking → Create Transfer Order → Single Document 

Transaction Code LT03 

2. Enter the following data:  

Field Europe North America 

Warehouse number 012  320  

Delivery Delivery number Delivery number 

Foregroung/backgrnd Background Background 

Adopt pick.quantity 2 2 

3. Choose .  

The system generates a transfer order for the picking of the delivery quantities. Option 2 
(Adopt picking quantity) ensures that the goods issue posting is made at the same time 
as the delivery. 

4. Choose  until the overview tree appears.  
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Partial Deliveries 
Purpose 
Due to technical problems in Shipping, you are unable to deliver a sales order completely on the 
confirmed delivery date. A second delivery is required to complete the order. 

You can find more information about this process under  [Page 250]. 

Process Flow 
You can find the data for this process under  [Page 251]. 

1. Creating the Sales Order [Page 252] 
Delivering the Sales Order [Page 254] 2. 

3. Picking the Delivery [Page 255] 
Reprocessing the Delivery [Page 256] 4. 

5. Delivering the Open Order Quantities [Page 25 ]7  
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Additional Process Information 
A partial delivery may be necessary if the entire quantity of goods ordered by the customer is not 
available on the requested delivery date. Another reason may be that no complete deliveries can 
be created during delivery processing because of, say, organizational or transportation capacity 
limitations. 
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Data Used During This Process 
Field Europe North America 

Order type OR (standard order) OR 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

Customer 2140 4140 

Material M-12 M-12 

Shipping point 1200 3000 

Warehouse number 012 300 

Plant 1200 3000 
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Creating a Sales Order 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Europe North America 

Order type OR OR 

Sales organization 1000 3000 

Distribution channel 12 12 

Division 00 00 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Sold-to party 2140 4140 

PO number K-NIC-801000 C-NI-0414000 

Today‘s date Today‘s date 

Req.deliv.date Today's date + three working days Today's date + three working days 

Pricing date Today‘s date Today‘s date 

Material M-12 M-12 

Order quantity 10 10 

Purchase order date 

5. Choose . 

6. To close the information dialog box, choose . 

 
If the goods ordered by the customer are not available on the requested delivery 
date, the R/3 System branches automatically to an availability check screen. Here 
you can choose one of the delivery options, for example, Delivery proposal. The R/3 
System then returns to the overview screen. 

7. Select the required item. 

8. Choose . 

252  April 2001 



 SAP AG Sales and Distribution (SD) 

  Creating a Sales Order 

9. Choose the Schedule lines tab page. 

10. On the Create Standard Order: Item Data screen, select the schedule line with the confirmed 
order quantity. 

11. Choose . 

12. Choose the Shipping tab page. 

13. Make a note of the Material availability date, as you will need this as a selection criterion to 
create the delivery. 

 
If the Transport planning date is earlier than the material availability date, you can 
create the delivery on this date. 

14. Choose . 

In the status bar, you see the order number. 

15. Make a note of the order number. 

16. Choose  until the overview tree appears. 

In the dialog box, choose No. 
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Delivering the Sales Order 
17. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Single Document → With Reference to 
Sales Order 

Transaction Code VL01N 

18. Enter the following data: 

Field Europe North America 

1200 3000 

Selection date The material availability date or the 
transport planning date of the first 
order 

The material availability date or the 
transport planning date of the first 
order 

Order Your order number Your order number 

Shipping point 

19. Choose . 

20. Choose . 

In the status bar, you see the number of the delivery you created. 

21. Note this delivery number. 

22. Choose  until the overview tree appears. 
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Picking the Delivery 
23. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Picking → Create Transfer Order → Single Document 

Transaction Code LT03 

24. Enter the following data: 

Field Europe North America 

Warehouse number 012 300 

Delivery Delivery number noted earlier Delivery number noted earlier 

Foreground/Backgrnd Background Background 

Adopt picking quantity Empty (delete any default) Empty (delete any default) 

25. Choose . 

The system generates a transfer order for the picking of the delivery quantities. 

In the status bar, you see the number of your transfer order. 

26. Note the number of the transfer order. 

27. Choose  until the overview tree appears. 
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Reprocessing the Delivery 
The delivery quantities could not be picked completely. To ensure that the goods issue can be 
made for the first partial delivery, you now enter the difference in the delivery document. 

28. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Change → Single Document 

Transaction Code VL02N 

29. Enter the following data: 

Field Europe North America 

Delivery Delivery number noted earlier Delivery number noted earlier 

30. Choose . 

31. Choose the Picking tab page. 

32. Enter the following data: 

Field Europe North America 

8  8 

Picking quantity 8 (that is, less than the quantity 
updated in the transfer order) 

8 (that is, less than the quantity 
updated in the transfer order) 

Delivery quantity 

 
To ensure that the goods issue can be posted for this delivery, the delivery quantity 
must be identical to the picked quantity. 

33. Choose Post goods issue. 

34. Choose  until the overview tree appears. 
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Delivering the Open Order Quantities 
1. Call the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Change 

Transaction Code VA02 

2. Enter the following data: 

Field Europe North America 

Order Your order number Your order number 

3. Choose . 

In the dialog box, the system informs you about the subsequent documents. 

4. Choose . 

5. Choose . 

6. Choose . 

7. On the Change Standard Order ###: Overview screen, select the item. 

8. Choose . 

You can now see that the ordered quantity differs from the delivered quantity. 

9. To generate the delivery document for the open quantities, choose Sales document → 
Deliver. 

 
If the open quantities are not ready for shipment on the defaulted selection date 
(today's date), the system issues an error message to inform you that no delivery 
items could be created. If this occurs, set the selection date three days in the future, 
then choose . 

The system defaults the remainder delivery quantity (2 pieces). 

10. Choose Subsequent Functions → Create Transfer Order. 

11. In the dialog box, to save your data, choose Yes. 

12. On the Create Transfer Order for Delivery Note: Initial screen, enter the following data: 

Field Europe North America 

Warehouse number 012 300 

Process Flow Background Background 

Copy picking quantity 2 2 

13. Choose . 
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Option 2 (Adopt picking quantity) ensures that the goods issue posting is made at the 
same time as the delivery. 

14. Choose  until the overview tree appears. 
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Packing the Delivery 
Purpose 
You can find more information about this process under  [Page 260]. 

Process Flow 
You can find the data for this process under  [Page 261]. 

1. Creating a Sales Order [Page 262] 

2. Delivering the Sales Order [Page 264] 

3. Billing the Sales Order [Page 266] 
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Additional Process Information 
Packing is part of delivery and transportation processing. While you process a delivery, you can 
select the delivery items that you want to pack and assign them to shipping units. 
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Data Used During This Process 
Field Data 

OR  

Sales organization 1000 

Distribution channel 10 

Division 00 

Plant 1200 

Shipping point 1200 

Warehouse number 012 

Customer 1200 

Material R-1140 

Shipping material 1 PK-100 

Shipping material 2 PK-095 

Order type 
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Creating a Sales Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Data 

Order type OR 

Sales organization 1000 

Distribution channel 10 

Division 00 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Data 

Sold-to party 1200 

Purch.order no. K-MI-302000 

PO date Today‘s date 

Req.deliv.date Today’s date +2 working days 

Pricing date Today‘s date 

Material R-1140 

Order quantity 2 

5. Choose . 

6. In the dialog box choose . 

 
If the goods ordered by the customer are not available on the requested delivery 
date, the system branches automatically to an availability check screen. Here you 
can choose one of the delivery options, for example, Delivery proposal. The system 
then returns to the overview screen. 

7. Select the item, then choose . 

8. On the Shedule lines tab page, select the schedule line with the confirmed order quantity, 
then choose . 
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9. Choose the Shipping tab page. 

10. Make a note of the Material availability date, as you will need this as a selection criterion to 
create the delivery. If the Transport planning date is earlier than the material availability date, 
you can create the delivery on this date. 

11. Choose . 

The system confirms that the standard order has been saved. 

12. Make a note of the sales order number. 

13. Choose  until the overview tree appears. 

In the Exit Order Processing dialog box, choose No.  
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Delivering the Sales Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Subsequent 
Functions → Outbound Delivery 

Transaction Code VL01N 

2. Enter the following data: 

Field Data 

Shipping point 1200 

Selection date The material availability date or the transport planning date of the first process 
step 

Order Your sales order number 

3. Choose . 

4. Choose . 

The Pack Items screen is subdivided into two areas: In the upper section, you enter the 
shipping units in which you want to pack the delivery items. In the lower screen area, you 
select the items that you want to pack. 

5. Select item 10 in the lower screen, then choose . 

In the dialog box, you can select the shipping material in which you can pack the 
selected item. In this case, the monitor can be packed only in a carton with cushioning 
material (special carton hi-tech. 

6. Position your cursor on shipping material PK-100, then choose . 

The system automatically generates a shipping unit in the upper section of the screen 
(internal number assignment). 

 
7. In the lower section select the monitors to be packed. 

8. At the top of the screen, select the carton (PK-100) that is to be used for the packing. 

9. Because the total weight of the items (30 kg) would exceed the permissible weight of the 
carton (20 kg), choose  per part qty. 

The system generates a second shipping unit. Both monitors have now been packed. 

 
If you had chosen Pack item, only one monitor would have been packed. The system 
would then have issued a message that only a partial quantity was packed because 
the weight limit had been exceeded. 

10. To display all of the items packed to date, choose . 

11. To display the contents of the two cartons, expand the hierarchy nodes. 
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12. Choose  Item. 

13. To create the second level in the packing hierarchy (pallet), choose the Pack HUs tab page. 

The Pack Shipping Units screen appears. 

14. In the lower screen area, select both cartons, then choose . 

In the dialog box, you can select the shipping material on which you can pack or stack 
the two cartons. 

15. Position your cursor on pallet (110 X 110 X 12.5), then choose . 

16. Select both cartons (PK-100) in the lower screen area. Select also the pallet on which these 
cartons are to be stacked in the upper screen area. 

17. Choose . 

The system confirms that the selected shipping units (cartons) have been packed. 

18. To display all of the items that have been packed, choose . 

19. To display the cartons and the delivery items that have been packed on the pallets, expand 
the two packing hierarchy levels. 

20. Choose  until the Delivery Create: Overview screen appears. 

Since the shipping units you selected are liable for costs, the R/3 System has generated 
two additional items independent of the order: one item for the shipping unit carton (2 
pieces) and one for the pallet (1 piece). These items are transferred to the billing 
document. 

21. Choose Subsequent functions → Create transfer order. 

22. In the dialog box choose Yes. 

23. Enter the following data: 

Field Data 

Warehouse number 012 

Plant 1200 

Delivery Defaulted 

Process Flow Background 

Adopt picking quantity 2 

24. Choose . 

The system creates a transfer order for picking the delivery quantities. Option 2 (Adopt 
picking quantity) ensures that the goods issue posting is made at the same time as the 
delivery. 

25. Choose  until the overview tree appears. 
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Billing the Sales Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Create 

Transaction Code VF01 

2. Choose . 

The Create Billing Document screen appears. You can see that the items generated 
during the packing of the delivery have been transferred to the billing document. As 
these items are liable for costs, pricing will be carried out. 

3. Choose . 

The system confirms that the billing document has been saved. 

4. Choose  until the overview tree appears. 
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Picking with Lean WM 
Picking in IDES is made using Lean WM (warehouse management) in the MM-WM application 
module with simply structured warehouses without inventory management for the storage bins. 

WM picking is executed using a transfer order, which allows you to start and monitor movements 
within a warehouse complex. The transfer order is the basis for the picking list, which is used to 
withdraw the ordered goods from stock. 

The following warehouse complexes are relevant in IDES for picking with Lean WM: 

Plant Storage location Warehouse number/warehouse complex 

1000 Hamburg 0001 010 Hamburg 

1100 Berlin 0001 011 Berlin 

1200 Dresden 0001 012 Dresden 

1300 Frankfurt 0001 013 Frankfurt 

1400 Stuttgart 0001 014 Stuttgart 

2000 Heathrow 0001 020 Heathrow 

2300 Paris 0001 022 Paris 

3000 New York 0001 300 New York 

3100 Chicago 0001 310 Chicago 

3200 Atlanta 0001 320 Atlanta 

3300 Los Angeles 0001 330 Los Angeles 

3400 Seattle 0001 340 Seattle 

4000 Toronto 0001 400 Toronto 

 
Picking in the warehouses listed above is not subject to confirmation. 

Various procedures can be used to create WM transfer orders. These are described below: 

Picking with Individual Generation of Transfer Orders [Page 268]1.  

2. Picking with Automatic Generation of Transfer Orders [Page 276] 

3. Picking using the Collective Processing Method [Page 282] 
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Picking with Individual Generation of Transfer Orders 
Purpose 
Due to technical problems in Shipping, you may sometimes need to pick deliveries individually. In 
this case, picking is triggered either as a subsequent function during delivery processing, with a 
separate transaction by specifying the number of the delivery, or by selecting the delivery from a 
work list. 

In this process, you trigger the picking of a delivery as a separate business transaction. You 
generate the basic requirements of this process (the sales order and the corresponding delivery) 
using a CATT (Computer Aided Test Tool). 

You can find more information about this process under  [Page 269]. 

Process Flow 
You can find the data for this process under  [Page 270]. 

Generating the Sales Order and the Delivery [Page 271] 1. 

2. Picking the Delivery Individually [Page 272] 

Posting a Goods Issue [Page 274] 3. 

4. Billing the Sales Order [Page 275] 
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Additional Process Information 
Picking as a follow-on activity to the delivery is described in the IDES process Order Processing 
and Subsequent Functions [Page 24] (process step: Delivering the Sales Order). 
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Data Used During This Process 
Field Europe North America Description 

CATT (test run) ZID30780_02 

 

ZID30780_02 CATT-procedure to generate 
sales orders and deliveries 

Variant A01 B01 Variants for sales organizations 
1000 and 3000 

Sales organization 1000 3000  

Plant 1000 3000  

Warehouse number 010 300  
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Generating the Sales Order and the Delivery 
123. Call up the transaction as follows: 

Menu Path Tools → ABAP Workbench → Test → Test Workbench → CATT Extended

Transaction Code SCAT 

124. Enter the following data: 

Field Europe North America 

Test case ZID30780_02 ZID30780_02 

125. Choose . 

126. Enter the following data: 

Block Europe North America 

Log type W/o (select) W/o (select) 

Processing mode Background (select) Background (select) 

Variants Special, generic Special, generic 

CATT procedure variant (in the Variants section) A01 B01 

127. Choose . 

In the status bar, you see which transactions are being processed. The system confirms 
that the delivery has been saved. 

 
You can find the sales order generated by the CATT procedure using Use the search 
help [Ext.] for the following PO number. 

Field Contents Example 

PO number DDMMYY-00-User 060600-00-Smith 

128. Make a note of the delivery number. 

129. Choose  until the overview tree appears. 
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Picking the Delivery Individually 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Picking → Create Transfer Order → Single Document 

Transaction Code LT03 

2. Enter the following data: 

Field Europe North America 

Warehouse number 010 300 

Delivery Delivery number (Defaulted) Delivery number (Defaulted) 

Foreground/backgrnd Background Background 

Adopt pick.quantity Blank Blank 

3. Choose . 

The system generates a transfer order for the picking of the delivery quantities. 

4. Make a note of the transfer order number. 

5. Choose Transfer order → Display. 

6. Enter the following data: 

Field Europe North America 

Transfer order no. Number of the transfer order 
(Defaulted) 

Number of the transfer order 
(Defaulted) 

Warehouse number 010 300 

7. Choose . 

8. Choose the From-data tab page. 

9. Note the following input fields: 

Field Contents Description 

Tpe 005 Storage type from where the material is to picked 

Stor. bin H1-101 Storage bin from where the material is removed (defined in material 
master) 

10. Choose the To-data tab page. 

11. Note the following input fields: 

Field Contents Description 

Tpe 916 Storage type into which the 
material picked is to be placed 
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C... (Confirmation status 
source/dest.) 

Picking and transport 
confirmed 

Item automatically confirmed, 
since no explicit confirmation 
required 

12. On the Display Transfer Order: Item List screen, to display the individual picking list, choose 
System → Services → Output controller.  

The system generates a new session. 

13. Adopt the data proposed by the system, then choose . 

14. Select the top entry LVS2. 

15. Choose . 

You now see a print preview of the transfer order. 

16. Choose System → End Session, then return to the Display Transfer Order: Item List screen. 

17. Choose  until the overview tree appears. 
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Posting the Goods Issue 
Usage 
To complete the shipping activities, you now post the goods issue for the delivery. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Change → Single Document 

Transaction Code VL02N 

2. Enter the following data: 

Field Data 

Delivery Delivery number (Defaulted) 

3. Choose . 

4. Choose the Picking tab page. 

You can see that the system automatically updates the picking quantities when you 
create the transfer order. If required, you could enter a different picking quantity. 

5. Choose Post goods issue. 

The system confirms that the delivery has been saved. 

6. Choose  until the overview tree appears. 
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Billing the Sales Order 

Logistics → Sales and Distribution → Billing → Billing Document → Create

1. Call up the transaction as follows: 

Menu Path 

Transaction Code VF01 

2. Enter the following data: 

Field Europe North America 

Document number Delivery number (Defaulted) Delivery number (Defaulted) 

3. Choose . 

The system confirms that the billing document has been saved. 

4. Choose  until the overview tree appears. 
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Picking with Automatic Generation of Transfer Orders 
Purpose 
In this process, you process and deliver immediately an incoming customer order. To do this, you 
use a rush order (where the system generates the delivery document at the same time as the 
order). 

The delivery quantities are picked automatically. When goods issue has been completed, the 
order is billed. 

You can find more information about this process under  [Page 277]. 

Process Flow 
You can find the data for this process under  [Page 278] [Page 278]. 

1. Creating a Sales Order for Immediate Delivery [Page 279] 

2. Billing the Rush Order [Page 281] 
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Additional Process Information 
The automatic generation of a WM transfer order for the picking of delivery quantities is 
determined by the output control in shipping. 

When the delivery is created, if at least one of the delivery items is relevant for WM, we use the 
condition technique to determine output type WMTA at the header level of the delivery. 

We determine output type WMTA based on the delivery type and the shipping condition that is 
valid for this business transaction. For this purpose, the IDES development team has defined a 
message record with transmission time-spot 4 (process immediately) for delivery type LF and 
shipping condition 10 (immediately). This ensures that as soon as the delivery is created, the 
system automatically generates the WM transfer order in the background. 

Order type RO (rush order) ensures that shipping condition 10 is automatically entered in the 
order header data and is transferred to the delivery to be generated by the system. 

 
In IDES, we have also defined shipping condition 10 as the default value for order 
type CS (cash sales). 
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Data Used During This Process 
Field Europe North America 

Order type RO (Rush order) RO 

Sales organization 1000 3000 

Distribution channel 10 10 

Division 00 00 

Customer 1172  3171 

M-08 M-08 

Shipping point 1200 3000 

Warehouse number 012 300 

Material 
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Creating a Sales Order for Immediate Delivery 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Europe North America 

RO (Rush order) RO Order type 

 
You do not need to specify the sales area at this point. The system derives the sales 
area when you enter the sold-to-party. If the sold-to-party has been defined in more 
than one sales area, the system requests you to select the appropriate sales area. 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Sold-to party 1172 3171 

K-CD-500000 

 

C-HI-500000 

PO date Today‘s date Today‘s date 

Req.deliv.date Today‘s date Today‘s date 

Pricing date Today‘s date Today‘s date 

Material M-08 M-08 

Order quantity 10 10 

Purch. order no. 

5. Choose . 

6. Choose Goto → Header → Shipping. 

 
Note that the shipping condition Immediately has been adopted automatically. 

7. Choose . 

8. Choose Sales document → Display. 

If the system displays the Go to "Display" dialog box, choose No. 

The system defaults the number of the rush order. 

9. Choose . 
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The system displays the documents involved in this business process to date. In addition to 
the rush order, you can also see the delivery and the WMS transfer order that were 
generated automatically. 

10. Select the outbound delivery, then choose  Display document. 

11. Choose Extras → Deliver output → Header. 

12. Select output type WTMA, then choose Further data. 

You can see that this output type has been processed successfully. 

13. Choose  until the Delivery ### Display: Overview screen appears. 

14. To execute the goods issue directly, choose . 

15. Choose Post goods issue. 

The system confirms that the goods issue for this delivery has been saved. 

16. Make a note of the delivery number. 

17. Choose  until the overview tree appears. 
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Billing the Rush Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing Document → 
Create 

Transaction Code VF01 

2. Enter the following data: 

Field Europe North America 

Document number Delivery number Delivery number 

3. Choose . 

The system confirms that the billing document has been saved. 

4. Choose  until the overview tree appears. 
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Picking using the Collective Processing Method 
Purpose 
In this process, a shipping controller issues and stages materials from the warehouse for different 
deliveries on the basis of a collective picking list. The picking process is initiated by the creation 
of WM transfer orders using the collective processing method. 

The basis for this process (several customer orders) is generated by a CATT-procedure 
(Computer Aided Test Tool). 

You can find more information about this process under  [Page 283]. 

Process Flow 
You can find the data for this process under  [Page 284]. 

1. Creating Sales Orders [Page 285] 

Creating Deliveries via Delivery Due List [Page 286] 2. 

Picking using the Collective Processing Method [Page 287] 3. 

4. Posting Goods Issue [Page 289] 
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Additional Process Information 
The delivery of the sales orders is managed in this process by a special shipping point. This 
shipping point uses the collective method to process deliveries.During sales order entry, the R/3 
System assigns this shipping point automatically to the different order items due to the shipping 
condition 03 (collective processing).  
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Data Used during this Process 
Field  Europe  North America Description 

CATT (test 
procedure) 

ZID30780_02 ZID30780_02 CATT-Test procedure to 
create sales orders 

Variant  A10 - A17 B10 - B17 Variants for sales 
organization 1000 and 3000 

Sales organization 1000 3000  

Plant 1200 3000  

Shipping point 1999 3999  

Warehouse number 012 300  
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Creating Sales Orders 
Use 
The data needed for this process is generated by means of a CATT-Test case. Thus, you create 
8 sales orders which form the basis for delivery processing. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Tools → ABAP Workbench → Test → Test Workbench → CATT Extended

SCAT Transaction Code 

2. Enter the following data: 

Field Data 

Test case ZID30780_02 

3. Choose . 

4. Choose the following options: 

Block Europe North America 

Log type W/o W/o 

Processing mode Background Background 

Variants Special, generic Special, generic 

CATT procedure variant (in the Variants section) A1* B1* 

5. Choose . 

In the status bar, you see wich transactions are being processed. The system confirms 
that the delivery has been saved. 

 
You find the sales order generated by the CATT procedure using Use the search 
help [Ext.] for the following purchase order number: 

Field  Content  Example 

Purch.order no. DDMMYY-Sequencial Number-User 

(Sequencial Numbers: 10 - 17) 

300998-11-MUSTER 

6. Choose  until the overview tree appears. 
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Creating Deliveries via Delivery Due List 
Use 
All sales orders whose delivery due date has been reached should now be delivered. The 
selection of the order items qualifying for shipment is done through a delivery due list. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Collective Processing of Documents 
Due for Delivery → Sales Orders 

Transaction Code VL10A 

2. Enter the following data: 

Field Europe North America 

Shipping point/reveiving pt 1999 3999 

Deliv. creation date (from) Current date Current date 

Deliv. creation date (to) Current date + 3 working 
days 

Current date + 3 working 
days 

Sales organization 1000 3000 

3. Choose . 
The system displays a list of all those orders due for shipment that meet your selection 
criteria. 

4. Select your order, then choose  Background. 

5. Choose . 
The system displays a log of the delivery run. Please note that the deliveries created 
have automatically been grouped together under the delivery run number (see screen 
name). This number is used afterwards to do collective picking and goods issue. 

6. Write down the delivery run number in the Group field. 

7. Choose . 

8. Choose . 

The system displays a list of created deliveries together with the sales orders on which 
they are based. 

9. Choose  until the overview tree appears. 
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Picking using the Collective Processing Method 
Use 
The picking process is now initiated using the collective processing method. As a result, a picking 
list containing all relevant deliveries is generated. This list is used by the picker to issue and 
stage the goods to be delivered. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Picking → Create Transfer Order → Via Outb. Delivery Monitor 

Transaction Code VL06P 

2. Enter the following data: 

Field Europe North America 

Shipping point/receiving pt 1999 3999 

Picking date Current date  Current date 

Picking date (to) Current date  Current date 

Warehouse number  012 300 

Group Delivery run number  Delivery run number 

3. Choose . 

On an overview screen, all items meeting your selection criteria are displayed. 

4. Choose . 

5. Choose Subsequent functions → Group → Create. 

6. In the Create Group dialog box you are requested to give a reference name to the collective 
processing run. 

7. Enter the following data: 

Field Europe North America 

K K 

DDMMYY-Delivery run number 

e.g. 301299-460 

DDMMYY-Delivery run number 

Group type 

Description 

e.g. 301299-460 

8. Choose . 

The group number is displayed at the bottom of the screen. 

9. Choose . 

10. Choose  TO in backgr. 

11. Enter the following data: 
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Field Europe North America 

Select items Selected Selected 

Adopt pick.quantity 1 1 

12. Choose . 

The collective processing run is executed. As a result, WM-transfer orders are created 
for the different deliveries and a collective picking list is generated. 

A run log is displayed as soon as all documents have been processed. 

13. To display the picking list, on the Day´s Workload for Picking choose System → Services → 
Output controller. 

The system opens a new session. 

14. On the Output controller: Spool request selection screen, choose . 
15. Select the corresponding spool request (LVS2...), then choose . 

A print preview of the picking list displayed. 

16. To return to the Day´s Workload for Picking screen of the first session, choose System → 
End session. 

17. Choose  until the overview tree appears. 
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Posting Goods Issue  
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → Post 
Goods Issue → Collective Processing Via Outb.Delivery Monitor 

Transaction Code VL06G 

2. Enter the following data: 

Field Europe North America 

Shipping point/receiving pt 1999 3999 

Pland gds mvmnt date Blank Blank 

Pland gds mvmnt date (to) Blank Blank 

Group Number of delivery run under 
which deliveries have been 
grouped together 

Number of delivery run under 
which deliveries have been 
grouped together 

3. Choose . 
The system displays the deliveries that belong to the group. 

4. On the Goods Issue for Outbound Deliveries to be Posted screen, choose  and then  
Post goods issue. 

5. Confirm the proposed goods issue date in the dialog box Specify Actual Goods Issue Date 
with . 

The system confirms that the goods issue has been posted. This business transaction is 
herewith complete from the point of view of shipping. 

6. Choose  until the overview tree appears. 
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